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Category Name Description Values Default Value
Application 
Programming Interfaces

add_java_class_path Prepends the option value on the java environment 
variable, CLASSPATH, used to find classes in J-
Link programs. To specify multiple search paths in 
the same line, delimit them using ':' on UNIX, and ';' 
on Windows NT.

Application 
Programming Interfaces

enable_protk_xml_schema Enables XML-Schema validation for Pro/TK feature 
XMLs

yes, no no

Application 
Programming Interfaces

jlink_java2 Option to force use of Java-2 JRE command line 
("java" instead of "jre")

off, on on

Application 
Programming Interfaces

prodevdat Specify the full path to an additional Toolkit registry 
file.

Application 
Programming Interfaces

protkdat Specify the full path to an additional Toolkit registry 
file.

Application 
Programming Interfaces

toolkit_registry_file Specify the full path to an additional Toolkit registry 
file.

Application 
Programming Interfaces

web_disable_js_command Enter a specific javascript command to be disabled

Application 
Programming Interfaces

web_link_file_read Sets Pro/Web.Link permission to read data from the 
local file system.

yes, no no

Application 
Programming Interfaces

web_link_file_write Sets Pro/Web.Link permission to write data to the 
local file system.

yes, no no

Application 
Programming Interfaces

web_link_proe_read Sets Pro/Web.Link permission to read data from a 
Creo session.

yes, no no

Application 
Programming Interfaces

web_link_proe_write Sets Pro/Web.Link permission to modify data in a 
Creo session.

yes, no no

Application 
Programming Interfaces

web_link_security_autoprompt Yes - The Security dialog box is displayed when a 
Pro/Web.Link function requires security access 
beyond the current settings.

yes, no yes
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Category Name Description Values Default Value
Assembly add_offset_to_constraint_com

p
Adds an offset dimensions to constraints that were 
created without an offset during the dragging of a 
component.

yes, no no

Assembly advanced_intersection Control the appearance of the intersection tool and 
scope of available functionalities.

yes, no no

Assembly allow_freeze_failed_assy_com
p

Allow freezing failed assembly components. yes, no no

Assembly allow_package_children Sets what type of children packaged components 
can have. ALL - Features and components can be a 
children of packaged component. FEAT - Only 
features can be children of packaged components. 
NONE - Packaged components cannot have 
children.

all, feat, none all

Assembly allow_redo_intersections Yes - Displays the ReIntersect command in the 
ASSY FEAT menu.

yes, no no

Assembly allow_save_as_instance Allows the option to save a copy of the active model 
as a family table instance.

yes, no no

Assembly allow_save_failed_model Yes - Failed models can be saved. No - Failed 
models cannot be saved. Prompt - Let the user 
decide whether failed models can be saved.

yes, no, prompt prompt

Assembly allow_update_part_simp_rep_d
ata

Allow updating part Simplified Rep data in session 
automatically when switching from one Simp Rep to 
another.  Yes - Allow updating part simplified rep 
data. No - Do not update part simplified rep data. 
Prompt - Prompt the user if the current simplified 
rep should be updated.

yes, no, prompt yes

Assembly annot_elem_params_with_unit
s

Some annotation element virtual parameters which 
were previous passed unitless will not be passed as 
attributes with units.

1

Assembly auto_assembly_with_notebook
s

Yes - Enables automatic assembly. No - Disables 
automatic assembly.

yes, no yes

Assembly auto_constr_always_use_offse
t

Control whether auto constraint should create 
offsets. Yes - Auto constraint alw ays creates 
offsets. No - Auto constraint snaps align or mate if 
surfaces are wi thin tolerance. Never - Auto 
constraint never create offsets.

yes, no, never no

Assembly auto_evaluate_simprep_rules If the option is "yes" newly created rep would be 
updated each time on   retrieve/regeneration.

yes, no no
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Category Name Description Values Default Value
Assembly auto_place_max_number Set the default value for the maximum number of 

matches allowed.
5

Assembly auto_update_intersected_mod
els

Control the appearance of the intersection tool and 
scope of available functionalities.

yes, no yes

Assembly autoplace_single_comp Assembling components with an interface will 
automatically place the component at the first 
position satisfying the interface definitions.

yes, no yes

Assembly bump_revnum_on_retr_regen Determines whether or not revision number is 
increased for generic models that regenerate and 
change during assembly retrieval.  Only applies if 
new_asm_regen_revnums is yes (otherwise, there 
will be no revision number bumping).

yes, no yes

Assembly can_snap_to_missing_ref Controls whether to enable snapping to missing 
references while dragging components for 
placement. Yes - Snapping is enabled while 
dragging. No - Snapping is disabled while dragging.

yes, no yes

Assembly check_interface_criteria Check for interfaces when placing a component. yes, no no
Assembly check_interference_of_matche

s
Show only matches that do not interfere with other 
components.

yes, no yes

Assembly check_same_assy_parts Determines whether to permit different names for 
different part occurrences, or not in mirror 
subassembly UI.

yes, no yes

Assembly chooser_size_filter_default Sets the size filter default value as a percentage of 
the overall assembly size

Assembly comp_angle_offset_eps Specifies the angle epsilon such that if the desired 
surfaces are equal or greater than the epsilon (in 
degrees), than an angle offset constraint will be 
created.

10

Assembly comp_assemble_start Sets the initial assembly placement behavior when 
assembling a new component. Default - Default 
initial position.  Package - Define initial position 
using the Move option.  Constraint_in_Window - 
Use secondary window.   Move_then_Place - Define 
initial position using the Move option and then  
define placement constraints.

package, constrain_in_window, default, 
move_then_place
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Category Name Description Values Default Value
Assembly comp_placement_assumptions Use placement assumptions when placing 

components.
yes, no yes

Assembly comp_retr_angular_increment Sets the accuracy for the selection of external 
components based on graphic computation.

1

Assembly comp_rollback_on_redef No - Assembly is not rolled back when the user 
redefines a component.

yes, no yes

Assembly copy_geom_update_pre_2000i
_dep

Yes - Flags independent copy geom features in a 
pre-2000i model as modified when retrieved into 
Creo. Save the model immediately to update the 
model's copy geom dependency information.

yes, no

Assembly copy_geometry_method Sets the default copy geometry reference(s) type publish_geometry, references publish_geometry

Assembly create_temp_interfaces Allow the automatic creation of interfaces based on 
previous assembly instructions.

yes, no no

Assembly dim_inactive_components Display inactive assembly components using 
phantom transparency and default color (grey). 
Default value is shade_only.

never, always, shaded_only shaded_only

Assembly disp_regen_success_msg Issue successfull regeneration messages for 
assembly models.

yes, no no

Assembly enable_advance_collision Enables advance collision settings usage. yes, no no
Assembly enable_assembly_accuracy No - Disables accuracy modification for assembly 

objects.
yes, no yes

Assembly enable_implied_joints Allow underconstrained components as mechanism 
connections.

yes, no yes

Assembly erv_show_external_only Yes - Global Reference Viewer will show objects 
with external references only;  No - all the objects 
will be visible

yes, no no

Assembly fail_ref_copy_when_missing_o
rig

Yes - When using a copied geom feature or a 
backed-up external reference with the Design 
Manager, and the reference is missing in the 
original, then the copied geom feature fails. No - 
The feature freezes and does not update.

yes, no yes

Assembly fix_refs_to_intersections Sets remnant removal ability for the ReIntersect 
command in the ASSY FEAT menu. Yes - You can 
remove remnants. No - You cannot remove 
remnants.

yes, no no
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Category Name Description Values Default Value
Assembly force_upd_assem_mp_in_sim

p_rep
Update mass properties parameters even when 
some of the components of the assembly are not in 
master rep.

yes, no, use_stored use_stored

Assembly grv_default_view Sets the default view the reference view starts with - 
Dependencies or References.

references, dependencies references

Assembly ignore_non_displayed_items Ignores nondisplayed items when searching the 
component interface during component placement.

yes, no no

Assembly include_sub_model_interfaces Includes sub model interfaces as possible 
references for interface to interface component 
placement.

yes, no yes

Assembly interface_criteria_mismatch FAIL_PLACEMENT - Fail regeneration upon 
component interface criteria mismatch. 
WARNING_ONLY - A warning message is given 
during regeneration for the criteria mismatch only 
without failure. IGNORE - Interface criteria 
mismatch ignored during regeneration.

ignore, warning_only, fail_placement warning_only

Assembly modify_offset_during_comp_dr
ag

Enables the modification of the value of offset 
dimensions during component dragging.

yes, no no

Assembly mp_dens_ft_column_mtrl_assi
gned

Yes - Allows adding an MP_DENSITY column in FT 
when a material is assigned to a model. When set 
may cause the same material to have different 
values for the Density parameter in different 
instances. Does not affect legacy models.

yes, no no

Assembly mtrl_convert_units If set to "Yes" Creo will automatically convert units in 
materials from a library to the model system of 
units.

yes, no yes

Assembly new_wf5_simp_rep_ui Yes - Use Component Chooser base Simp Rep UI, 
No - Use old Simp Rep definition UI.

yes, no yes

Assembly package_constraints Action to take for packaged components in 
Assembly mode. Update - Updates components if 
assembly changes. Freeze - Does not move 
components if assembly changes. Disallow - Does 
not allow packaged components in assembly (must 
be fully constrained).

disallow, freeze, update update
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Category Name Description Values Default Value
Assembly package_ref_alert Control whether alert dialog is given when packaged 

component is referenced. Yes - Allow alert when a 
packaged component is referenced. No -  No Alert 
is given when a packaged component is referenced.

yes, no no

Assembly preserve_comp_color_in_previ
ew

Yes - During component placement, component 
being assembled will retain its normal colors.  No - 
During component placement, component being 
assembled is shown in preview color.

yes, no no

Assembly regen_notebook_w_assem Specifies whether or not the notebook will be 
automatically regenerated upon assembly 
regeneration.

yes, no yes

Assembly replace_comp_name_method Sets the naming convention used when replacing 
components.

transfer, remove, preserve transfer

Assembly replace_history_rule_order Set the default order of the history evaluation rule in 
the replace operation. Disable - the evaluation rule 
will be disabled by default. Number - set the order of 
the rule relative to other evaluation rules.

1, 3, 2, disable, 4, 5 3

Assembly replace_interface_rule_order Set the default order of the interface evaluation rule 
in the replace operation. Disable - the evaluation 
rule will be disabled by default. Number - set the 
order of the rule relative to other evaluation rules.

1, 3, 2, disable, 4, 5 1

Assembly replace_sameid_rule_order Set the default order of the same id evaluation rule 
in the replace operation. Disable - the evaluation 
rule will be disabled by default. Number - set the 
order of the rule relative to other evaluation rules.

1, 3, 2, disable, 4, 5 5

Assembly replace_samename_rule_order Set the default order of the same name evaluation 
rule in the replace operation. Disable - the 
evaluation rule will be disabled by default. Number - 
set the order of the rule relative to other evaluation 
rules.

1, 3, 2, disable, 4, 5 2
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Category Name Description Values Default Value
Assembly replace_sameparam_rule_orde

r
Set the default order of the same parameters 
evaluation rule in the replace operation. Disable - 
the evaluation rule will be disabled by default. 
Number - set the order of the rule relative to other 
evaluation rules.

1, 3, 2, disable, 4, 5 4

Assembly replace_unrelated_automatic Availability of automatic reference pairing in 
unrelated replace. No - Automatic reference pairing 
is not available. Yes - Automatic reference pairing is 
available.

yes, no no

Assembly retrieve_instance_dependencie
s

Determines whether to retrieve the dependencies of 
the generic when an instance is retrieved.

instance_deps_only, 
instance_and_generic_deps, 
instance_req_generic

instance_req_generic

Assembly rv_current_object Will control default option when setting a model or 
component as the current object.

model, component, component + model component + model

Assembly rv_search_scope Sets the search scope for children when entering 
the reference viewer. Session - Search all objects in 
session. Window - Search objects in the active 
window only.

session, window session

Assembly search_area_for_comp_interfa
ces

Defines the search area for the component interface 
as a percentage of the component size during 
component placement.

100

Assembly search_not_retrieved_models Expands search to include models that have not 
been retrieved into session. If Yes, models will be 
brought into session possibly causing performance 
issues.

yes, no yes

Assembly sel_insts_on_comp_retrieval Yes - If the components used in the assembly 
instances are themselves generics, the systems 
asks if you want to choose an instance as each 
component is retrieved. No - The generic model of 
the component is retrieved automatically.

yes, no no

Assembly show_interference_in_sections Yes - Interference will be shown automatically, No - 
interference will not be shown automatically.

yes, no no

Assembly shrinkwrap_alert Displays the Shrinkwrap alert the first time the 
quality level is increased.

yes, no yes
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Category Name Description Values Default Value
Assembly simple_search_consider_selec

t
Defines whether simple search executes query only 
inside selected models (if some models selected) or 
always in scope of entire top-level model.

yes, no no

Assembly simprep_default_model_status Determines the default model status while defining a 
new simplified rep.

master, geometry, exclude, graphics, light 
graphics rep

exclude

Assembly simprep_ondemand_selection Determines the rep to be retrieved when selecting a 
reference. Automatic  Retrieves the minimum rep 
required to perform the operation.

automatic, master, disable automatic

Assembly simprep_ondemand_settings Determines on-demand retrieval behavior in 
simplified representation views. Prompt - Ask for 
confirmation before retrieving on-demand. 
Never_prompt - Retrieve models on-demand 
automatically with no confirmation. Disabled - on 
demand is disabled.

prompt, disable, never_prompt never_prompt

Assembly skeleton_model_default_color Specifies the color Creo uses to display new 
skeleton models. The three decimal values ranging 
from 0 through 100 specify (in order) the 
percentages of red, green, and blue in the resulting 
color. For example, 0 0 49 specifies medium blue.

0.000000 75.000000 
100.000000

Assembly snap_to_constraints_during_dr
ag

Enables the dynamic snapping to constraints during 
the dragging of components.

yes, no yes

Assembly update_copy_geom_location Yes-Copy Geometry will try to update location of 
copied geometry based on changes to component 
placements even if some components are excluded 
or in graphics rep.

yes, no yes

Assembly update_rep_refs "Yes" updates top assembly simplified reps for 
replacements during regeneration and upon 
replacement.

yes, no yes

Assembly use_3d_thumbnail_in_lwg_rep Control the usage of 3D thumbnails when retrieving 
in light weight graphic representation

yes, no yes

Assembly use_active_model_in_transfor
m

Transform analysis default behavior: use active 
model CSYS and units or not.

yes, no no

Assembly Process curr_proc_comp_def_color Specifies the default color used to display the 
current component in a process assembly.

0.000000 0.000000 0.000000

Assembly Process curr_proc_comp_def_font Specifies the default font used on the current 
component in a process assembly.
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Category Name Description Values Default Value
Assembly Process display_comps_to_assemble Yes - The design model goes into memory and 

displays. Pick process components from the design 
model or the Model Tree. No - Only the Model Tree 
displays. As you pick process components from the 
Model Tree, they go into memory.

yes, no yes

Assembly Process offset_line_def_color Specifies the color that offset lines are displayed in 
drawings.

0.000000 0.000000 0.000000

Assembly Process offset_line_def_font Specifies the font in which offset lines are displayed 
in drawings.

Assembly Process prev_proc_comp_def_color Specify the default color for components added to a 
process assembly in a previous step.

0.000000 0.000000 0.000000

Assembly Process prev_proc_comp_def_font Specify the default font for previously added 
components in a process assembly.

Casting & Mold Design allow_shrink_dim_before Allow calculation before relations. yes, no no

Casting & Mold Design default_mold_base_vendor Default Value for Mold Base vendor. futaba_mm, dme, hasco, dme_mm, 
hasco_mm

Casting & Mold Design default_shrink_formula Default option of shrinkage formula: 1/(1-S) - ASME 
standard or 1+S (simple).

asme, simple simple

Casting & Mold Design mold_layout_origin_name Sets a specified coordinate system as the default for 
the cavity layout origin.

Casting & Mold Design mold_vol_surf_no_auto_rollbac
k

Do not perform automatic rollback while modifying 
mold volumes or parting surfaces.

yes, no no

Casting & Mold Design pro_catalog_dir Sets the path to the catalog directory containing the 
catalog menu and the names of other catalog files, 
such as ejector pins. For example: pro_catalog_dir 
proe_loadpoint/apps_data/mold_data/catalog. Use 
full path name to avoid problems.

Casting & Mold Design pro_cav_lay_rule_dir Sets the default directory for cavity layout rules. Use 
the full path name to avoid problems.

Casting & Mold Design shrinkage_value_display Determines how dimensions are displayed when 
shrinkage is applied to a model with 
Pro/MOLDESIGN. Percent_shrink - Dimensions 
appear with the shrinkage percent.

final_value, percent_shrink percent_shrink

Colors color Turns the colors on or off. Turning colors off 
displays the model wireframe in white.

yes, no yes
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Category Name Description Values Default Value
Colors color_ramp_size Specifies the number of shades in a color ramp. 

Applicable to multi-color, shaded model displays of 
simulation / analysis results. System graphics must 
support 256 colors and color maps that compress.

-1

Colors color_resolution Specifies minimum allowable deviation between 
user-defined colors. Colors having RGB values 
within tolerance of existing colors cannot be 
created. Decreasing this setting allows more colors 
that are very similar in RGB value to be defined.

0.1

Colors global_appearance_file Material Global Appearance file path.
Colors mat_assign_appearance Control whether default appearance in material 

definition is automatically assigned to a part.
yes, no yes

Colors number_user_colors Specifies the maximum number of different 
wireframe colors that can display in the graphics 
area(s) at any given moment.

-1

Colors pro_colormap_path Specifies the directory path for a color map (.map) 
file to be loaded from disk. Use the full path name to 
avoid problems.

Colors reflection_analysis_display Black and White displays reflection as black and 
white stripes. Surface color - uses the surface color 
to represent reflection stripes.

black and white, surface color black and white

Colors suppress_appearance_messa
ge

Suppress the Lightworks appearance conversion 
notification dialog.

yes, no no

Colors system_background_color Defines default graphics area background color. 
The three decimal values specify (in order) 
percentage of red, green and blue in the resulting 
color. For example, 0 0 49 specifies a medium blue. 
Change in session using View>Display 
Settings>System Colors.

0.000000 0.000000 0.000000

Colors system_colors_file Specifies the system color file. Use the full path 
name to avoid problems.
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Category Name Description Values Default Value
Colors system_curves_color Defines default curve color. The three decimal 

values specify (in order) percentage of red, green 
and blue in the resulting color. For example, 0 0 49 
specifies a medium blue. Change in session using 
View>Display Settings>System Colors.

0.000000 0.000000 0.000000

Colors system_dimmed_menu_color Defines default secondary highlight color. The three 
decimal values specify (in order) percentage of red, 
green and blue in the resulting color. For example, 0 
0 49 specifies a medium blue. Change in session 
using View>Display Settings>System Colors.

0.000000 0.000000 0.000000

Colors system_edge_high_color Defines default edge highlight color. The three 
decimal values specify (in order) percentage of red, 
green and blue in the resulting color. For example, 0 
0 49 specifies a medium blue. Change in session 
using View>Display Settings>System Colors.

0.000000 0.000000 0.000000

Colors system_geometry_color Defines default color of solid wireframe entities. The 
three decimal values specify (in order) percentage 
of red, green and blue in the resulting color. For 
example, 0 0 49 specifies a medium blue. Change 
in session using View>Display Settings>System 
Colors.

0.000000 0.000000 0.000000

Colors system_hidden_color Defines default color of hidden, wireframe entities. 
The three decimal values specify (in order) 
percentage of red, green and blue in the resulting 
color. For example, 0 0 49 specifies a medium blue. 
Change in session using View>Display 
Settings>System Colors.

0.000000 0.000000 0.000000

Colors system_highlight_color Defines default primary highlight color. The three 
decimal values specify (in order) percentage of red, 
green and blue in the resulting color. For example, 0 
0 49 specifies a medium blue. Change in session 
using View>Display Settings>System Colors.

0.000000 0.000000 0.000000
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Category Name Description Values Default Value
Colors system_letter_color Defines default color of datum tags. The three 

decimal values specify (in order) percentage of red, 
green and blue in the resulting color. For example, 0 
0 49 specifies a medium blue. Change in session 
using View>Display Settings>System Colors.

0.000000 0.000000 0.000000

Colors system_section_color Defines default section color. The three decimal 
values specify (in order) percentage of red, green 
and blue in the resulting color. For example, 0 0 49 
specifies a medium blue. Change in session using 
View>Display Settings>System Colors.

0.000000 0.000000 0.000000

Colors system_sheetmetal_color Defines default color of Sheetmetal parts. The three 
decimal values specify (in order) percentage of red, 
green and blue in the resulting color. For example, 0 
0 49 specifies a medium blue. Change in session 
using View>Display Settings>System Colors.

0.000000 0.000000 0.000000

Colors system_volume_color Defines default color of Manufacturing volumes. The 
three decimal values specify (in order) percentage 
of red, green and blue in the resulting color. For 
example, 0 0 49 specifies a medium blue. Change 
in session using View>Display Settings>System 
Colors.

0.000000 0.000000 0.000000

Colors use_part_color_for_hidden_lin
es

Determines how to color the hidden lines of parts 
that have user defined colors. "YES" - Use the 
dimmed part color for hidden lines.  
SYSTEM_HIDDEN_COLOR is ignored if it has been 
specified.

yes, no no

Creo Simulate custom_rainbow Used to specify fringe colors in Pro/FEM-POST 
results. Specify blue, black, cyan, magenta, green, 
yellow, red, and white. Enter colors as a dash-
delimited string (lowest to highest value). The 
default is blue-cyan-green-yellow-red-magenta-
white.
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Category Name Description Values Default Value
Creo Simulate sim_hyperelastic_material_fit Sets the default method for calculating coefficients 

for hyperelastic materials. If set to "normalized", 
normalized stresses will be used. If set to "non-
normalized", non-normalized stresses will be used.

normalized, non-normalized normalized

Data Exchange acis_export_params For ACIS interface allows to export object, feature 
and entity level parameters.

yes, no no

Data Exchange acis_export_units Allows selection of model units for ACIS export. micron, mm, default, in, ft, m, cm default
Data Exchange afx_enabled Loads AFX application. yes, no yes
Data Exchange allow_flat_to_screen_note Allow creation of flat to screen notes when option is 

set to true
yes, no no

Data Exchange atb_auto_check_on_activate Sets state of ATB 'Auto Check Status On Activate' 
toggle.

off, on off

Data Exchange atb_auto_check_on_retrieve Sets state of ATB 'Auto Check Status On Retrieve' 
toggle.

off, on on

Data Exchange atb_auto_check_on_update Sets state of ATB 'Auto Check Status On Update' 
toggle.

off, on off

Data Exchange atb_ident_cadds_files Allows to identify CADDS files in the file open 
browser.

yes, no no

Data Exchange atb_prod_asm_upd_by_comp_
ids

Allows to update a Pro/DESKTOP assembly based 
on assembly component ids, if set to YES. 
Otherwise, the update will be based on component 
names.

yes, no yes

Data Exchange atb_show_foreign_name Displays foreign source model name in the model 
tree for imported models.

yes, no yes

Data Exchange atb_show_log Sets state of ATB 'Show Log' toggle. off, on on
Data Exchange auto_associate_dimensions If set to yes, Creo will attempt to take imported 

dimensions that are not associative and link them to 
geometric entities so that they act as associative.

yes, no no

Data Exchange board_bend_notes_dflt_display Define the default state of bend note display (board 
mode)

yes, no yes

Data Exchange board_bend_notes_direction_d
own

Defines the down direction symbol for board bend 
notes.

default

Data Exchange board_bend_notes_direction_u
p

Defines the up direction symbol for board bend 
notes.

Data Exchange board_bend_notes_order Defines the fields order for board bend notes. &type&direction&angle
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Category Name Description Values Default Value
Data Exchange board_bend_notes_type_forme

d
Defines the formed symbol for board bend notes. default

Data Exchange board_bend_notes_type_rolled Defines the rolled symbol for board bend notes. default

Data Exchange board_bend_table_directory Will be used to set the bend allowance table only. 
Sets the default directory of the board bend 
allowance table files. If not set,  the system supplied 
bend tables are used. Use the full name and  path 
to avoid problems.

Data Exchange board_design_rules_directory Will be used to set the design rules file folder only. 
Will be used  by the design rules manager. Sets the 
default directory of the  board design rules files. Use 
the full name and path to avoid problems.

Data Exchange board_drive_bend_by_paramet
ers

Board bend radius and bend angle values and bend  
dimension location will be driven by feature-level  
relations to board parameters.

yes, no no

Data Exchange board_drive_tools_by_paramet
ers

Drives the board options and values by feature-level  
relations to board parameters.

yes, no yes

Data Exchange board_flange_shape_sketches
_dir

Sets path to directory that contains the Flange 
shapes.

Data Exchange board_flat_shape_sketches_dir Sets path to directory that contains the Flat shapes.

Data Exchange board_parameters_directory Specifies the directory to save/retrieve board 
parameters files. Use full name and path to avoid 
problems.

Data Exchange cadds_import_layer Allows import of CADDS5 layering. yes, no yes
Data Exchange catia_out_to_existing_model Append - If the selected CATIA model already 

exists, the new data is appended to the existing 
CATIA file. Overwrite - If the selected CATIA model 
already exists, the newly exported file overwrites the 
existing one.

append, overwrite append

Data Exchange cgm_use_pentable No - Do not use a defined pen table for formatting of 
CGM export.

yes, no no

Data Exchange cri_grafting_enable Activates "Graft features" button under File menu. 
This allows user to graft features created in CRI 
model to active model.

yes, no no
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Category Name Description Values Default Value
Data Exchange dazix_default_placement_unit Specifies the units to be used for data imported in 

Dazix files.
micron, mm, thou

Data Exchange dazix_export_mounthole Yes - Causes the MOUNTHOLE section of a Dazix 
file to be processed as a mount hole.  No - Causes 
the MOUNTHOLE section to be processed as a cut.

yes, no no

Data Exchange dazix_z_translation Yes - Passes the objects in the .edn files through z 
translation.

yes, no yes

Data Exchange direct_vrml Yes - Enables direct VRML conversion. yes, no no
Data Exchange dwg_export_format Provides the ability to choose DWG file version 

when exporting from Creo drawing.
14, 2000, 2004, 2007, 2010, 2013 2013

Data Exchange dxf_block_to_pro_symbol Specifies whether or not DXF BLOCKS to be 
imported as Creo symbols. Yes - Imports BLOCKS 
as symbol definitions, No - Imports BLOCKS as 
separate entities.

yes, no no

Data Exchange dxf_export_format Provides the ability to choose DXF file version when 
exporting from Creo drawing.

12, 13, 14, 2000, 2004, 2007, 2010, 2013 2013

Data Exchange dxf_in_faceted_brep Default, faceted boundary representation is allowed 
in import.

yes, no yes

Data Exchange dxf_out_comments YES - comments (999 group codes) will be created 
in DXF file exported from Creo. NO - DXF file will be 
created without comment lines.

yes, no yes

Data Exchange dxf_out_drawing_scale Specify whether or not to export drawing scale to 
the DXF or DWG file. Yes - Includes a scale factor 
DIMLFAC in the exported DXF/DWG. No - Exports 
without using a scale for the drawing. Set to Yes 
when exporting to read into AutoCAD.

yes, no no

Data Exchange dxf_out_scale_views Specify whether or not to scale drawing views when 
exporting to the  DXF or DWG file.  Yes - rescales 
the entire drawing in such a way that the main view  
scale becomes 1:1. No - exports without rescaling.

yes, no no

Data Exchange dxf_out_sep_dim_w_breaks YES - Breaks dimensions with breaks on witness 
lines to separate entities and preserves the original 
picture. No - Exports such dimensions as DXF 
DIMENSION entities and removes the breaks on 
witness lines.

yes, no no
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Category Name Description Values Default Value
Data Exchange dxfio_in_sjis Determines if the SJIS is supported when 

importing/exporting DXF files in Japanese
yes, no yes

Data Exchange ecad_area_default_import Defines how imported ECAD areas are treated. 
Cosm_area - Treats imported ECAD areas as 
cosmetic area features. 3d_volume - Imports ECAD 
areas with Z-heights as a 3D enclosed quilt.

3d_volume, cosm_area cosm_area

Data Exchange ecad_board_csys_def_name Specifies the default coordinate system name 
added to an ECAD board being imported. If you do 
not set this variable, the system prompts you for a 
name.

Data Exchange ecad_comp_csys_def_name Specifies the default coordinate system name 
added to an ECAD component being imported. If 
you do not set this variable, the system prompts you 
for a name.

Data Exchange ecad_comp_layer_map Allow layer mapping for ECAD component's import 
into Assembly.

yes, no yes

Data Exchange ecad_comp_naming_conventio
n

ECAD_NAME / ECAD_ALT_NAME - Uses the 
components package name or part number as the 
part name.  ECAD_NAME_ECAD_ALT_NAME - 
Concatenates the component's package name and 
part number as the part name.

ecad_name, ecad_name_ecad_alt_name, 
ecad_alt_name

ecad_name

Data Exchange ecad_comp_xsec_def_name Will allow pre-setting default X-section to be used 
for component outline output to *.eda format.

Data Exchange ecad_create_hint_add Assists in creation of an ecad_hint.map file. Yes - 
Automatically renames components, if necessary, 
each time library of component outlines is imported 
to Creo. This does not create an ecad_hint.map file. 
It controls if ecad_hint.add is created.

yes, no yes

Data Exchange ecad_default_comp_height Sets default value and units for an ECAD 
component being imported. Units can be: inch, mil 
(1E-3 inches), thou (1E-6 inches), cm, mm, micron 
(1E-6 meters), dsu (1E-8 meters). If not set, the 
system uses the current component's units.

-1.000000 ecad_unit_not_set
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Category Name Description Values Default Value
Data Exchange ecad_default_comp_place_stat

us
Sets default component placement status for export 
(parameter setting will override the default).

unplaced, fixed, placed, mcad, ecad placed

Data Exchange ecad_edmd_out_version Set the EDMD output version. 2.0, 1.2, 3.0 2
Data Exchange ecad_exp_both_two_areas Supports the export of ECAD areas with different 

"Above Board" and "Below Board" conditions.  "yes" - 
Enables you to export both sided keep-in/keep-out 
ECAD areas as two individual areas (top and 
bottom).

yes, no no

Data Exchange ecad_export_cuts_as_holes Exports Creo cuts as holes to ECAD systems. yes, no yes
Data Exchange ecad_export_holes_as_cuts Exports Creo holes as cuts to ECAD systems. yes, no no
Data Exchange ecad_import_holes_as_feature

s
Import sections specified as DRILLED_HOLE as 
through-all holes. Boards created with Creo drilled 
holes export with default value of NPTH for the 
ECAD_HOLE_TYPE parameter. Create this feature 
parameter if a value of PTH is needed (IDF 2.0/3.0).

yes, no yes

Data Exchange ecad_import_relative_accuracy Defines the relative accuracy used in ECAD import. 0.0012

Data Exchange ecad_load_filtered_holes_to_ui Controls whether "ECAD import holes configs" 
(ecad_pin_hole_import & ecad_via_hole_import) will 
remove holes completely from the import (default) 
or just pre-set the holes filter UI condition.

yes, no no

Data Exchange ecad_mapping_file Specify the ecad_hint.map file that will be used for 
ECAD operations.

Data Exchange ecad_missing_component_stat
us

Setup default status for missing components in 
"Investigate Placement" Dialog.

keep_missing, delete_missing keep_missing

Data Exchange ecad_mtg_hole_import Setup the default for the import of ECAD Holes type 
MTG (IDF 3.0 or IDX ONLY)

yes, no, as lightweight yes

Data Exchange ecad_other_outl_csys_def_na
me

Specifies the default coordinate system name for 
the .OTHER_OUTLINE section of an IDF 2.0 ECAD 
component being imported. If you do not set this 
variable, the system uses ECAD DEFAULT as 
coordinate system name.
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Category Name Description Values Default Value
Data Exchange ecad_outline_ents_enhanced_

exp
Enhanced export of special entities to ECAD 
formats. Yes - Attempt to approximate arcs and 
lines. No - Use part accuracy to approximate lines.

yes, no yes

Data Exchange ecad_outline_holes_exp_meth
od

Select how holes that are placed on the board 
outline be exported.

default, arcs default

Data Exchange ecad_panel_csys_def_name Specifies the default coordinate system name 
added to an ECAD panel being imported. If you do 
not set this variable, the system prompts you for a 
name.

Data Exchange ecad_pin_hole_import Set up the default for the import of ECAD Holes 
from type PIN (IDF 3.0 or IDX ONLY)

yes, no, as lightweight no

Data Exchange ecad_reject_strategy Configures the way the changes are rejected. ui_based, as_original, as_base ui_based
Data Exchange ecad_set_intercomm_compatib

le
Yes - Set both EDA format version and output 
method to support InterComm product, yes or no.

yes, no no

Data Exchange ecad_tool_hole_import Setup the default for the import of ECAD Holes type 
TOOL (IDF 3.0 or IDX ONLY)

yes, no, as lightweight yes

Data Exchange ecad_via_hole_import Set up the default for the import of ECAD Holes 
from type VIA (IDF 3.0 or IDX ONLY)

yes, no, as lightweight yes

Data Exchange ecadcollab_accept_color ECAD Collaboration Accept color 0.0 255.0 0.0
Data Exchange ecadcollab_auto_redef_areas Automatically redefine ECAD Areas affected by 

collaboration changes
yes, no yes

Data Exchange ecadcollab_auto_redef_comps Automatically redefine components affected by 
collaboration changes

yes, no yes

Data Exchange ecadcollab_auto_redef_holes Automatically redefine holes affected by 
collaboration changes

yes, no yes

Data Exchange ecadcollab_preview_after_colo
r

ECAD Collaboration Preview After color 255.0 127.0 0.0

Data Exchange ecadcollab_preview_before_co
lor

ECAD Collaboration Preview Before color 0.0 76.0 255.0

Data Exchange ecadcollab_preview_level ECAD Collaboration preview Level full, partial, light partial
Data Exchange ecadcollab_reject_color ECAD Collaboration Reject color 255.0 127.0 127.0
Data Exchange ecadcollab_scan_des_on_area

_chg
Check for affected objects resulting from ECAD 
Areas collaboration changes

yes, no yes

Data Exchange ecadcollab_scan_des_on_brd_
chg

Check for affected objects resulting from board 
collaboration changes

yes, no yes
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Category Name Description Values Default Value
Data Exchange ecadcollab_scan_des_on_com

p_chg
Check for affected objects resulting from 
components collaboration changes

yes, no yes

Data Exchange ecadcollab_scan_des_on_hole
_chg

Check for affected objects resulting from holes 
collaboration changes

yes, no yes

Data Exchange ecadcollab_supp_failed_feats Suppress of failed features on Object changes yes, no yes

Data Exchange ecadcollab_suppress_cuts Automatically suppress cut features in case of board 
collaboration changes

yes, no yes

Data Exchange enable_acis_export_extension Enable ACIS export extension. yes, no no

Data Exchange enable_cadra_export Enables the CADRA command in the EXPORT 
menu. This enables the creation of a CADRA 
specific IGES file.

yes, no no

Data Exchange explode_iges_dimension_note Controls how dimensions are treated when 
importing an IGES drawing file. Yes - Each IGES 
dimension explodes into an independent note with 
the dimension text and a dimension with an empty 
note. No - Dimensions are treated as before.

yes, no no

Data Exchange export_3d_force_default_nami
ng

Specify whether the Creo model names should be 
used for STEP export. Yes - Use default naming. 
No - Add suffixes to model file names.

yes, no no

Data Exchange export_to_shipit Enable Ship-it interface export. yes, no no
Data Exchange extend_cvpath Extends CVPATH search path for CADDS5 data 

exchanging.
Data Exchange fix_autocad_iges_text_scale Fixes scaling problems with AutoCAD releases 

earlier than Release 10. Yes - Repairs AutoCAD 
files appropriately.

yes, no no

Data Exchange fix_catia_iges_sym_note Corrects a problem caused by multiple rotations of a 
note in a CATIA IGES file. Yes - Rectifies any 
discrepancies.

yes, no no

Data Exchange frt_enabled Loads feature recognition application. yes, no no
Data Exchange iges_clip_view_ent Determines whether IGES entities are clipped with 

regards to IGES views. YES - Entities outside the 
view outline are clipped. NO - No clipping.

yes, no yes



PTC Creo 3.0 Parametric Configuration Options

PTC Inc. 20 PTC Creo 3.0 Parametric Configuration Options

Category Name Description Values Default Value
Data Exchange iges_clip_view_note Determines how IGES notes are clipped with 

regards to IGES views. No_clip - No clipping. 
Full_clip - Notes that are partially outside the view 
outline are clipped. Partial_clip - Notes completely 
outside the view outline are clipped.

no_clip, full_clip, partial_clip no_clip

Data Exchange iges_export_dwg_views Yes - Exports drawing view information. No - Does 
not export drawing view information.

yes, no no

Data Exchange iges_in_dwg_color Yes - Import RGB information to IGES files. The 
color definition entities in the IGES file are imported 
to the drawings as user-defined colors. No - The 
color-definition entities in the IGES files are ignored 
when importing to the drawing.

yes, no no

Data Exchange iges_in_dwg_line_font Controls the import of user-defined line fonts. Yes - 
Give default names to user-defined line styles 
without names in order ("IGES_1," "IGES_2" etc.). 
No - Imports the user-defined line fonts as Solid line 
font.

yes, no no

Data Exchange iges_in_group_to_dwg_layer Yes - Converts an IGES group to drawing layers. No 
- The IGES group is not converted.

yes, no no

Data Exchange iges_note_disp Determines what to do when IGES note entities do 
not point to any views or the drawing entity. See the 
configuration option iges_zero_view_disp.

as_geometry, all_views, no_views, as_is all_views

Data Exchange iges_out_all_srfs_as Default - Outputs all surfaces as appropriate IGES 
surfaces. 114 - This option applies only to 
representations of surface shape. Trimmed surface 
entities (type 144) are exported regardless of 
setting. 128 - Outputs all surfaces as IGES B-spline 
surfaces.

128, 114, default default

Data Exchange iges_out_assembly_default_m
ode

Set default for assembly export via IGES. Flat - 
Single level model. One_level - Assy structure with 
pointers to components. All_levels - Assy structure 
with all comps to IGES files. All_parts - Assy to 
IGES files with geom  info of comps and assy feats.

flat, one_level, all_levels, all_parts flat

Data Exchange iges_out_catia_gdt_width Yes - Enables the desired width of a gtol symbol to 
be exported to CATIA.

yes, no no
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Category Name Description Values Default Value
Data Exchange iges_out_catia_notes Yes - Breaks a large note (greater than 70 strings) 

down into smaller notes, each producing an IGES 
entity.

yes, no no

Data Exchange iges_out_dwg_color Yes - Enables the export of RGB information to 
IGES files. The user-defined colors in the drawing 
are exported to an IGES file as color definition 
entities. No - Ignores the user-defined colors in the 
drawing when exporting IGES file.

yes, no no

Data Exchange iges_out_dwg_line_font Controls the export of user-defined line font through 
IGES. No - Exports all geometry as solid font.

yes, no no

Data Exchange iges_out_ent_as_bspline True - Exports all geometry entities, other than lines 
or arcs, as third-degree B-splines. False - Does not 
export entities as third-degree B-splines.

true, false FALSE

Data Exchange iges_out_jamais_compliant Yes - Specifies IGES output with special JAMA-IS 
subset specification, compliant with the version 1.02 
of JAMA-IS (Japan Automobile Manufacturers 
Association IGES Subset Specification). No - 
Specifies normal IGES.

yes, no no

Data Exchange iges_out_mil_d_28000 Yes - Specifies IGES output that uses the MIL-D-
28000 entity subset.

yes, no no

Data Exchange iges_out_spl_crvs_as_126 Converts all part geometry spline curves to IGES 
entity 126 (B-spline) when creating an IGES file.

yes, no yes

Data Exchange iges_out_spl_srfs_as_128 Converts all part geometry spline surfaces to IGES 
entity 128 (B-spline) when creating an IGES file.

yes, no yes

Data Exchange iges_out_start_note Yes - Exports the text specified by 
system_iges_header_file and user_iges_header_file 
as a note on the drawing. To control note 
placement, use the configuration file option 
put_iges_drawing_entity.

yes, no no

Data Exchange iges_out_symbol_entity Exports a drawing symbol as an IGES general 
symbol entity, IGES type number 228 (yes), or as its 
component entities: notes and lines.

yes, no yes
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Category Name Description Values Default Value
Data Exchange iges_out_trim_curve_deviation Sets the maximum value for the distance between 

an XYZ trimming curve (boundary) and the 
underlying surface of a trimmed surface

-1

Data Exchange iges_out_trim_xyz Controls whether or not XYZ data is output in 
addition to UV data for trimmed surfaces.

yes, no yes

Data Exchange iges_out_trm_srfs_as_143 Yes - Exports all surfaces to IGES entities 141 and 
143. This overrides option iges_out_trm_xyz.

yes, no no

Data Exchange iges_zero_view_disp When IGES geometry does not point to any views 
or the drawing entity. All_views - Creates a copy of 
the entity for each view. No_views - Does not create 
the entity at all. As_is - Creates the entity once, 
using only its own transformation information.

all_views, no_views, as_is all_views

Data Exchange initial_board_bend_y_factor Specifies a value used to determine the neutral 
bend line for a board part. This value is always used 
for non-cylindrical bends. It is used for regular 
bends only when no bend table is specified

0.5

Data Exchange interface_quality Sets amount of checking for overlapping lines and 
collecting lines of same pen color before exporting 
plot or 2-D file. 0 - No check or collection. 1 - No 
check, but collection. 2 - Partial check and 
collection. 3 - Complete check and collection.

3

Data Exchange intf_cadds_import_make_solid Allows the user to solidify all closed quilts during 
import CADDS5 model.

yes, no no

Data Exchange intf_cadds_version Allows the user to switch between the default and 
alternate converter version for interface with 
CADDS5

14, 15 14

Data Exchange intf_generate_log_file Specifies not to generate or generate short or long 
log files for data exchange import operations.

no, long, short short

Data Exchange intf_ignore_suffix_in_pvz YES- the document type as suffix will not be 
appended to the part name in Creo View name 
during Save As to Workspace operation.

yes, no no

Data Exchange intf_in_dwg_pnt_ent Yes - Converts an IGES or DXF point entity to a 
drawing point.

yes, no no
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Category Name Description Values Default Value
Data Exchange intf_in_dwg_view Controls if associativity in an imported IGES view is 

preserved. 3D_VIEWS - tries to create 3D views if 
3D model exists in the file. 2D_VIEWS - Imported 
IGES views work as 2D. No - Imported IGES views 
are exploded and become unrelated.

no, 2d_views, 3d_views 2d_views

Data Exchange intf_in_extract_profiles Default, no profiles in a data exchange file will be 
extracted for use.

all, none, comp none

Data Exchange intf_in_granite_direct_enable Allows the user to switch back to the old 'Import 
Feature' method of reading Desktop .des files and 
Granite .g files into Creo. By default, Creo directly 
opens these models.

yes, no yes

Data Exchange intf_in_layer_asm_dialog Yes - Presents a dialog box to control the import of 
both layers and assemblies. You can choose from 
the list of layers and/or solids available in the file to 
select one or more for import.

yes, no no

Data Exchange intf_in_profile_default Specifies the name of the existing import profile to 
use by default.

Data Exchange intf_out_as_bezier Exports all B-splines as Bezier surfaces. yes, no no
Data Exchange intf_out_asm_mapped_item Export assembly components and instances using 

MAPPED ITEM entity.
yes, no no

Data Exchange intf_out_assign_names Controls how entity names are handled when an 
object is exported to STEP format from part or 
assembly mode. You can give unique names to 
Creo datum points, datum axes, datum curves, 
surfaces, edges, and quilts.

no_name, user_name, id_name no_name

Data Exchange intf_out_auto_layer_ids Yes - Automatically assigns interface IDs for layers 
that were not assigned IDs during export. No - Does 
not assign interface IDs for layers that were not 
assigned IDs during export.

yes, no no

Data Exchange intf_out_blanked_entities Filters export of entities based on their blank status yes, no yes

Data Exchange intf_out_cat_start_model Specifies Catia start model to be used for CATIA II 
.model export.

Data Exchange intf_out_ed_recipe_file Sets the Creo View recipe file for export to .ed and 
.edz formats. For use with Windchill 8.0 and earlier 
servers
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Category Name Description Values Default Value
Data Exchange intf_out_layer Layer mapping mechanism providing an ability to 

group entities to layers or blocks.
none, part_layer, block_layer, 
block_nested_layer, 
block_view_based_layer, 
block_nested_view_based_layer

none

Data Exchange intf_out_layer_rename_table Enables you to assign interface ids to layers during 
export

Data Exchange intf_out_max_bspl_degree Controls the maximum degree of exported B-spline 
surfaces when exporting through IGES

16

Data Exchange intf_out_pvs_recipe_file Sets the Creo View recipe file for export to .pvs and 
.pvz formats. For use with Windchill 9.0 and later 
servers

Data Exchange intf_out_text_length Sets text length in exported 2-D. As_is - Width of 
each character is width of strokes. Full_size - Width 
of each character is width of character text box. 
Adjusted - Adjusts spacing so no extra space left 
and end/start character do not overlap.

as_is, full_size, adjusted full_size

Data Exchange intf_pdf_u3d_create_u3d_files YES - When exporting a Creo model as PDF U3D 
file, create a U3D file of the same name as the PDF 
file.

yes, no no

Data Exchange intf_profile_dir Specifies the directory where import and export 
profiles are stored. Use the full path to avoid 
problems.

Data Exchange intf_pv_recipe_dir Sets the directory for user defined Creo View recipe 
files

Data Exchange intf_use_variable_size Yes - IGES,DXF,STEP files with variable sized 
sheet information are imported andput on the 
appropriate variable-size format. Without a sheet 
size, the system tries to apply the correct variable-
size format.  No - The IGES,DXF,STEP drawing 
isplaced on a standard  sized format.

yes, no yes

Data Exchange intf2d_fit_incompatible_data YES - For import and export, fixes compatibility 
problems between 2-D external formats (such as 
IGES and DXF) and Creo.

yes, no no

Data Exchange intf2d_iges_out_hatch YES - Exports draft xhatching as IGES sectioned 
area entity. NO - exports draft xhatching as 
separate geometric entities.

yes, no no
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Category Name Description Values Default Value
Data Exchange intf2d_in_acad_expl_unsupp_e

nts
Yes - ACAD_PROXY_ENTITY and REGION entities 
are imported as set of draft entities, No - 
ACAD_PROXY_ENTITY and REGION entities are 
ignored.

yes, no yes

Data Exchange intf2d_in_acad_ignore_3d YES - Ignore the 3DSOLID entities, if they exist, in 
the DXF/DWG file being imported in Drawing mode. 
Only, the 2D entities are processed.  NO - Create 
an assembly by processing the 3DSOLID entities in 
the DWG/DXF file being imported in Drawing mode. 
This is the default value for this option.

yes, no no

Data Exchange intf2d_in_acad_wrap_tbl_texts Wrap table texts imported from a DXF or DWG file 
when set to YES.

yes, no no

Data Exchange intf2d_in_assoc_dim_geom Controls if imported associative dimensions remain 
associative. Yes - If the drawing setup option 
associative_dimensioning is Yes, then dimensions 
are imported associative. No - Dimensions do not 
retain associativity.

yes, no no

Data Exchange intf2d_in_bottom_margin Sets the bottom margin in drawing units for 
imported drawings.

0

Data Exchange intf2d_in_create_multiline_note Create a single multi-line note on importing multi-
line text when is set to YES.

yes, no yes

Data Exchange intf2d_in_dim AS_SEP_ENT - Imports each component of a 
dimension separately. AS_IS - Imports dimensions 
as dimensions in Pro/ENGINEER. AS_SYMBOL - 
Imports dimensions as symbols in Pro/ENGINEER.

as_symbol, as_is, as_sep_ent as_is

Data Exchange intf2d_in_dxf_mapping_file Specifies the mapping file for DXF and DWG 
import. Absolute or relative path to the file can be 
used.

Data Exchange intf2d_in_iges_hatch_bnd_laye
r

Yes - Places all sectioned areas boundary imported 
from the IGES file in one layer named 
IGES_HATCH_BOUNDARY. NO - Does not place 
sectioned areas boundary in one layer.

yes, no no

Data Exchange intf2d_in_iges_symbols Controls whether to import IGES symbols as 
symbols or as entities by default. Yes - Import IGES 
symbols as symbols by default. No - Import IGES 
symbols as entities by default.

yes, no yes
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Category Name Description Values Default Value
Data Exchange intf2d_in_left_margin Sets the left margin in drawing units for imported 

drawings.
0

Data Exchange intf2d_in_mi_brk_unsupp_dim Yes - Breaks unsupported MI dimension types to 
separate entities, No - Imports unsupported MI 
dimension types as different type dimensions that 
can look differently.

yes, no no

Data Exchange intf2d_in_mi_lay_parts Yes - Maps MI drafting parts to layers, No - Imports 
MI drafting parts as separate entities.

yes, no yes

Data Exchange intf2d_in_mi_mapping_file Specifies the mapping file for MI import. Absolute or 
relative path to the file can be used.

Data Exchange intf2d_in_mi_sym_parts Yes - Maps MI symbol parts to symbols, No - 
Imports MI symbol parts as separate entities.

yes, no yes

Data Exchange intf2d_in_mi_view_parts Yes - Maps MI annotation views to 2D views, No - 
Imports MI annotation views as separate entities.

yes, no yes

Data Exchange intf2d_in_open_log_window Yes - Opens Import Log File in a separate window. 
No - The Log File does not appear in the window.

yes, no no

Data Exchange intf2d_in_recompute_dim_valu
e

Indicates whether to recompute associative 
dimensions upon import.

yes, no no

Data Exchange intf2d_in_right_margin Sets the right margin in drawing units for imported 
drawings.

0

Data Exchange intf2d_in_std_clrs_as_user_def Yes - standard colors are imported as user-defined 
colors. No - standard colors are mapped to Creo 
colors.

yes, no yes

Data Exchange intf2d_in_top_margin Sets the top margin in drawing units for imported 
drawings.

0

Data Exchange intf2d_in_white_as_black If set to yes entities having white color will be 
imported as black when the background color is 
white.

yes, no yes

Data Exchange intf2d_out_acad_brk_tbl_w_bl_
ln

Yes - drawing tables having blanked lines are 
exported to DXF/DWG as separate entities, No - the 
tables are exported as DXF/DWG tables but the 
lines are not blanked.

yes, no no

Data Exchange intf2d_out_acad_mtext Create a single MTEXT entity for multi-line text 
notes when is set to YES.

yes, no yes
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Category Name Description Values Default Value
Data Exchange intf2d_out_acad_ole_as_image Controls OLE export to DXF/DWG. Yes - exports 

OLE objects as DXF/DWG IMAGEs. No - exports 
OLE objects as separate entities.

yes, no yes

Data Exchange intf2d_out_acad_text_align As_is - Exports notes to DXF/DWG with their 
original alignment values. Fit - Exports notes with 
FIT alignment.

as_is, fit as_is

Data Exchange intf2d_out_acad_unicode Yes - Non-ASCII characters are written in 
UNICODE encoding.

yes, no no

Data Exchange intf2d_out_blanked_layers Enables export of blanked layer entities. If an entity 
is placed on a layer that is blanked and this option is 
set to YES, the entity will be exported.

yes, no no

Data Exchange intf2d_out_cgm_old_lfont_map Yes - Use the old line font mapping in CGM export: 
hidden lines to type 2, CTRLFONT to type 4, 
PHANTOMFONT to type 5. No - Use the new 
mapping: hidden lines to type 12, CTRLFONT to 
type 11, PHANTOMFONT to type 13.

yes, no no

Data Exchange intf2d_out_cgm_ver Provides the ability to choose CGM metafile version 
when exporting from Creo drawing.

1, 3 1

Data Exchange intf2d_out_dxf_mapping_file Specifies the mapping file for DXF and DWG 
export. Absolute or relative path to the file can be 
used.

Data Exchange intf2d_out_enhanced_ents Controls whether the enhanced entities (SPLINE 
and HATCHING) are converted to the 
corresponding DXF entities or represented as 
separate lines and polylines.

none, spline_and_hatch, spline_only, 
hatch_only

spline_and_hatch

Data Exchange intf2d_out_iges_layers_with_id Yes - Exports interface IDs of layers as IGES levels. yes, no no

Data Exchange intf2d_out_image_format If set to "png" shaded views will be exported as a 
PNG image and the background will be transparent. 
If set to "jpeg" shaded views will be exported as a 
JPEG image and the background will be opaque.

jpeg, png png

Data Exchange intf2d_out_line_width YES - Exports line width information to DXF. NO - 
all entities are exported with the default width.

yes, no yes
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Category Name Description Values Default Value
Data Exchange intf2d_out_linemerge_ign_layer

s
If set to yes overlapping lines will be merged 
regardless of their layers when exporting or plotting 
a drawing. If set to no overlapping lines belonging to 
different layers will not be merged.

yes, no no

Data Exchange intf2d_out_open_log_window Yes - Opens Export Log File in special window. No - 
the Log File will not appear in the window.

yes, no no

Data Exchange intf2d_out_pnt_ent Yes - Exports a drawing point to IGES, DXF or 
DWG as a point entity. No - Exports a drawing point 
as shape entities.

yes, no no

Data Exchange intf2d_out_quilt_hl_priority QUILT - quilt lines have higher priority than hidden 
lines when exporting or plotting a drawing. 
HIDDEN_LINE - hidden lines have higher priority 
than quilt lines.

quilt, hidden_line quilt

Data Exchange intf2d_out_splines_to_arcs Yes - splines geometrically representing arcs will be 
exported as arcs. No - such splines will be exported 
as splines.

yes, no yes

Data Exchange intf2d_out_stroke_text Strokes == text is converted to lines and dots. 
"NONE"- Does not stroke out the text for export. 
"ALL" - Strokes out all the text. "SPECIAL" - Strokes 
out only special characters.

all, none, special none

Data Exchange intf3d_ideas_import_filter Enables UI to selectively import I-DEAS part and 
assembly models from the I-DEAS .mf1 and .pkg 
container files.

yes, no no

Data Exchange intf3d_ideas_install_dir Specifies the path for I-DEAS installation. Use the 
full pathname to avoid problems.

Data Exchange intf3d_ideas_run_command Specifies the I-DEAS run command. Default 
command is "ideas".

ideas.cmd

Data Exchange intf3d_in_enable_layer_join No - Join surfaces on import as geometry is loaded 
from file. Yes - Use new method to join surfaces by 
layer (surfaces contained on the same layer are 
joined together first) with a better chance of joining 
those surface elements to form closed geometry.

yes, no yes

Data Exchange intf3d_in_import_as_facets Import faceted data for formats that support both 
facet and Brep representations.

yes, no, default default
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Category Name Description Values Default Value
Data Exchange intf3d_in_lock_redisplay Provides the option to prevent the redisplay of 

models while they are in transitional state during 
Creo Elements/Direct file import.

yes, no no

Data Exchange intf3d_out_anno_as This option will determine if annotations are 
exported and, if exported, whether they will be 
exported as polyline or semantic.

none, default, graphic, semantic graphic

Data Exchange intf3d_out_cat2_ident_crv Specifies model parameter IDENT_CRV while 
exporting to Catia.

-1

Data Exchange intf3d_out_cat2_ident_pt Specifies model parameter IDENT_PT while 
exporting to Catia.

-1

Data Exchange intf3d_out_cat2_infinity Specifies model parameter INFINITY while 
exporting to Catia.

-1

Data Exchange intf3d_out_cat2_model_sz Specifies model parameter MODEL_SZ while 
exporting to Catia.

-1

Data Exchange intf3d_out_cat2_sag Specifies model parameter SAG while exporting to 
Catia.

-1

Data Exchange intf3d_out_cat2_step Specifies model parameter STEP while exporting to 
Catia.

-1

Data Exchange intf3d_out_datums_by_default Determines whether datum curves are included 
when exporting IGES files in Batch mode.

yes, no no

Data Exchange intf3d_out_default_option Controls the type of 3-D data output through 
Pro/BATCH to an IGES or STEP file.

none, wireframe, surfaces, 
wireframe_surfaces, solid, shells

surfaces

Data Exchange intf3d_out_extend_surface Specifies how surfaces are handled for exporting 
files to other systems

yes, no yes

Data Exchange intf3d_out_force_surf_normals IGES and PDGS export. Controls normals of non-
analytic surfaces. Yes - Forces the surface normals 
to point in a consistent direction. No - Does not 
force the surface normals to point in a consistent 
direction.

yes, no no

Data Exchange intf3d_out_jt_auto_lods Generate three default Creo Parametric LODs. yes, no no
Data Exchange intf3d_out_jt_brep No*: Export to JT as facet representation only, 

jt_brep: Export to JT as facet and jt_brep 
representation, xt_brep: Export to JT as facet and 
xt_brep representation

no, jt_brep, xt_brep no

Data Exchange intf3d_out_jt_config_name Name of JT configuration file.
Data Exchange intf3d_out_jt_config_path Path to JT configuration file.
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Category Name Description Values Default Value
Data Exchange intf3d_out_jt_structure Specifies product structure to file structure mapping 

defined in JT Open Toolkit.
per_part, fully_shattered, monolithic per_part

Data Exchange intf3d_out_parameters Exports parameters with models. all, none, designated all
Data Exchange intf3d_out_prop_chord_heights Use maximum chord heights proportional to 

component sizes.
yes, no no

Data Exchange intf3d_out_prop_step_sizes Use maximum step sizes proportional to component 
sizes.

yes, no no

Data Exchange intf3d_out_surface_deviation Sets maximum allowable deviation between original 
and resulting surfaces in the process of converting 
Creo surfaces to spline surfaces. By setting this you 
convert surfaces with a better approximation than by 
using the current model accuracy.

-1

Data Exchange intf3d_out_unicode_to_neutral YES - Unicode strings are exported to the Neutral 
file, NO - Unicode strings are converted to ascii 
characters for Neutral file export.

yes, no yes

Data Exchange intf3d_out_use_num_names Use numeric layer names as layer export IDs. yes, no yes
Data Exchange intf3d_out_use_step_size Use maximum step size(s). yes, no no
Data Exchange intf3d_parasolid_export_schem

a
Allows user to choose the schema to be used for 
parasolid export. Default is SCH_10004. Consult 
online documentation for other valid schema 
settings.

sch_10004

Data Exchange medusa_2d_config_file Specifies the Medusa 2D Interface config. file. 
Absolute or relative path to the file can be used.

Data Exchange mentor_ver_2_0 Yes - Exports the file in IDF 2.0 format. No - Exports 
the file in IDF 1.0 format unless IDF 2.0 is selected 
from the ECAD FORMAT menu.

yes, no yes

Data Exchange pdf_linecap 0 - Butt cap: stroked lines are squared off at the 
endpoint of the path.  There is no projection beyond 
the end of the path.

butt, round, projecting square butt

Data Exchange pdf_linejoin 0 - Miter join: outer edges of the strokes for the two 
segments are extended until they meet at an angle.

round, miter, bevel miter

Data Exchange pdf_use_pentable No - PDF export does not use any defined pentable 
changes as would be applied to plotting the drawing.

yes, no no
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Category Name Description Values Default Value
Data Exchange pro_gplug_dir Specifies the directory in which Granite application 

plug-ins are located. Use the full pathname to avoid 
problems.

<creo_loadpoint>\x86e_win64\
gplugs\

Data Exchange put_iges_drawing_entity Specifies whether or not to suppress the output of 
the IGES drawing entity, #404, to the IGES file. No - 
The drawing entity is not output.

yes, no yes

Data Exchange step_appearance_layers_grou
ps

No - Output of Appearances, Layers, and Groups is 
enabled for STEP standard AP214. Yes - Output of 
Appearances, Layers, and Groups is enabled for 
STEP standard AP203.

yes, no no

Data Exchange step_export_ap214_asm_def_
mode

Toggles the default setting of the File Structure field 
in the STEP Export dialog box for supported 
assembly STEP export files.

single_file, separate_parts_only, 
separate_all_objects

single_file

Data Exchange step_export_dwg_views AS_3D_VIEWS - Export 3-D model geometry with 
its associative views. 
AS_3D_VIEWS_ASSOC_DRAFT - Export 3-D 
model geometry with its associative views and view 
related annotations. NO - Export only 2-D 
representations of the 3-D models. This is the 
default.

no, as_3d_views, 
as_3d_views_assoc_draft

no

Data Exchange step_export_format Specifies output format when exporting to STEP. 
AP203_IS - Formats output to ISO 10303 AP203IS 
format. AP214_CD - Formats output with geometry 
that meets the specification for the long-term 
schema for AP214cc1.

ap203_is, ap202_is, ap209_dis, ap214_is, 
ap203_e2, ap203_is_ext

ap203_is

Data Exchange step_out_asm_val_prop Export validation information for assemblies to the 
STEP file for formats ap203_e2, ap214_is

yes, no no

Data Exchange step_out_material Exports the material definition (name and density) to 
the STEP file for formats ap203_e2, ap214_is and 
203_is_ext

yes, no no

Data Exchange step_out_material_as_product Export the material definition (name and density) to 
the STEP file as a separate STEP PRODUCT entity

yes, no no

Data Exchange step_out_suppl_geom Export datum csys, planes, axes, points to the 
STEP file for formats ap203_e2, ap214_is

yes, no no
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Category Name Description Values Default Value
Data Exchange system_iges_header_file Inserts specified text file into the Start section of 

IGES files (refer to user_iges_header_file). When 
used with user_iges_header_file, the system text 
appears first.

Data Exchange tiff_compression TIFF exports are done without compression. none, g4, packbits, deflate none
Data Exchange tiff_type Determines the type of tiff items are exported to 

variables refer to color sets
rgb, palette, grayscale, mono rgb

Data Exchange use_export_2d_dialog Yes - Opens export options dialog when exporting 
Creo drawing. No - exports file without the options 
dialog.

yes, no yes

Data Exchange use_iges_font_1003 Used to disable the use of IGES font 1003. yes, no yes
Data Exchange use_iges_kanji_font_2001 Specifies whether to convert Kanji notes in Creo to 

IGES Kanji notes (font code) when exporting. Yes - 
Converts Kanji notes to IGES Kanji notes. No - 
Converts using Font 1.

yes, no no

Data Exchange user_iges_header_file Filename - Insert specified text file into the Start 
section of IGES file. Valid parametric note symbols 
will be replaced during export. For example, 
&dwg_name in the text file is replaced by the 
drawing name when a drawing is exported.

Data Exchange vda_header The complete filename of the text file containing 
VDA header information. If you intend to use the 
same header for all VDA files, specify the full 
pathname.

Data Exchange vrml_anchor_url Enables you to place an anchor on a specified 
VRML component during the export to VRML. The 
keywords are optional.

Data Exchange vrml_background_color Yes - Exports a model to VRML with the Creo 
background color.

yes, no no

Data Exchange vrml_explode_lines Yes - Exports a model to VRML with explode lines 
for assembly or assembly process data.

yes, no yes

Data Exchange vrml_export_resolution Specifies the number of levels of detail (LODs) in 
models exported in VRML format.

high, medium, low medium

Data Exchange vrml_export_version Allows the user to choose between exporting to the 
VRML 2.0 or 1.0 format.

2.0, 1.0 2
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Category Name Description Values Default Value
Data Exchange vrml_file_duplicate_material Yes - Ensures that the model components retain 

their true color. No - In some viewers, component 
colors might not be consistent.

yes, no no

Data Exchange vrml_multiple_views All - Exports top-level and lower-level assembly 
component views into VRML format. None - Does 
not export component views into VRML format. Top - 
Exports top-level object view only into VRML format.

all, none, top all

Data Exchange vrml_parameters Controls the export of user parameters. Designated - 
Export only designated parameters. All - Export all 
parameters. None - Do not export parameters.

all, none, designated designated

Data Exchange vrml_simprep_export Yes - Specifies direct and in memory export of top-
level assembly simplified representation to Pro/FLY-
THROUGH package files.

yes, no no

Data Exchange www_add_aux_frame Creates additional frame for each process step or 
for assembly publication. Yes - Auxiliary files 
aux.html are created for each step in assembly 
process (in each step00 directory) to be replaced by 
your .html file. No - Auxiliary files are not created.

yes, no no

Data Exchange www_export_geometry_as Specifies the output format by to one of the values all, vrml, cgm, jpg, cgm_vrml, jpg_vrml, 
cgm_jpg

jpg_vrml

Data Exchange www_multiple_views All - Writes all views in any component to the 
appropriate VRML files. Top - Writes only named 
views that reside in the assembly or process 
assembly to top-level VRML files. None - Does not 
write named views to VRML files.

all, none, top top

Data Exchange www_tree_location Specifies the location of the model tree in the 
browser window. Out - Opens model tree in a 
separate window. In - Includes model tree in the 
Web page and removes the Tree checkbox from 
the control panel.

out, in out

Data Management allow_import_file_extension Allow additonal files with extensions to be shown in 
the import dialog

Data Management bitmap_size Works in conjunction with save_bitmap. Determines 
the size (squared) of the bitmap image that is 
stored.

200
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Category Name Description Values Default Value
Data Management dm_auto_open_zip YES - Windchill CAD packages or zip files will open 

automatically. NO - User selects which file in 
contents to open.

yes, no yes

Data Management dm_cache_limit Enter amount of disk space (in megabytes) to 
allocate for local file storage. The change to the 
existing setting will take effect after Creo is 
restarted.

Data Management dm_cache_mode Indicate which objects will be written to local cache 
when objects in Creo memory are saved.

all, none, modified all

Data Management dm_checkout_on_the_fly Controls the default action presented to the user 
when Check Out on the fly dialog comes up

checkout, continue checkout

Data Management dm_fallback_server_location Specifies the server location where objects will be 
saved when Creo does not provide an ability to 
specify the target save location. This option is 
applicable for Windchill ProductPoint only.

Data Management dm_hide_virtual_default_ws Yes - When there is at least one workspace created 
in any context in selected server, default 
workspaces that were never used, will not be listed. 
No - (Default value) Default workspaces will be 
listed for each context that has no workspace 
defined.

yes, no no

Data Management dm_http_compression_level Set the data compression factor (0-9, 0= no 
compression) for data exchange with a Windchill 
server.

Data Management dm_offline_after_event Allow the user to choose to work offline when there 
is a loss of server connection. Staying online will 
continue to retry server operations.

yes, no yes

Data Management dm_offline_options_activated Yes - Synchronize, Download and Upload boxes are 
checked when going online. No - Only Synchronize 
box is checked when going online.

yes, no yes

Data Management dm_overwrite_contents_on_up
date

Yes: Windchill Workspace Update will overwrite 
locally/modified out of date objects with the ones in 
the server. No (Default): Windchill Workspace 
Update will update metadata only.

yes, no no

Data Management dm_remember_server Primary server/workspace must be set by user for 
each Creo session.

yes, no yes
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Category Name Description Values Default Value
Data Management dm_save_as_attachment Controls the default option for Save A Copy when 

models are saved as in non-Creo format. Yes - It 
will by default save it as secondary content 
attachment to the original CAD Document. No- It will 
by default save it as Primary CAD Document.

yes, no yes

Data Management dm_search_primary_server Search the primary server for dependencies not 
found in the workspace.

yes, no yes

Data Management dm_secondary_upload Indicate when modified Creo objects on a 
secondary server will be moved from the local 
cache to the user's workspace on the server.

automatic, explicit automatic

Data Management dm_synchronize_in_backgroun
d

Yes: Enables workspace synchronization in the 
background. No (Default): Workspace 
synchronization will happen in the foreground.

yes, no no

Data Management dm_update_unconfirmed_insta
nces

Specifies when to force verification and save of 
unconfirmed assembly instances to data 
management system:    NEVER         - never;    
CRITICAL_ONLY - only to correct or prevent 
doubtless data corruption;    ALWAYS        - 
whenever generic is saved

never, always, critical_only never

Data Management dm_upload_objects Indicate when modified Creo Parametric objects will 
be moved from the local cache to the user 
workspace on the server.

automatic, explicit explicit

Data Management let_proe_rename_pdm_objects Determines whether an object fetched from a PDM 
database can be renamed in a Creo session.

yes, no no

Data Management pdm_rev Specify how the system parameter, PDM_REV, 
should be formatted. Only useful for objects 
submitted to Pro/PDM or Pro/INTRALINK.

pdmrev_fmt_rev_ver, pdmrev_fmt_rev, 
pdmrev_fmt_branch_rev_ver, 
pdmrev_fmt_branch_rev

pdmrev_fmt_rev_ver

Data Management read_parameters_of_excluded Allow Creo designated parameters on excluded 
objects in Simplified Representation to be visible in 
Model Tree columns.

yes, no, common_name_only no

Data Management regenerate_read_only_objects Determines whether an object retrieved from PDM 
database with read only status can be regenerated 
in a Creo session.

yes, no yes

Data Management save_bitmap When performing a save on a model, determines 
what level of the assembly will have bitmap images 
created of modified components.

none, toplevelonly, alllevels none
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Category Name Description Values Default Value
Data Management save_bitmap_type When performing a save on a model, determines 

the type of image file that is created for that model. 
Used with "save_bitmap" option.

cgm, bmp, tiff, gif, jpeg bmp

Data Management save_unchanged_pdm_object Determines how to save in the current working 
directory an object fetched from a Pro/PDM 
database into a Creo session.

as_ref, as_copy as_ref

Design Manager dont_show_symbol_nodes Do not show references derived from relations in 
Parent/Child viewer.

yes, no no

Dimensions & 
Tolerances

allow_rfs_default_gtols_always Yes - Enables RFS/Default gtols to be created even 
when not permitted by ANSI standard.

yes, no no

Dimensions & 
Tolerances

ang_dim_in_screen Yes - If the display is in the default pan/zoom setting 
(View>Pan/Zoom>Reset), the system checks 
whether an angular dimension is visible on the 
screen. If it is not visible, then the system moves the 
dimension to a visible location.

yes, no no

Dimensions & 
Tolerances

angular_tol An alternative format for setting default angular 
tolerance dimensions. The value sets the number of 
decimal places, and the tolerance is the actual 
tolerance value. For integer dimensions, the value is 
zero, and the tolerance is an integer.

0

Dimensions & 
Tolerances

angular_tol_0.0 Sets the default tolerance for angular dimensions. 
Each option sets a tolerance for a specific decimal 
place. The value is the place of the last decimal.

5

Dimensions & 
Tolerances

angular_tol_0.00 Sets the default tolerance for angular dimensions. 
Each option sets a tolerance for a specific decimal 
place. The value is the place of the last decimal.

50

Dimensions & 
Tolerances

angular_tol_0.000 Sets the default tolerance for angular dimensions. 
Each option sets a tolerance for a specific decimal 
place. The value is the place of the last decimal.

500

Dimensions & 
Tolerances

angular_tol_0.0000 Sets the default tolerance for angular dimensions. 
Each option sets a tolerance for a specific decimal 
place. The value is the place of the last decimal.

5000
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Category Name Description Values Default Value
Dimensions & 
Tolerances

angular_tol_0.00000 Sets the default tolerance for angular dimensions. 
Each option sets a tolerance for a specific decimal 
place. The value is the place of the last decimal.

50000

Dimensions & 
Tolerances

angular_tol_0.000000 Sets the default tolerance for angular dimensions. 
Each option sets a tolerance for a specific decimal 
place. The value is the place of the last decimal.

500000

Dimensions & 
Tolerances

create_fraction_dim Yes - All dimensions created will be displayed as 
fractions.

yes, no no

Dimensions & 
Tolerances

default_ang_units Sets the display of newly created angular 
dimensions both in the model and in the drawing. 
There is no impact on dimensions previously 
created. ang_deg - Decimal degrees.  ang_min - 
Degrees and decimal minutes ang_sec - Degrees, 
minutes, and decimal seconds

ang_deg, ang_min, ang_sec ang_deg

Dimensions & 
Tolerances

default_dec_places Sets the default number of decimal places (0-13) to 
which to round newly created dimensions. 
Unrounded dimensions automatically determine the 
number of decimal places required to display their 
stored value.

2

Dimensions & 
Tolerances

default_dim_num_digits_chang
es

Sets the default number of digits displayed in a 
dimension to the last entered value. No - The 
system defaults to the value specified for the 
configuration file option default_dec_places.

yes, no yes

Dimensions & 
Tolerances

default_placement_surfacefinis
h

Sets the default placement type for surface finishes 
within the surface finish UI.

with_leaders, on_entity, normal_to_entity, 
free

normal_to_entity

Dimensions & 
Tolerances

dim_fraction_denominator Sets the largest denominator to be used for 
fractional dimensions. If the fraction can be 
reduced, then it converts to the lowest possible 
denominator (for example, 4/32 converts to 1/8).

32

Dimensions & 
Tolerances

dim_fraction_format Std - Displays fractional dimensions in the standard 
Creo format. Aisc - Displays fractional dimensions in 
the American Institute of Steel Construction (AISC) 
format and displays architectural units in AISC 
format for feet-inches.

std, aisc std
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Category Name Description Values Default Value
Dimensions & 
Tolerances

dim_offscreen_limit If more than zero, sets the margin beyond which 
dimensions are automatically snapped back onto 
the screen.  For example, a value of .2 lets a 
dimension be 20% of the window size outside the 
window.  If set to zero, disables snapping of 
offscreen dimensions.

0.2

Dimensions & 
Tolerances

display_tol_by_1000 If set to Yes, tolerances for non-angular dimensions 
will be displayed multiplied by 1000.

yes, no no

Dimensions & 
Tolerances

gtol_dim_placement Controls display of geometric tolerances in Part. 
Use like drawing set-up option of the same name. 
On_bottom - Gtols display at bottom (below 
additional lines of text). Under_value - Gtols display 
under dimension value (above additional lines of 
text).

on_bottom, under_value on_bottom

Dimensions & 
Tolerances

linear_tol An alternate format for setting default linear 
tolerance dimensions. First value sets the number 
of decimal places. Second value is the actual 
tolerance. For example, 6 0.000025 sets tolerance 
to six decimal places. The default tolerance is 
0.000025.

0.000000 -1

Dimensions & 
Tolerances

linear_tol_0.0 Specify a range for default tolerances of linear and 
angular dimensions. These values affect only 
models created after the tolerance options are 
specified in the configuration file.

1

Dimensions & 
Tolerances

linear_tol_0.00 Specify a range for default tolerances of linear and 
angular dimensions. These values affect only 
models created after the tolerance options are 
specified in the configuration file.

1

Dimensions & 
Tolerances

linear_tol_0.000 Specify a range for default tolerances of linear and 
angular dimensions. These values affect only 
models created after the tolerance options are 
specified in the configuration file.

1

Dimensions & 
Tolerances

linear_tol_0.0000 Specify a range for default tolerances of linear and 
angular dimensions. These values affect only 
models created after the tolerance options are 
specified in the configuration file.

1
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Category Name Description Values Default Value
Dimensions & 
Tolerances

linear_tol_0.00000 Specify a range for default tolerances of linear and 
angular dimensions. These values affect only 
models created after the tolerance options are 
specified in the configuration file.

1

Dimensions & 
Tolerances

linear_tol_0.000000 Specify a range for default tolerances of linear and 
angular dimensions. These values affect only 
models created after the tolerance options are 
specified in the configuration file.

1

Dimensions & 
Tolerances

maintain_limit_tol_nominal Maintains the nominal value of a dimension 
regardless of the changes that you make to the 
tolerance values.

yes, no no

Dimensions & 
Tolerances

mark_approximate_dims Yes - Displays a tilde (~) in front of a dimension that 
is set to display as a fraction and has an actual 
value that is not rounded to equate exactly to the 
displayed fractional value (the fraction shows 7/32 
but the actual value is .22, not 0.21875).

yes, no no

Dimensions & 
Tolerances

minimum_angle_dimension Controls the minimum angle value under which 
Creo assumes colinearity of the selected items 
when creating a dimension.

1

Dimensions & 
Tolerances

parenthesize_ref_dim Encloses reference dimensions in parentheses. No - 
Follows reference dimensions with the text "REF".

yes, no no

Dimensions & 
Tolerances

restricted_gtol_dialog Determines whether the Geometric Tolerance 
dialog restricts the user by graying out elements that 
are considered "illegal".

yes, no yes

Dimensions & 
Tolerances

round_displayed_dim_values Sets the default status of the Rounded Dimension 
Value checkbox for newly created or shown 
dimensions.

yes, no yes

Dimensions & 
Tolerances

tbl_driven_tol_val_edit Tbl_driven_tol_val_edit Y/N* - "Yes" allows users to 
directly edit the tolerance value of dimensions 
whose tolerance values are driven by tolerance 
tables. Editing the tolerance value of a dimension 
will make the dimension non-table-driven. "No" 
disallows direct editing of the tolerance values of 
table driven tolerances.

yes, no no

Dimensions & 
Tolerances

tol_display Displays dimensions with or without tolerances. yes, no no
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Category Name Description Values Default Value
Dimensions & 
Tolerances

tolerance_class Sets the default tolerance class for ISO-standard 
models. The system uses the tolerance class in 
conjunction with the dimension value when 
retrieving tolerances for General or Broken Edge 
dimensions.

medium, fine, coarse, very_coarse

Dimensions & 
Tolerances

tolerance_standard Sets the tolerance standard used when creating the 
model.

ansi, iso ansi

Dimensions & 
Tolerances

tolerance_table_dir Sets the default directory for user-defined tolerance 
tables for ISO-standard models. All Holes and 
Shafts tables overwrite existing tables when loaded.

Dimensions & 
Tolerances

use_major_units Determines if fractional dimensions are displayed in 
feet-inches, such as 1' 3 1/2" for 15.5 inches.  Used 
in retrieval of pre-Creo solids to set detail setup 
option, and used at runtime when setup value is 
'default'.

yes, no no

Dimensions & 
Tolerances

use_nom_dim_val_in_expr Yes - use dimensions' nominal values in 
expressions.  No - use current values.

yes, no no

Drawing allow_move_attach_in_dtl_mov
e

Yes - Move and Move Attach commands in drawing 
mode act together. No - Move and Move Attach 
commands in drawing mode do not act together.

yes, no yes

Drawing allow_move_view_with_move Disallow the movement of drawing views with the 
mouse.

yes, no no

Drawing allow_refs_to_geom_reps_in_d
rws

Yes - Allows you to create drawing references to 
geometry representations (includes dimensions, 
notes, and leaders). These references may become 
invalid if the referenced geometry changes resulting 
in geometry representations not updating in 
drawings.

yes, no no

Drawing allow_vert_select_in_dim_creat
e

Allow highlight of model vertices during dimension 
placement in drawings

yes, no yes

Drawing auto_constr_offset_tolerance Sets the auto constraint tolerance for creating offset 
dimensions. If distance is less than this tolerance 
multiplied by component size, offset is set as 
coincident. Default value is 0.5 .

0.5
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Category Name Description Values Default Value
Drawing auto_regen_views Yes - Automatically repaints the drawing display 

when changing from one window to another. No - 
Update to drawing views will only occur when 
manual updates are made via Repaint or View> 
Update.

yes, no yes

Drawing autobuildz_enabled Loads AutobuildZ application. yes, no no
Drawing bom_format Sets the BOM format file to be used for a 

customized BOM.  Specify name and path.
<creo_loadpoint>\text\format.b
ft

Drawing create_drawing_dims_only Yes - Saves all new driven dimensions created in 
the drawing inside the drawing as associative draft 
dimensions. No - Saves driven dimensions created 
in Drawing mode on solid geometry in the solid.

yes, no no

Drawing default_ang_dec_places Sets the default number of decimal places (0-13) to 
which to round newly created angular dimensions. 
Unrounded angular dimensions automatically 
determine the number of decimal places required to 
display their stored value.

1

Drawing default_draw_scale Sets the default drawing scale for views added with 
the No Scale command. The value must be greater 
than 0. No - The system does not set a default 
drawing scale.

-1

Drawing default_font_kerning_in_drawin
g

Determines initial setting of Font kerning when 2D 
drawing annotations are created. Yes - Font kerning 
is on for new 2D annotations.

yes, no no

Drawing disp_trimetric_dwg_mode_view Displays the model in default orientation when 
placing a general view on the drawing. No - Model 
does not appear until Default is chosen from the 
Orientation dialog box.

yes, no yes

Drawing display_dwg_sketch_constraint When set to yes, parametric sketching constraints, 
such as V for vertical, are displayed when a drawing 
object is selected

yes, no no

Drawing display_dwg_tol_tags Sets the display of the tolerance tags that appear in 
drawings. This option does not affect the display of 
tolerances on dimensions.

yes, no yes
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Category Name Description Values Default Value
Drawing display_in_adding_view Controls model display in a drawing when 

auto_regen_views is No. Wireframe - Adds new 
views in wireframe, displays datums. 
Minimal_wireframe - Displays in wireframe, no 
datums, axes, or silhouette edges. Default - 
Displays using the Environment setting.

default, wireframe, minimal_wireframe wireframe

Drawing draw_models_read_only Yes - Drawing model files are read-only.  No model 
changes can be made.  Cosmetic_only - Only 
cosmetic changes can be made to the model.  
Design changes are not allowed.  Cosmetic 
changes include adding driven dimensions, cross 
sections, and explode states.

yes, no, cosmetic_only no

Drawing draw_points_in_model_units Defines the current draft view's coordinate values as 
model units rather than drawing units. The GET 
POINT menu uses the scale of the draft view and 
the draft view's model units for relative and absolute 
coordinate entry and display in the Message 
Window.

yes, no no

Drawing drawing_ole_image_dpi Resolution of OLE object images. The range of valid 
values is 0 to 600 dots per inch.

150

Drawing drawing_setup_file Sets the default drawing setup file option values for 
your Creo session, otherwise, the system uses the 
default drawing setup file option values. Certain 
parameters in the file are valid only if you have a 
license for Pro/DETAIL.

<creo_loadpoint>\text\prodetail
.dtl

Drawing drawing_shaded_view_dpi Resolution of exported shaded drawing views.  The 
range of valid values is 0 to 600 dots per inch.

150

Drawing drawing_view_origin_csys The named coordinate system will be used as the 
origin of a newly created view or of a modified view.  
None - The system will not use a previously 
specified coordinate system.

none

Drawing drawing_warn_if_flex_feature Display a warning dialog upon opening a drawing 
with models that contain flexible features advising 
users that annotations may be out of date and 
should be verified.

yes, no yes
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Category Name Description Values Default Value
Drawing dwg_unicode_conversion_lang

uage
Defines the language used during Unicode 
conversion of pre-Wildfire 4.0 drawings.    This 
option does not affect the conversion of models.  
File - Uses the language stored in the drawing 
header file; Session - Uses the language of the 
current Creo session.

file, session, english, japanese, french, 
german, russian, italian, spanish, korean, 
chinese_tw, chinese_cn, hebrew, greek, 
turkish, czech, polish, hungarian, 
slovenian, portuguese, slovak, usascii

file

Drawing enable_shaded_view_in_drawi
ngs

Yes - shading display is allowed in drawing views. 
No - shading display will be shown in wireframe.

yes, no yes

Drawing force_wireframe_in_drawings Yes - Displays all views of drawings in wireframe. 
No - Displays views according to the display set for 
the session (wireframe, hidden, and so on).

yes, no no

Drawing format_setup_file Assigns a specified setup file to each drawing 
format. To assign the drawing's parameter values to 
the format, you must retrieve the drawing's setup file 
into the format.

dwgform.dtl

Drawing highlight_erased_dwg_views Controls the display of erased view outlines 
(environment option Highlight Erased Views). Yes - 
Highlights erased views. No - Turns off highlighting 
for erased views.

yes, no yes

Drawing highlight_new_dims In drawing mode, highlights new dimensions in red 
until you repaint the screen.

yes, no no

Drawing hlr_for_quilts In Drawing, controls quilt display in hidden line 
removal. Yes - Includes quilts in the hidden line 
removal process (preselects Qlt HLR in the VIEW 
DISP menu). Default in the VIEW DISP menu, uses 
the value you have set.

yes, no no

Drawing make_aux_view_notes Automatically adds view names to auxiliary views 
using AUX VIEW* viewname-viewname. You can 
modify the view name after adding the view to the 
drawing.

yes, no no

Drawing make_parameters_from_fmt_t
ables

Determines the handling of values entered in a 
format table when you replace one drawing format 
with another. Yes - Stores entered values for format 
table and copies them with the table. No - Prompts 
you to re-enter all the values for the format table.

yes, no no
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Category Name Description Values Default Value
Drawing make_proj_view_notes Automatically adds view names to projection views 

in the format "VIEW viewname-viewname." You can 
modify the view name after adding the view to the 
drawing.

yes, no no

Drawing ole_unlimit_zoom Yes - The OLE object is displayed in any zoom level 
(could result in performance degradation). No - The 
OLE object disappears in high zoom-in levels.

yes, no no

Drawing pick_chain_tangent_only Specifies the extent of draft entity chains selected. 
Yes - Only entities in the chain that are tangent will 
be selected. No - All entities connected end to end 
will be selected.

yes, no no

Drawing preferred_export_format Set the default preferred export file type for export 
from drawings.

cgm, tiff, iges, dxf, step, pdf, dwg, 
medusa, stheno

pdf

Drawing pro_dtl_setup_dir Sets the directory for the drawing setup files. If this 
option is not set, the system uses the default setup 
directory.

Drawing pro_format_dir Sets the default directory for the drawing format 
library. Use the full pathname to avoid problems.

Drawing pro_note_dir Specifies the directory from which to retrieve notes 
entered from a file. Use the full path name to avoid 
problems.

<dir_name>\dump_x86e_win6
4\

Drawing pro_palette_dir Sets the default directory for drawing symbol palette 
files.

<creo_loadpoint>\symbols\pale
tte\

Drawing pro_symbol_dir Set and automatically create the default directory for 
saving and retrieving user-defined symbols. If you 
do not specify a directory, the system uses the 
current working directory. Use full path name to 
avoid problems.

<dir_name>\dump_x86e_win6
4\

Drawing pro_table_dir Specifies the directory to be used when tables are 
retrieved or saved. Use the full path name to avoid 
problems.

Drawing remember_last_get_point_opti
on

Yes - Sets the default of the GET POINT menu as 
the last option picked among Pick Pnt, Vertex and 
On Entity.

yes, no no
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Category Name Description Values Default Value
Drawing save_display Yes - Stores view geometry and detail items such 

as solid dimensions. These items are displayed 
when retrieving the drawing in View-Only mode.

yes, no no

Drawing save_drawing_picture_file Embed - Embeds a picture file inside a drawing for 
preview purposes. Export - Saves a drawing file as 
a picture file in the working directory when saving a 
drawing. Both - Does both embed and export.

no, export, embed, both embed

Drawing save_modified_draw_models_
only

Determines whether the system saves the model 
after you have changed it. No - Saves the model 
every time that you store the drawing.

yes, no yes

Drawing select_hidden_edges_in_dwg Controls selectability of hidden edges in no-hidden 
drawing views.

yes, no yes

Drawing selection_of_removed_entities Yes - Entities in front of cross-section (planar or 
offset) can be selected, clipped (using Z-clipping), or 
erased with EDGE DISP menu. No - Geometry, 
datum points or curves, cosmetic features, threads, 
grooves, or coordinate systems cannot be erased.

yes, no no

Drawing show_annotations_dialog_limit Default value for Annotations dialog box.

Drawing show_preview_default This option determines the default behavior for 
preview in Show/Erase.

remove, keep remove

Drawing snap_drw_entity_to_snap_line Yes - Enable snapping of drawing and report entities 
to snap lines. No - disable snapping of drawing and 
report entities to snap lines.

yes, no yes

Drawing switch_dims_for_notes Yes - Dimensions will be displayed in their symbolic 
format during drawing note creation. No - 
Dimensions will be displayed in drawing notes as 
numerical values.

yes, no yes

Drawing sym_leader_orient_move_text With Pro/DETAIL, automatically regroups weld 
symbol instances after you move the text.

yes, no no

Drawing symbol_instance_palette_file Specifies the location of the symbol instance 
palette.

Drawing symbol_palette_input Controls the display of the special symbol palette 
during note creation.

yes, no yes
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Category Name Description Values Default Value
Drawing todays_date_note_format Controls the initial format of the date displayed in a 

drawing. The format for the setting is a string 
consisting of three portions: the year, the month, 
and the date. You can enter the portions in any 
order.

%dd-%mmm-%yy

Drawing tol_num_digits_default_driven Yes - The Default check boxes in the number of 
digits area of the Dimension Properties dialog will be 
checked when a dimension is created or first 
shown. No - The check boxes will be unchecked 
when a dimension is created or first shown.

yes, no yes

Drawing triangulate_filled_areas Subdivide filled areas into triangles (may affect 
memory usage and plot files).

yes, no no

Drawing variant_drawing_item_sizes No - Drawing items moved/copied to a different 
sheet or located on a changed sheet keep same 
size and relative orientation on paper. Yes - Some 
items scale/reposition to be the same on paper, and 
others scale and/or reposition to be the same on 
screen.

yes, no no

Drawing warn_if_iso_tol_missing Yes - Returns the user to the dimension properties 
dialog to select a different table. No - Applies the 
tolerance according to existing functionality.

yes, no no

Education & Social 
Tools

enable_learning_connector Enable the Learning Connector, which provides 
context specific access to videos, training, help 
topics, and technical support content.  When 
enabled, the Learning Connector is added to the 
ribbon bar next to Help.

yes, no yes

Electromechanical align_cable_bundles Align NEWLY CREATED bundles where they meet 
or branch out

yes, no yes

Electromechanical allow_bundle_flat_cables Allow to create a bundle over a group of flat packing 
cables.

yes, no no

Electromechanical allow_harn_mfg_assy_retrieval Allow to retrieve a harness mfg assembly directly. yes, no no

Electromechanical assemble_parent_connector Assemble parent connectors on locations 
referencing a subconnector.

yes, no yes
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Category Name Description Values Default Value
Electromechanical auto_convert_cables Yes - When regenerating a pre-Release 11.0 

cabling assembly, the system automatically creates 
a separate spool feature for every individual wire or 
cable in the assembly. No - An interface for the 
cable conversion appears.

yes, no yes

Electromechanical auto_xml_on_retrieve Automatically load Cabling Logical Reference from 
an XML file when retrieving the cabling assembly

yes, no no

Electromechanical auto_xml_on_save Automatically create an XML Logical Reference 
when saving a cabling assembly

yes, no no

Electromechanical autoroute_path_param_name Set the wire parameter to use to select a path 
during autorouting.

use_path

Electromechanical boeing_extract_bundle Yes - Uses the extract bundle algorithm. No - Does 
not use the extract bundle algorithm.

yes, no no

Electromechanical bundle_transition_create_meth
od

Control whether bundle transitions are created 
automatically. Default is automatic.

automatic, manual

Electromechanical cable_bundle_transition_length Transition length is controlled by the formula Larger 
Diameter X <percentile>. Default value is 
50&#91;0...250]%.

0.5

Electromechanical cable_int_portions_for_clr No - Global clearance checking for internal cable 
portions is excluded. Yes - Global clearance 
checking for internal cable portions is included.

yes, no no

Electromechanical cable_jacket_termination Ports - Cable jackets are routed between the entry 
ports. Network Ends - Cable jackets are terminated 
at the network ends.

ports, network ends network ends

Electromechanical cable_location_override_color Override the system color of cable locations. Enter 
RGB values between 0 and 255 separated by 
space.

Electromechanical cable_segment_override_color Override the system color of cable segments that do 
not have a color map. Enter RGB values between 0 
and 255 separated by space.

Electromechanical cables_with_hlr Cables are not hidden behind objects. yes, no yes
Electromechanical cabling_split_multi_pnt_locs Setup whether to convert multiple-location features 

into single location features.
yes, no yes

Electromechanical compact_cables_packing Setup whether the new packing of cables should be 
applied.

yes, no no
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Category Name Description Values Default Value
Electromechanical compare_spools_by_name Compare spools by names in logical compare. yes, no yes
Electromechanical cti_class_color_file Sets the CTI class color file for CTI class color 

display  during electrical clearance and creepage 
analysis.  Use the full pathname to avoid problems.

Electromechanical diagram_export_allow YES: Allow user to save a copy of loaded diagrams 
as DGE file for loading into Routed Systems 
Designer, NO: Do not provide option to save a 
diagram as DGE.

yes, no no

Electromechanical diagram_pin_edit_multi_line (Diagram)  Determines the Pro/TABLE format used 
when you are modifying pin parameters.   "yes" - 
You can add user-defined pin parameters by 
including them between the DEFINE and ENDDEF 
statements for each pin.   "no" - The system uses 
columnar format and

yes, no no

Electromechanical display_duplicate_harness_ms
g

Display warning message when duplicate harness 
are identified in the same assembly.

yes, no yes

Electromechanical display_internal_cable_portion Yes - Internal cable portions will be displayed for 
any wires that have been manually set to Yes in the 
Cable Paths Setup dialog box for each individual 
splice and custom component. This option can be 
overridden in the Environment dialog box.

yes, no no

Electromechanical display_route_cable_preview If no then Route Cables tool does not display 
preview of cables as they are routed.  Otherwise 
Route Cables tool will show a preview of the path 
routed cables will follow.

yes, no yes

Electromechanical display_thick_cables Yes - Display cables and wires with thickness. No - 
Display the centerline of cables and wires only. This 
option can be overridden in the Environment dialog 
box.

yes, no no

Electromechanical enable_cable_channel Activates channel functionality yes, no no
Electromechanical fan_significant_locations_only Setup whether only significant locations should be 

flattened on flattening a harness.
yes, no yes

Electromechanical fan_with_network Setup whether the network should be included on 
flattening a harness.

yes, no yes
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Category Name Description Values Default Value
Electromechanical freeze_failed_cable_locations Suspends the cable location at its last known 

assembly location.
yes, no no

Electromechanical full_hlr_for_cables Full - Removes hidden lines from view when cables 
hide other geometry (use when Hidden Line active). 
Partial - Cables hide other non-interfering cables 
except when cables route together between same 
locations. None - Display hidden lines (faster).

none, full, partial full

Electromechanical harn_mfg_branch_angle Sets the default value for the branch location angle 
for the harness manufacturing. Enter a value 
between 10 and 130.

80

Electromechanical harn_start_model_dir Provides the complete path to the directory 
containing harness start parts and assemblies

Electromechanical harn_tang_line_display Display the tangency lines between cable segments 
in thick cable display mode.

yes, no yes

Electromechanical hlr_for_xhatches Controls whether HLR to be enabled for 
crosshatches in drawing mode.

yes, no no

Electromechanical ignore_bundles_in_find_cables Include bundles and overbraids in the query results 
when the model or logical data is queried for 
unrouted items.

yes, no no

Electromechanical network_location_override_col
or

Override the system color of network locations. 
Enter RGB values between 0 and 255 separated by 
space.

Electromechanical network_segment_override_col
or

Override the system color of network segments. 
Enter RGB values between 0 and 255 separated by 
space.

Electromechanical orthogonal_snap Controls non-90 degree routing in Pro/DIAGRAM. 
Yes - Turns the Ortho Snap function on. You can 
sketch wires only at the default horizontal and 
vertical orientation. No - Enables you to sketch wires 
in drawings at angles other than the default.

yes, no yes

Electromechanical pro_cbltrm_dir Sets the directory from which terminators are 
retrieved. Use the full pathname to avoid problems.

Electromechanical pro_spool_dir Sets the directory from which spools are retrieved. 
Use the full pathname to avoid problems.

<dir_name>\dump_x86e_win6
4\
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Category Name Description Values Default Value
Electromechanical report_end_splice Setup whether the terminal splices of cables are 

reported.
yes, no no

Electromechanical ribbon_cable_flat_direction Flat ribbon cables in the y-axis of entry ports. y_axis, x_axis y_axis
Electromechanical smaller_bundle_min_bend_rad Setup whether to consider the thickness of the 

bundle when set up the minimum bend radius.
yes, no no

Electromechanical template_flat_harness Specify the model used as the default flattened 
Harness assembly template.

Electromechanical template_harnesspart Specify the model used as the default Harness part 
template.

Electromechanical terminator_table_out_unicode YES - Unicode strings are exported in terminator 
table files, NO - Unicode strings are converted to 
ASCII characters for terminator table export.

yes, no yes

Electromechanical trace_thru_splice_connector Report the from/to connectors of cables passing 
through splices correctly.

yes, no no

Electromechanical update_harness_mfg_line_colo
r

Update cable line color for harness-mfg part created 
in release 2000i or earlier.

yes, no no

Electromechanical update_loom_bundle_data Setup whether to update loom bundle data from old 
harnesses.

yes, no no

Electromechanical update_pre_130_harness Yes - When a cable is added between two 
previously laid out locations in a three-dimensional 
reference harness, display of the new cable will 
update automatically in pre-Release 13 flattened 
cable models.

yes, no no

Electromechanical update_pre_16_cable_layers Yes - Harnesses containing cables routed prior to 
Release 16.0 will be automatically updated upon 
retrieval to comply with new display standards.

yes, no no

Environment accuracy_lower_bound Enter an accuracy value to override the default 
lower limit.  The minimum value for relative 
accuracy is 1E-06.

0.0001

Environment activate_window_automatically Yes - Execute Activate command automatically after 
a window is selected. No - Don't execute Activate 
command automatically after a window is selected.

yes, no yes
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Category Name Description Values Default Value
Environment bell Yes - Turns on the keyboard bell that rings after 

each prompt. No - Turns off the keyboard bell. To 
override this setting use the Environment dialog box 
on the Tools menu.

yes, no no

Environment clearance_triangulation Specifies the quality of surface triangulation used to 
obtain initial guess points for clearance and 
interference calculations.

none, high, medium, low none

Environment clock Yes - Displays the clock while Creo is working. yes, no no
Environment clr_print_plus_minus Sets the display of the system accuracy when 

calculating clearances between two parts or 
surfaces. The default is to not display the accuracy.

yes, no no

Environment company_name Used with the export option iges_out_mil_d_28000. 
To support MIL-D-28000, your company name is 
required input and the system prompts you every 
time you export through IGES unless you set the 
company name in your configuration file.

Environment default_abs_accuracy Defines the default absolute part accuracy. 0
Environment des_exp_confirm_on_save When you use a `Save` command during a Design 

Exploration session, it does not save the session, it 
prompts to add a new checkpoint.

yes, no yes

Environment des_exp_create_auto_cps Set the maximum number of automatically created 
checkpoints allowed. Additional checkpoints 
override previous checkpoints. Type a value from 1 
to 99. Type 0 to prevent automatic checkpoint 
creation.

Environment des_exp_create_backups Back up all models in session when starting Design 
Exploration and all models opened and modified 
during the session. When backup is on, starting a 
Design Exploration session might take some time.

yes, no no
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Category Name Description Values Default Value
Environment des_exp_data_path Sets the directory for the Design Exploration 

session. The default location is in a default system 
folder. Type a valid file path to change the directory 
to a user defined one. Data from only one session is 
stored.

Environment des_exp_display_type Set the default display of the Checkpoint Tree. 
'Tree' - Displays all branches in the Checkpoint 
Tree. 'Timeline' - Displays checkpoints in 
chronological order (des_exp_display_type).

tree, timeline tree

Environment des_exp_show_cp_props_dial
og

Open the Checkpoint Properties dialog box when 
you add a new checkpoint, or turn an automatic 
checkpoint into a regular one.

yes, no yes

Environment display_annotations Determines whether or not annotations are 
displayed in 3D models.

yes, no yes

Environment display_full_object_path Controls the display of the object's full file name 
(including its object-type suffix and its version 
number) and file path in the window title and Model 
Info display. Yes - Displays full file name and file 
path. No - Displays object name only.

yes, no no

Environment display_model_anls_selection Determines whether or not to highlight the selected 
components during a Model Analysis.

yes, no no

Environment enable_absolute_accuracy Controls display of the ACCURACY menu. Yes - 
ACCURACY menu always appears when you 
choose Accuracy from the PART SETUP menu. No - 
The menu appears only if the part is currently 
defined with absolute accuracy.

yes, no no

Environment flip_arrow_scale Sets a scale factor for enlarging the size of the flip 
arrow that appears for feature creation direction 
(default = 1).

1

Environment highlight_geometry Yes - Items selected in the model tree are 
highlighted in the geometry area.

yes, no yes

Environment info_output_format Setup the default format type for information 
presentation. Text - information will be output as 
simple text. HTML - information will be output as 
html data.

text, html html
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Category Name Description Values Default Value
Environment info_output_mode Sets default method for presenting information. Both 

- View information on screen and write information 
to file. Screen - View information on screen only. 
File - Write information to file only. Choose - Select 
method from the INFO OUTPUT menu.

both, choose, screen, file both

Environment intelligent_fastener_enabled Enables Intelligent Fastener. You must restart Creo 
for the setting to take effect.

yes, no yes

Environment mass_property_calculate Calculate mass properties upon regeneration, upon 
save or by user request

automatic, by_request, check_upon_save by_request

Environment mathcad_automapping Toggles Mathcad analysis automapping of variables yes, no no

Environment mdx_collision_num_triangles The number of mesh triangles which are used to 
approximate model in collision detection.

1000

Environment measure_sig_figures Sets the number of significant figures displayed as 
results when using the Measure dialog box from the 
Info menu.

6

Environment model_grid_balloon_display Controls the display of grid balloons. yes, no yes
Environment model_grid_neg_prefix Enables you to specify the prefix to use for negative 

numbers in the balloon capture of the grid.
-

Environment model_grid_num_dig Controls the number of decimal places displayed in 
the balloon capture. 0 - Only integers display.

Environment model_grid_spacing Sets the default model grid spacing. 1.5
Environment model_notes_as_labels Gives the option to display notes as either full text or 

as label. Can also be toggled with environment 
option "Display Notes as Names."

yes, no no

Environment model_tree_start Toggles display of the Model Tree. Yes - Displays 
the Model Tree window along with its model. No - 
Does not display the Model Tree window.

yes, no yes

Environment modelcheck_enabled Enable ModelCHECK yes, no yes
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Category Name Description Values Default Value
Environment mp_auto_update_precreo_mo

dels
no - Creo does not recalculate the mass properties 
of legacy parts upon retrieval of a model.  yes - Creo 
recalculates mass properties of legacy parts upon 
retrieval of a model except for legacy parts with no 
assigned density.

yes, no no

Environment part_mp_calc_ignore_alt_mp Yes (default) - Creo uses the calculated mass 
(mass=volume*density) to calculate part mass 
properties. No - Creo uses the user-defined value of 
PRO_MP_ALT_MASS if the value of 
PRO_MP_SOURCE is Geometry and Parameters 
or Fully Assigned.

yes, no yes

Environment prehighlight Yes - Selectable items beneath the pointer are 
highlighted prior to being selected. No - Selectable 
items beneath the pointer are not highlighted prior to 
being selected.

yes, no

Environment prehighlight_tree Default value for "Preselection Highlighting" option 
in the model tree, layer tree, detail tree and layout 
tree. When enabled, selectable items are 
highlighted prior to being selected in the tree.

yes, no no

Environment pro_unit_length Sets the default units for new objects. unit_inch, unit_foot, unit_mm, unit_cm, 
unit_m

unit_inch

Environment pro_unit_mass Sets the default units for mass for new objects. unit_ounce, unit_pound, unit_ton, 
unit_gram, unit_kilogram, unit_tonne

unit_pound

Environment pro_unit_sys Specifies the default system of units for new 
models.

mks, cgs, mmns, fps, ips, proe_def, mmks

Environment proe_memory_buffer_size Specify the size in megabytes of the memory buffer 
to be reserved by Creo for system out of memory 
condition. You must restart Creo for the change to 
take effect.

50

Environment regen_backup_directory Specifies the directory in which the system stores 
regen_backup models. (See 
regen_backup_using_disk.) The primary default is 
the current directory, but if that directory is read-
only, the secondary default is the /tmp directory.
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Category Name Description Values Default Value
Environment regen_backup_using_disk Specifies whether or not the system backs up the 

current model to disk before each regeneration.
yes, no no

Environment save_section_surfaces Yes - Save section surfaces with models. No - Do 
not save section surfaces with models.

yes, no yes

Environment select_on_dtm_edges All_modes - Select a datum plane by clicking on its 
visual boundary. Sketcher_only - Select a datum 
plane by clicking on its tag in modes other than 
Sketcher. If you use Query frequently, set this option 
to Sketcher_only.

all_modes, sketcher_only all_modes

Environment show_dim_sign No - Dimension values always appear positive. 
Negative value creates geometry to opposite side. 
Yes - Entering negative value for dim displayed as 
negative creates geometry to same side. Dims for 
csys and datum point offsets always show neg/pos 
value.

yes, no no

Environment show_selected_item_id Show id of Creo and Sketcher geometry in query 
selection bin, collector and tool tip.

yes, no no

Environment spin_center_display Determines whether or not the spin center symbol 
displays.

yes, no yes

Environment start_appmgr Determines whether or not the application manager 
starts when Creo is started.

yes, no yes

Environment startup_check_for_visualization Determines whether or not the visualization 
components are checked for installation upon 
startup.

yes, no yes

Features allow_anatomic_features Allow the creation of pre-Pro/ENGINEER 2000i 
geometry features including ear, neck, lip, slot, 
flange, shaft, local push, radius dome and section 
dome.

yes, no no

Features allow_fully_dependent_copy Enables the usage of advanced copy/paste 
functionality to  control degree of dependency on the 
pasted object.

yes, no yes

Features allow_udf_style_cosm_threads Defines the Cosmetic Thread user interface. Yes - 
Creates a Cosmetic Thread as a UDF. No - Creates 
a Cosmetic Thread as a Cosmetic Thread feature.

yes, no no

Features angle_grid_interval Modify grid space in angular units for handle 
movement.

1
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Category Name Description Values Default Value
Features auto_add_remove Allows Creo to automatically switch from add to 

remove of material for solid extrude and revolve 
during feature creation.

yes, no yes

Features autohide_copied_group_af If set to yes, copying a feature group containing an 
Annotation feature will automatically hide the 
Annotation Features in the new group.

yes, no no

Features autohide_external_sketch If set to yes, a Sketch feature is automatically 
hidden after being used as external sketch for a 
sketch based feature.

yes, no yes

Features autoround_max_n_chains_per
_feat

Determines the maximum number of edge chains 
that the Auto-Round algorithm will attempt to round 
in each Auto-Round member

20

Features centimeter_grid_interval Modify grid space in centimeter units for handle 
movement.

0.1

Features copy_set_datum_attr If set to yes, allow to copy set datum associated with 
datum features..

yes, no yes

Features default_dep_copy_option Sets Full Dependent Copy as a default copy option. full_dep, dep_dim dep_dim

Features display_draggers Display Dragger for Edit mode. yes, no yes
Features dynamic_preview Controls the default state of geometry preview within 

a feature tool. Attached/Unattached - Dynamic 
attached/unattached geometry preview will be 
enabled. No - Geometry preview will not be enabled.

no, attached, unattached attached

Features enable_auto_regen Enable Auto Regeneration for Unified Edit Mode. yes, no yes

Features enable_remove_notifications Presents a notification dialog when the result of a 
Remove feature creates  a surface with a flipped 
normal, an intersection with non-adjacent geometry  
or geom check errors.  Setting this option to no will 
not issue the notification.

yes, no yes

Features enable_tapered_extrude Enables you to add a taper to an extrude feature by 
displaying the Add taper check box and the taper 
degree value box on the Extrude tab Options tab. 
yes - The Add taper check box is displayed. no - 
The Add taper check box is not displayed.

yes, no yes
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Category Name Description Values Default Value
Features fail_unattached_feature Handles unattached protrusion and cuts, when 

retrieving pre-Release 15 models. Yes - When a 
part is retrieved, the system fails an unattached 
protrusion or cut. No - When a part is retrieved, the 
system does not fail an unattached protrusion or 
cut.

yes, no no

Features feature_create_auto_begin In feature creation, determines whether or not the 
Define button is automatically activated when you 
open the dialog box. Yes - Button is activated 
automatically. No - You select the button.

yes, no no

Features feature_create_auto_ok In feature creation, determines whether or not the 
system activates the dialog box OK button 
automatically when the last required element is 
defined. Yes - Button is activated automatically. No - 
You select the button.

yes, no no

Features feature_type_default It sets the solid or surface default type for feature 
creation. The Advanced option sets the default type 
for Extrude and Revolve to solid, and all others to 
Surface.

solid, advanced, surface solid

Features flex_maintain_solution_topolog
y

Initial value for the "Maintain solution topology" 
option in created flexible modeling features.

yes, no no

Features foot_grid_interval Modify grid space in foot units for handle movement. 0.083333

Features hole_diameter_override No- Uses hole-table-driven standard hole diameter 
value. Yes - Allows specifying the drilled hole value 
instead of the standard value.

yes, no no

Features hole_file_resolution Specify Hole tool to use external hole parameter 
(.hol) files.

replace_with_external, use_internal replace_with_external

Features hole_parameter_file_path Specifies the directory path for a standard screw-
size parameters (.hol) file to be loaded from disk. 
Use the full path name to avoid problems.

Features inch_grid_interval Modify grid space in inch units for handle 
movement.

0.03125

Features keep_info_datums Sets the initial state of how the system treats 
datums and features created at run time.

yes, no yes
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Category Name Description Values Default Value
Features max_regen_time_attach_previ

ew
Sets the maximum regeneration time for the 
dynamic attached preview.

0.5

Features merge_type Sets the default merge type surface merge 
operations.

join, intersect intersect

Features meter_grid_interval Modify grid space in meter units for handle 
movement.

0.001

Features millimeter_grid_interval Modify grid space in millimeter units for handle 
movement.

0.1

Features pro_group_dir Sets the default directory for the user-defined 
feature (UDF) library. If not specified, your current 
working directory is the default. Use the full 
pathname to avoid problems.

Features ratio_grid_interval Modify grid space in percentage units for handle 
movement.

0.05

Features show_geom_checks_on_creati
on

Yes - The SHOW ERRORS menu appears at the 
end of feature creation when the feature being 
created has Geometry Checks.

yes, no no

Features troubleshooter_show_info_gch
eck

When set to Yes this option will add a "Show info 
items" filter to the View panel in the Troubleshooter.

yes, no no

Features udf_af_name_postfix If set to yes, a sequential number will be appended 
to the name of annotation feature in group from 
Copy and UDF placement.

yes, no yes

Features user_defined_grid_interval Modify grid space in user defined length units for 
handle movement.

0.5

File Storage & Retrieval analysis_crt_tmp_file_on_rege
n

Determines whether regeneration of analysis 
features creates/updates tmp files

yes, no yes

File Storage & Retrieval browser_favorite Specifies the directories visible in the file browser 
for quick navigation.  Use the full path to avoid 
problems.

File Storage & Retrieval compress_output_files Yes - Stores object files in a compressed format.  
Note: Compressed files are usually smaller, buy 
may be larger,  than uncompressed files. 
Compressed files are slower to read and to write to.

yes, no no

File Storage & Retrieval dir_cache_max Specify the maximum number of directories to 
cache.  Larger values can speed up file access, but 
use more memory.

256
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Category Name Description Values Default Value
File Storage & Retrieval disable_search_path_check Controls whether the search path is checked for 

name conflicts when creating, renaming, or copying 
models. Name conflicts should be avoided because 
different models with the same name cannot be 
together in session.

yes, no no

File Storage & Retrieval excel_analysis_directory Sets the default directory for the MS Excel files to 
be used for Excel analysis calculations. Use the full 
pathname to avoid problems.

File Storage & Retrieval excel_family_table_keep_file Yes - in case of editing family table with excel, if 
saved excel file exist , will always update it.

yes, no no

File Storage & Retrieval exec_prog_on_assem_retr Execute pro/program for models during assembly 
retrieval.

yes, no no

File Storage & Retrieval external_analysis_directory Sets the default directory for the files to be used by 
External Analysis calculations.  Use the full 
pathname to avoid problems.

File Storage & Retrieval file_open_default_folder Sets default dir for File>Open. Working_directory - 
Search working directory. In_session - Search 
objects in  session. Pro_library - Use only if 
Pro/LIBRARY is installed. Workspace - Use only 
with Pro/INTRALINK.  Commonspace - Use only 
with Pro/INTRALINK.

default, working_directory, in_session, 
pro_library, my_documents, desktop

File Storage & Retrieval file_open_default_view Specify the initial Views setting as List or Details in 
the File dialog boxes.

list, details list

File Storage & Retrieval file_open_preview_default Controls whether the preview area is expanded by 
default when the file open dialog or local file browser 
is displayed.

expanded, collapsed collapsed

File Storage & Retrieval file_open_preview_delay The delay before a file selection is previewed, in 
tenths of a second.

File Storage & Retrieval force_new_file_options_dialog Force the use of the New File Options dialog. yes, no no

File Storage & Retrieval generate_viewable_on_save Controls whether updated Creo View .edz files are 
automatically exported every time a model is saved.

yes, no no

File Storage & Retrieval geometry_analysis_color_sche
me

Specifies the location of the geometry analysis color 
scheme file.
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Category Name Description Values Default Value
File Storage & Retrieval instance_search_exhaustive Specifies extent of instance search. Yes - Include 

file type when entering instance name in File>Open: 
type in  input panel (e.g. inst_name.prt) or select in 
drop-down list. If no .idx files are found, only working 
dir is  searched; each generic is not.

yes, no no

File Storage & Retrieval lang_propagate Specifies language storage options. The option 
provides flexibility for objects that use a different 
language than the current

yes, no yes

File Storage & Retrieval mathcad_analysis_directory Sets the default directory for the Mathcad files to be 
used for Mathcad analysis calculations. Use the full 
pathname to avoid problems.

File Storage & Retrieval menu_show_instances Determines whether instance names listed in 
instance index files appear in file lists.

yes, no yes

File Storage & Retrieval mfg_start_model_dir Provides the complete path to the directory 
containing mfg start assemblies.

File Storage & Retrieval model_rename_template Sets the default renaming convention for copied 
assemblies. The default new name is the old name 
appended with an underscore (_). Adding a 
template such as &#91;*a1*=*b1*] changes every 
occurrence of a1 to b1 (e.g. TOP_A1_BRACKET 
copies to TOP_B1_BRACKET).

File Storage & Retrieval modified_objs_in_new_dir Yes- During Save a Copy operations, any modified 
object that is not renamed will be saved in the new 
directory.  No- Any modified object that is not 
renamed will be saved to the retrieval directory.

yes, no no

File Storage & Retrieval open_draw_simp_rep_by_defa
ult

Set to "Yes" to always invoke the open rep dialog 
when opening a drawing.

yes, no no

File Storage & Retrieval open_simplified_rep_by_defaul
t

Retrieves a model in a specified representation. Yes 
- uses Open Rep dialog. No - retrieves the Master 
representation. Specified Name - retrieves the 
model in the specified representation name if it 
exists or the Default representation.

no
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Category Name Description Values Default Value
File Storage & Retrieval override_store_back Forces the storage of objects retrieved from other 

directories to the current working directory.
yes, no no

File Storage & Retrieval placement_rep_by_default Retrieves the assembled component in a specified 
representation. None - retrieves the representation 
specified in configuration option 
open_simplified_rep_by_default.

none

File Storage & Retrieval preferred_save_as_type Allows customizing the order of the Type selections 
found under File ->Save A Copy.

File Storage & Retrieval pro_crosshatch_dir Specifies a default directory for your cross-hatch 
library in which you can save cross-hatching 
patterns for later retrieval. Its value is the full path 
name of the default directory.

File Storage & Retrieval pro_datum_target_dir Sets the default directory for your user-defined 
datum target symbols. Use the full pathname to 
avoid problems.

<creo_loadpoint>\symbols\targ
ets\

File Storage & Retrieval pro_font_dir Sets the default font directory (Creo will load all 
fonts in this directory into the drawing regardless of 
the contents of the system and working directories).

<creo_loadpoint>\text\fonts\

File Storage & Retrieval pro_library_dir Sets the default directory for the Creo libraries (or 
any libraries you have built containing the proper 
index menu files). Use the full pathname to avoid 
problems.

File Storage & Retrieval pro_material_dir Sets the default directory for the part material 
library. Use the full pathname to avoid problems.

File Storage & Retrieval pro_surface_finish_dir Sets the default directory for your user-defined 
surface finish symbols. Use the full pathname to 
avoid problems.

<creo_loadpoint>\symbols\surf
fins\

File Storage & Retrieval prompt_on_erase_not_disp Specifies whether or not to display a prompt 
allowing you to save your undisplayed objects. This 
option is used in conjunction with the Erase > Not 
Displayed command on the File menu.

yes, no no
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Category Name Description Values Default Value
File Storage & Retrieval propagate_change_to_parents When saving objects with option save_objects set to 

Changed or Changed_and_specified, Creo verifies 
which models are. Yes - Any model that is a parent 
of a changed model is considered to be a changed 
model when determining what to save.

yes, no no

File Storage & Retrieval read_famtab_file_on_retrieve No - Ignores filename.ptd. Yes - Creates and saves 
filename.ptd and uses that file when retrieving the 
generic.

yes, no no

File Storage & Retrieval regen_simp_retrieve Regenerate the assembly when retrieving an 
assembly simplified representation. Yes - 
Regenerates the assembly on retreival.  No - The 
assembly is not regenerated on retrieval.

yes, no no

File Storage & Retrieval rename_drawings_with_object Controls whether the system copies associated 
drawings automatically with parts and assemblies.

none, both, part, assem none

File Storage & Retrieval retain_display_memory Determines if the display of an object currently on 
the screen is kept in memory when you quit the 
window. Doing so (yes) makes the retrieval of 
objects in memory faster.

yes, no yes

File Storage & Retrieval save_clipped_view Yes - clipping status is saved with model. No - 
clipping status is not saved.

yes, no no

File Storage & Retrieval save_dialog_for_existing_mod
els

Controls whether the Save dialog is shown for 
models whose storage location is already known.

yes, no no

File Storage & Retrieval save_file_iterations Yes - Iterations of a file will be saved. No - Iterations 
of a file will not be saved.

yes, no yes

File Storage & Retrieval save_instance_accelerator With family tables of solid parts, determines saving 
instance accelerators. None - Accelerator files not 
used. Explicit - Save when instance is explicitly 
saved. Saved objects - Save when objects were 
modified. Always - Always save.

none, explicit, always, saved_objects saved_objects

File Storage & Retrieval save_model_display Sets amount of graphical data stored. Wireframe - 
Wireframe data. Shading_high - Most detail 
(shaded). Shading_low - Least detail (shaded). 
Shading_lod - Detail determined by View  
Performance dialog (shaded).

wireframe, shading_low, shading_high, 
shading_lod

shading_lod
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Category Name Description Values Default Value
File Storage & Retrieval save_object_in_current Use with the override_store_back option. Yes - 

Objects retrieved from a directory where you do not 
have write permission will be stored in the current 
directory. No - These objects are not saved at all.

yes, no no

File Storage & Retrieval save_objects Determines when an object and its dependent 
objects (such as a part used in an assembly) are 
stored.

all, changed, changed_and_specified, 
changed_and_updated

changed_and_specified

File Storage & Retrieval saving_model_thumbnails Enables saving of model thumbnails. yes, no yes

File Storage & Retrieval search_path Specifies list of directories to search (in order) for 
object/file retrieval. These directories, the working 
directory, and directories in search.pro file (refer to 
search_path_file) are Creo's search path. Use full 
path name to avoid problems.

File Storage & Retrieval search_path_file Specifies path to text file search.pro (a list of 
directory path names). The directories listed in 
search.pro, the working directory, and directories 
specified by search_path are Creo's search path. 
Use full path name to avoid problems.

File Storage & Retrieval set_model_types_to_save Determines which model types are used in the Save 
Changed command. The format is a list of 
extensions separated by spaces.

asm prt drw sec mfg gph ipf 
cem

File Storage & Retrieval start_model_dir Provides the complete path to the directory 
containing start parts and assemblies.

File Storage & Retrieval template_boardpart Specify the model to use as the default new ECAD 
board template.

File Storage & Retrieval template_designasm Specifies the designated template assembly. Use 
full path to avoid problems.

inlbs_asm_design.asm

File Storage & Retrieval template_drawing Specify the drawing used as the default drawing 
template.

c_drawing.drw

File Storage & Retrieval template_ecadasm Specify the model used as the default ECAD 
assembly template.

File Storage & Retrieval template_ecadpart Specify the model used as the default ECAD part 
template.

File Storage & Retrieval template_mfgcast Specify the model used as the default 
manufacturing cast template.

inlbs_mfg_cast.asm
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Category Name Description Values Default Value
File Storage & Retrieval template_mfgcmm Specify the model used as the default 

manufacturing cmm template.
inlbs_mfg_cmm.asm

File Storage & Retrieval template_mfgemo Specify the model used as the default 
manufacturing expert machinist template.

inlbs_mfg_emo.asm

File Storage & Retrieval template_mfgmold Specify the model used as the default 
manufacturing mold template.

inlbs_mfg_mold.asm

File Storage & Retrieval template_mfgnc Specify the model used as the default 
manufacturing assembly template.

inlbs_mfg_nc.asm

File Storage & Retrieval template_module Specifies the default module template file.  Use full 
pathname to avoid problems.

inlbs_asm_module.asm

File Storage & Retrieval template_mold_layout Specify the mold layout assembly used as a default 
template.

inlbs_mold_lay.asm

File Storage & Retrieval template_new_ecadasm Specify the model to use as the default new ECAD 
assembly template.

File Storage & Retrieval template_sheetmetalpart Specify the model used as the default sheetmetal 
part template.

inlbs_part_sheetmetal.prt

File Storage & Retrieval template_solidpart Specify the model used as the default part template. inlbs_part_solid.prt

File Storage & Retrieval update_accelerator_in_verify No* - Does not update existing accelerators upon 
family table verification for changes. Yes - Update 
existingaccelerators upon family table verification for 
changes

yes, no no

File Storage & Retrieval use_outdated_accel_in_geom_
rep

This option controls the usage of outdated 
accelerator files during retrieval of instances in 
geometry representation. Yes - Provides the fastest 
retrieval. No - Ensures accurate Retrieval.

yes, no no

File Storage & Retrieval use_temp_dir_for_inst Explicitly makes Creo use the Temp directory for 
regenerating instances of models.

yes, no no

File Storage & Retrieval verify_on_save_by_default Yes - "Verify Now" action will be selected in the 
conflict dialog by default when an unverified family 
table instance is to be saved in PDM workspace.  
No - "Verify Now" action will not be selected by 
default. The user may explicitly specify the "Verify 
Now" action in the conflict dialog.

yes, no no
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Category Name Description Values Default Value
Freestyle Feature freestyle_drag_performance Yes - Improve performance during drag by 

temporarily reducing graphics quality. No - No 
reduction in graphics quality during drag.

yes, no yes

Layers add_lower_level_comps_to_lay
er

Setting this option to yes will check off the Favor 
Current Layer option, which allows lower level 
components to be added to top level layers.

yes, no no

Layers blank_layer Blanks specified layers when you begin a Creo 
session. The value is the layer ID.

Layers create_numbered_layers Yes - Creates default layers named 1 through 32. yes, no no

Layers def_layer Specifies default layer names for different types of 
items. The first value string is the layer type. The 
second value string is the layer name.

layer_assem_member, 
layer_assy_cut_feat, layer_axis, 
layer_chamfer_feat, 
layer_comp_design_model, 
layer_comp_fixture, 
layer_comp_workpiece, 
layer_copy_geom_feat, 
layer_corn_chamf_feat, 
layer_cosm_round_feat, 
layer_cosm_sketch, layer_csys, 
layer_curve, layer_curve_ent, 
layer_cut_feat, layer_datum, 
layer_datum_plane, layer_datum_point, 
layer_detail_item, layer_dgm_conn_comp, 
layer_dgm_highway, layer_dgm_rail, 
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Category Name Description Values Default Value
layer_dgm_wire, layer_dim, 
layer_draft_constr, layer_draft_dim, 
layer_draft_dtm, layer_draft_entity, 
layer_draft_feat, layer_draft_geom, 
layer_draft_grp, layer_draft_hidden, 
layer_draft_others, layer_draft_refdim, 
layer_driven_dim, layer_dwg_table, 
layer_ext_copy_geom_feat, layer_feature, 
layer_geom_feat, layer_gtol, 
layer_hole_feat, layer_intchg_funct, 
layer_intchg_simp, layer_nogeom_feat, 
layer_note, layer_parameter_dim, 

layer_part_refdim, layer_point, 
layer_protrusion_feat, layer_quilt, 
layer_refdim, layer_ribbon_feat, 
layer_rib_feat, layer_round_feat, 
layer_sfin, layer_shell_feat, 
layer_skeleton_model, layer_slot_feat, 
layer_snap_line, layer_solid_geom, 
layer_surface, layer_symbol, 
layer_thread_feat, layer_trim_line_feat, 
layer_weld_feat, layer_all_detail_items, 
layer_annotation_element, layer_axis_ent, 
layer_csys_ent, layer_set_datum_tag, 
layer_3d_items, layer_ae_driving_dim, 
layer_draft_xsec, layer_hole_thread

Layers default_layer_model Name of the model which is used to drive rule-
based layer placement of new items in all models of 
the same type in session.

Layers display_layer This causes the specified layers to display when you 
begin a Creo session. The variable "value" is the 
layer Id.

Layers floating_layer_tree Set to yes if user wants to see a layer tree dialog 
separated from navigator.

yes, no no

Layers highlight_layer_items Yes - Items selected in the layer tree are highlighted 
in the geometry area.

yes, no yes
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Category Name Description Values Default Value
Layers layer_item_highlight_limit Set the upper limit of items in a layer for highlighting.  

If items in a layer exceeds this number, highlighting 
will not occur.

500

Layers save_display_status_in_submo
del

If set to no, the top level assembly will store sub 
model layer display status, allowing lower level 
display status to be stored without having to save 
the sub models.

yes, no yes

Layers save_hidden_items_w_status The items on the "Hidden Items" temporary layer 
are stored permanently when layer display status is 
saved with Save Status command.

yes, no yes

Layout layout_feat_copied_geom_thic
k

Layout feature - Copied geometry thickness. 1, 3, 2, 4, 5, 1.5, 2.5, 3.5, 4.5 1.5

Layout layout_scroll_bars Show/Hides scroll bars. yes, no yes
Layout layout_snap Enable/Disable snapping to geometry and guides. yes, no yes

Layout layout_symbol_dir Set and automatically create the default directory for 
saving and retrieving user-defined symbols. If you 
do not specify a directory, Layout will use the same 
directory as Creo drawings. Use full path name to 
avoid problems.

<dir_name>\dump_x86e_win6
4\

Manufacturing allow_mfg_in_assem_mode Allows a manufacturing model to be opened in 
assembly mode from the file open dialog.  Use 
"Open In Assembly Mode" option in "File Open" 
dialog.

yes, no no

Manufacturing assy_mfg_open_mode No Default Application set for opening Assembly NC 
Models.

mfg, process, feature, any_mode any_mode

Manufacturing autodrill_udf_dir Storage directory for holemaking MUDF's that are 
used by Pro/NC Auto-drilling functionality

Manufacturing autodrilling_config_filename Retrieve automatically and load the configuration file 
for the auto-drilling table.

autodrilling

Manufacturing autodrilling_holestyle_param Parameter name included in hole features of a 
manufacturing reference model.  The parameter 
value identifies the MUDF for holemaking that is 
automatically applied in Pro/NC to drill these holes.

Manufacturing campost_dir Specifies the CAM-Post load point directory to 
enable you to directly set-up the post-processors 
and generate MCD files.
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Category Name Description Values Default Value
Manufacturing chk_part_surfs_profpock Yes - Includes all reference part surfaces as check 

surfaces for profiling and pocketing NC sequences.
yes, no no

Manufacturing cl_arrow_scale Enables you to control the size of the tool path 
arrow for contouring NC sequences. 0 - The arrow 
does not display. Any other value - The arrow scales 
accordingly.

1

Manufacturing cl_rotate_sign_convention TOOL or TABLE - defines ROTATE sign direction 
convention based with respect to either rotation 
table or cutting tool.

table, tool table

Manufacturing cmm_custom_tool_param_file Defines the file that contains the user-defined tool 
parameters' list.

Manufacturing curve_traj_offset_opt_default Enables default state of "Offset Cut" option for the 
trajectory sequence. "ON" - "Offset Cut" option is 
selected. "OFF" - the option is not selected. "AUTO" 
- the option state depends on the selected chain 
reference.

off, on, auto auto

Manufacturing display_mfg_icon_for_mfg_ass
y

Yes- Display manufacturing icon for manufacturing 
assembly files in Open/Save dialogs.  No- the 
manufacturing assembly files have assembly icons.

yes, no no

Manufacturing dm_nc_references Sets whether reference relationships will be created 
in Windchill between the manufacturing model and 
its deliverables(CL file, tape file and DMIS file).

yes, no yes

Manufacturing enable_2x_traj_multi_loops Enables selection of loops on surfaces for curve 
trajectory sequence.

yes, no no

Manufacturing enable_face_thread_turning Allows/disallows face option for thread turning 
sequence.

yes, no no

Manufacturing enable_param_n_tool_upd_dia
log

Enable parameters and tool updation dialog. yes, no yes

Manufacturing gpostpp_dir Specifies the directory containing the post processor 
files to be used by Pro/NCPOST (GPOST).

Manufacturing ignore_templ_pos_for_new_to
ol

Ignore pocket number from template for tools added 
to a workcell. Use first available pocket.

yes, no no

Manufacturing mfg_auto_ref_mfg_template Enable/Disable auto referencing for Manufacturing 
template

yes, no no
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Category Name Description Values Default Value
Manufacturing mfg_auto_ref_prt_as_chk_srf Yes - In 3, 4, and 5 axis contour and conventional 

mill sequences, the entire reference part is selected 
as check surfaces by default when computing the 
NC sequence toolpath for those sequences. No - 
You select the check surfaces.

yes, no yes

Manufacturing mfg_auto_retract_clear_dist Specifies distance between automatically created 
retract plane and step coordinate system. Will be 
applied to the new steps created in process 
manager if operation retract cannot be used.

0

Manufacturing mfg_cl_euc_japanese_encode Yes - Output cl-file Japanese characters in EUC 
encoding.

yes, no no

Manufacturing mfg_comments_text_area_size Controls the number of lines available for comments 
without scrolling in NC steps dashboard UI.

8

Manufacturing mfg_custom_tool_param_file Defines the file that contains the user-defined tool 
parameters' list.

Manufacturing mfg_customize_dialog Yes - Uses the new customize dialog box for 
customizing NC sequences. No - Uses the Release 
19.0 menus.

yes, no yes

Manufacturing mfg_cutline_save_mesh Yes - Save / Retrieve Mesh for subsequent cutline 
recalculations, No - New Mesh will be computed for 
each cutline recalculations.

yes, no yes

Manufacturing mfg_ijk_num_digits Sets the number of digits for i, j, k data points in a 
CL data file.

10

Manufacturing mfg_info_location top left /bottom right -Position of the mfg. Info dialog 
box.

top_left, bottom_right top_left

Manufacturing mfg_modal_command_file Enables you to make some of the APTn index 
topics modal, which means that you repeatedly get 
a list of major keywords corresponding to this topic 
upon completing a command line.

Manufacturing mfg_param_auto_copy_from_t
ool

Do not copy any parameter of the tool to the 
sequence parameter tree.

all, none, misc, cutting none

Manufacturing mfg_process_print_dir Specifies the directory where Mfg Process html 
page get stored. Use the full pathname to avoid 
problems.
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Category Name Description Values Default Value
Manufacturing mfg_process_sync_by_default Specifies whether all steps created in the Process 

Manager get automatically synchronized with 
features in the Pro/NC assembly. You can change 
steps later in the dialog box open during the 
session.

yes, no yes

Manufacturing mfg_process_table_setup_dir Specifies the directory where Mfg Process Table 
settings get stored. Use the full pathname to avoid 
problems.

Manufacturing mfg_process_template_dir Specifies the directory where Mfg Process 
Templates get stored. Use the full pathname to 
avoid problems.

Manufacturing mfg_setup_dir Specifies the directory which contains all 
manufacturing related setup files for the current 
session.

Manufacturing mfg_stock_display_show_defa
ult

Sets the default visibility status of the Stock Model 
after creation.

yes, no no

Manufacturing mfg_tap_mat_rem_coef The factor is used to consider the threading of 
tapping tool. The estimate removed material value 
of tapping sequence is presented as estimate 
removed material value multiplied by this factor. The 
factor should be greater than 0 and upto 1.0.

1

Manufacturing mfg_tbl_comment_from_retr_t
ool

Controls whether the mfg tool comment is getting 
copied from TOOL_COMMENT parameter of the 
retrieved tool to the tool manager table comment.

yes, no no

Manufacturing mfg_template_dir Specifies the storage directory for NC templates. 
Specify full path to avoid problems. NC templates 
are used in Expert Machinist. Templates store the 
recipe for a toolpath as the method of tool retrieval.

Manufacturing mfg_tool_dialog_setup_file Specifies the XML based file to setup Tool Dialog.

Manufacturing mfg_tool_preview_by_pick Enables preview of a milling tool at a specified 
location on the tool path or geometry of the part.

yes, no yes

Manufacturing mfg_udf_info_setup_file Specify name and path of the file containing udf and 
mfg criteria values .
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Category Name Description Values Default Value
Manufacturing mfg_workpiece_transparency Controls the workpiece transparency in shaded 

model display. You can change the value in the 
range between 0.1 and 1. The bigger the value, the 
more transparent the workpiece. The default value 
is 0.5.

0.67

Manufacturing mfg_xyz_num_digits Sets the number of digits for x, y, z data points in a 
CL data file.

10

Manufacturing nc_autodoc_param_dir Location of the setup file that describes which 
process parameters are included in the parameter 
table.

Manufacturing nc_autodoc_report_dir Location for storing the report and images 
generated by the shop floor documentation tool.

Manufacturing nc_autodoc_setup_dir Location for documentation setup files that describe 
which process parameters are included in the 
parameter table.

Manufacturing nc_autodoc_template_dir Location of the style sheet and default images used 
for shop floor documentation.

Manufacturing nc_jobman_visible Yes - make "Submit Path" and "Abort Path" visible. 
No - make "Submit Path" and "Abort Path"  invisible.

yes, no no

Manufacturing nccheck_type Vericut will be used for NC material removal 
simulation.

vericut, nccheck vericut

Manufacturing ncl_file_extension Sets the default file extension for Pro/MFG CL data 
files. Enter the file extension only (without the 
preceding "."). For example, apt produces 
filename.apt.

ncl

Manufacturing ncmdl_bar_stock_part_path Sets path for storage and retrieval of stock 
instances for creating workpiece in NC Model. 
Specify full path, including part name, to avoid 
problems.

<creo_loadpoint>\text\ncmdl_d
ata\ncmdl_bar.prt

Manufacturing ncmdl_billet_stock_part_path Sets path for storage and retrieval of stock 
instances for creating workpiece in NC Model. 
Specify full path, including part name, to avoid 
problems.

<creo_loadpoint>\text\ncmdl_d
ata\ncmdl_billet.prt

Manufacturing ncpost_type Set to GPOST to access the default post processor 
supplied with Pro/NCPOST.

gpost, ncpost

Manufacturing ncseq_outbound_curve Yes - Create out bound curve. yes, no no
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Category Name Description Values Default Value
Manufacturing new_turn_scan_type Allows to use New turn scan types for Turning NC 

sequences.
yes, no yes

Manufacturing output_mfg_xml Allows export/import mfg model to/from xml file. Yes  
- make Export/Import options visible. No - make 
them invisible.

yes, no no

Manufacturing pro_mdb_dir Sets the default directory for the Machinability 
Database (MDB) files. Use the full pathname to 
avoid problems.

Manufacturing pro_mf_cl_dir Sets the default directory for the manufacturing CL 
data files.Use the full pathname to avoid problems.

Manufacturing pro_mf_clamp_dir Specifies the directory where the manufacturing 
clamps can be found.

Manufacturing pro_mf_param_dir Sets the default directory for the manufacturing 
parameter files. Use the full pathname to avoid 
problems.

Manufacturing pro_mf_tape_dir Sets the default directory for the manufacturing 
TAPE data files.Use the full pathname to avoid 
problems.

Manufacturing pro_mf_tprm_dir Sets the default directory for the manufacturing tool 
files. Use the full pathname to avoid problems.

Manufacturing pro_mf_workcell_dir Sets the default directory for the manufacturing 
workcell files. Use the full pathname to avoid 
problems.

Manufacturing pro_mfg_cmdsyn_dir Sets the default directory for the syntax menu files 
in Pro/MFG. Use the full pathname to avoid 
problems.

Manufacturing profile_output_utils Affects CL-Data output for profile milling sequences. 
Yes - Sequence parameter output_point is available 
with options: tip - Toolpath is output with respect to 
the tool center; on_profile - Toolpath is output with 
respect to the profile of the tool.

yes, no no

Manufacturing proncpost_dbf Enter directory path to NCPost database file.
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Category Name Description Values Default Value
Manufacturing prorembatch_queue_manager Enables toolpath computation on a separate host 

machine. Required values are Processor name, 
Remote machine's hostname, Type of transport 
(always 0), RPC processor number (same as that of 
remote processor), Version of queue manager.

Manufacturing reverse_spiral_finish_type If the option value is 1, the tool path is obtained from 
standard one by reversing it; if the option value is 2, 
the tool path starts from an inner circle.

Manufacturing shade_mfg_ref_models No - Does not process reference parts when 
generating the shaded image (to save time). Yes - 
Shades reference parts when generating shaded 
images.

yes, no yes

Manufacturing store_tool_path_file Specifies how tool path information is computed. 
Yes - Tool path information stored in file 
filename.tph (filename is manufacturing model 
name). No - Tool path is computed each time 
manufacturing model is retrieved or parameters are 
changed.

yes, no yes

Manufacturing tool_motion_list_length Controls the number of rows visible in the tool 
motion list without scrolling.   This value is applied to 
dashboard based NC Steps.

7

Manufacturing tool_path_preview_default Sets tool path preview default mode to OFF. off, on, auto auto
Manufacturing turn_avoid_holder_interference Yes - Tool holder interference will be ignored during 

Turning toolpath calculation.
yes, no no

Manufacturing wcell_fixt_info_setup_file Specify name and path of the file containing 
workcell and fixture name info.

Manufacturing workpiece_instances Cut out are created in Workpiece but not the family 
table instances.

none, operations, steps, 
operations_and_steps

none

Mechanism mdo_cl_executable Path for Custom Load executable.
Mechanism mdo_integration_method Select integration method for dynamic analyses. explicit, implicit, auto auto

Mechanism mdo_spring_wire_radius Spring wire radius for dynamics spring icons. 0.15
Mechanism mdx_belt_icon_width Width of belt transmission icons. 5
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Category Name Description Values Default Value
Mechanism mechanism_significant_digits The number of significant digits of mantissa for real 

double values  in mechanism mode.  Can be set in 
interval from 6 to 16. Default value is 12.

12

Mechanism motion_envlp_alert Displays the Motion Envelope alert the first time the 
quality level is increased.

yes, no yes

Mechanism move_mechanism_in_nongeo
m_reps

Allow mechanism operations in non geometrical 
representations.

yes, no, exclude_to_move yes

Miscellaneous allow_ply_cross_section Yes - Enables Pro/COMPOSITE to create a cross-
section of composite plys.

yes, no yes

Miscellaneous mapkey Stores a keyboard macro. Use File > Options > 
Environment > Mapkey Settings to create, edit and 
delete mapkeys.

Miscellaneous mapkeys_execution Mapkeys execution behavior. No Feedback - The 
mapkey is executed with no feedback, Execute with 
Feedback - A warning message is given upon 
failure during execution, Stop at failure - The 
execution stops at failure and a feedback message 
is provided.

no_feedback, execute_with_feedback, 
stop_at_failure

no_feedback

Miscellaneous relation_text_trail_output No - Disable trail output from Text layout in Relation 
Parameter UI if it hasn't been changed.

yes, no yes

Miscellaneous relation_tool_mapkey_behavior Will control how mapkeys will be executed in 
relation tool / dialog.  Incremental will add/remove 
text incrementally to the current set.  Full_output will 
record the original set state and replace the current 
one with it. Note: this config is dependent on 
relation_text_trail_output.

increment, full_output increment

Miscellaneous show_cav_fit_loc_sys Allows the printing of the transformation matrix of a 
Pro/Verify Fit into a file.

yes, no no

Model Display allow_solid_perspective_hlr Yes - Allows a solid to be displayed with hidden 
lines while in perspective.

yes, no yes

Model Display animate_component_placeme
nt

Animate the transition between component states in 
placement.

yes, no yes

Model Display animate_explode_states Animate the transition between explode states and 
mold opening steps.

yes, no yes
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Category Name Description Values Default Value
Model Display blended_transparency Yes - Transparent colors will appear using alpha 

blending (if supported) when the model is shaded.
yes, no, independent independent

Model Display capped_clip Yes - Displays the model as a solid when shaded 
and clipped. No - Displays the model as surfaces 
when shaded and clipped.

yes, no yes

Model Display clip_always Yes - Display clipping after Visibilities dialog box is 
closed.

yes, no yes

Model Display datum_point_symbol Specifies the shape of datum point symbols 
displayed in Part or Assembly mode.

dot, cross, circle, triangle, square cross

Model Display default_ramp_size Specifies a number of shades of gray to show 
shading of non-colored objects.

Model Display disp_comp_name_in_symb_re
p

Displays the names of components in symbolic 
representations.

yes, no yes

Model Display display Wireframe - All solid edges in white. Hiddenvis - 
Hidden lines in grey. Hiddeninvis - Hidden lines 
removed. Shade - Display shaded surfaces. 
Settings are reflected in printing and some export 
modes.

wireframe, hiddenvis, hiddeninvis, shade, 
shadewithreflect, shadewithedges

shade

Model Display display_axes Displays or hides datum axes. yes, no yes
Model Display display_axis_tags Displays or hides datum axis name tags. yes, no no
Model Display display_coord_sys Yes - Coordinate systems will be displayed. No - 

Coordinate systems will not be displayed.
yes, no yes

Model Display display_coord_sys_tags Yes - Coordinate system name tags will be 
displayed. No - Coordinate system name tags will 
not be displayed.

yes, no yes

Model Display display_florin Yes: display of the florin (international currency 
symbol) where possible. No: use the euro symbol 
exclusively.

yes, no no

Model Display display_plane_tags Yes - Datum plane name tags will be displayed. No - 
Datum plane name tags will not be displayed.

yes, no no

Model Display display_planes Yes - Datum planes will be displayed. No - Datum 
planes will not be displayed.

yes, no yes

Model Display display_point_tags Yes - Datum point tags will be displayed. No - 
Datum point tags will not be displayed.

yes, no no
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Category Name Description Values Default Value
Model Display display_points Yes - Datum points and their names will be 

displayed. No - Datum points and their names will 
not be displayed.

yes, no yes

Model Display display_silhouette_edges Sets the display of silhouette edges for wireframe 
display only.

yes, no yes

Model Display display_z_extension_lines Controls the display of dimension z-extension lines. 
Yes - z-extension lines will be displayed; No - z-
extension lines will not be displayed.

yes, no yes

Model Display edge_display_quality Controls display quality of an edge for wireframe 
and hidden-line removal. Normal - Normal quality of 
edge display. High - Increases tessellation by 2. 
Very_high - Increases tessellation by 3. Low - 
Decreases tessellation from normal, speeds up 
display.

high, low, normal, very_high normal

Model Display enable_ambient_occlusion Enable ambient occlusion. This simulates the effect 
of light radiating from a real model by darkening the 
occluded areas.

yes, no no

Model Display enable_hlr_hashing Enables hlr hashing yes, no no
Model Display enable_transparent_text_bg Yes - Clear background before displaying text. No - 

Do not clear text background.
yes, no yes

Model Display explode_animation_max_time Sets the maximum amount of time for an animation 
between explode states.

1

Model Display fast_highlight Yes - Use simplified highlighting which redisplays 
more quickly at the expense of certain details.  This 
option may increase memory usage slightly.

yes, no yes

Model Display fasthlr Specifies whether fast hidden line removal is on/off 
by default.

yes, no no

Model Display frames_per_sec Determines whether view is animated. yes, no no
Model Display frames_per_sec_value Used to set the smoothness of view animation 

changes. Higher numbers provide more frames/sec, 
and giving you a smoother animation. Lower 
numbers cause the view to change more quickly.

3
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Category Name Description Values Default Value
Model Display lods_enabled Determines whether or not the system uses Level of 

Detail in shaded models during dynamic orientation 
(panning, zooming and spinning).

yes, no no

Model Display lods_value When lods_enabled is Yes, this value specifies the 
default value used to display LODs. The value is a 
percentage of the edge size vs the total size of the 
model.

50

Model Display max_animation_time When the orientation, or zoom state, of the Creo 
window changes, an animation sequence of a 
predefined duration takes place. This option controls 
the maximum time the system spends animating.

1

Model Display max_image_dimension Set the upper bound dimension on images loaded 
into Creo. Images larger than this limit will be 
rescaled to this upper bound during loading.

4096, 1024, 2048, 8192, 16384 16384

Model Display mesh_spline_surf Turns the blue mesh surface lines on or off. yes, no no
Model Display min_animation_steps When the orientation, or zoom state, of the Creo 

window changes, an animation sequence of 
predefined duration takes place. This option controls 
the minimum number of frames used in the 
animation sequence.

6

Model Display model_detail_options_file Sets the path to the file which contains the default 
model detail option values for new models.

<creo_loadpoint>\text\3d_inch.
dtl

Model Display orientation Establishes the initial standard view orientation. 
User_default - System uses X-axis and Y-axis 
values defined by options x_axis and y_axis.

isometric, trimetric, user_default trimetric

Model Display real_time_rendering_display Set the realtime rendering to project 
shadows/reflections on a transparent floor.

transparent_floor, room_display transparent_floor

Model Display save_triangles_flag Spinning shaded images with software graphics 
only.  Note: This option has no effect if your system 
uses hardware graphics.

yes, no no

Model Display shade_moving_comp Yes - Shades assembly components while they are 
being moved. No - Displays components in 
wireframe while they are being moved.

yes, no yes
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Category Name Description Values Default Value
Model Display shade_quality Model shade quality is used to decide how much to 

subdivide surfaces for  shading purposes. Higher 
shade quality is slower but produces better pictures.

12, 13, 14, 1, 3, 23, 24, 25, 26, 2, 4, 5, 15, 
6, 7, 8, 9, 10, 11, 16, 17, 18, 19, 20, 21, 
22, 27, 28, 29, 30, 31, 32, 33, 34, 35, 36, 
37, 38, 39, 40, 41, 42, 43, 44, 45, 46, 47, 
48, 49, 50

3

Model Display shade_surface_feat Controls the shading of surface features. yes, no yes
Model Display shade_windows Enables shading of objects in all windows. This 

option does not also enable color shading.
all_windows, one_window all_windows

Model Display shade_with Controls the display of datum curves on shaded 
objects.

no, curves curves

Model Display show_axes_for_extr_arcs Determines if axes are created for newly extruded 
arcs.

yes, no no

Model Display skip_small_surfaces Gives the user the option not to display small 
shaded surfaces. Disabling this option will improve 
display quality at the expense of speed.  It is most 
useful for creating screen snap shots.

yes, no yes

Model Display spherical_map_size Size of Spherical map texture image used for 
environment mapping. Bigger size will have better 
image quality but will be slow to regenerate.

256x256, 512x512, 1024x1024 256x256

Model Display spin_rate_zoom_sensitive Allows slower spinning when zoomed in on a model. yes, no no

Model Display spin_with_notes Yes - 3D feature and model notes are displayed 
during dynamic spinning of a model.

yes, no yes

Model Display spin_with_part_entities Yes - Datum features will be displayed during 
dynamic spinning of a model.

yes, no no

Model Display spin_with_silhouettes Yes - Silhouette lines will be displayed during 
dynamic spinning of a model.

yes, no no

Model Display tan_angle_for_disp For display purposes only. Sets the angle between 
two quilt surfaces below which the edge will be 
displayed as tangent. Enter an angle between 1.5 
and 15 degrees.

0.02618

Model Display tangent_edge_display Determines how edges between tangent surfaces 
are displayed.

no, solid, centerline, phantom, dimmed solid

Model Display texture Yes - Applied textures will be displayed when the 
model is shaded.

yes, no yes
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Category Name Description Values Default Value
Model Display texture_search_path Appends a directory to the search path for textures.

Model Display transparency Yes - Transparent colors will appear as such when 
the model is shaded.

yes, no yes

Model Display update_old_appearance Update pre-Creo 3.0 appearances to their latest 
values. Always - update without warning, Never - do 
not update, Prompt - issue a warning dialog allowing 
users to choose to update or not.

never, always, prompt always

Model Display use_pre_wildfire_text_font Yes - Use the old stroke-based PTC font as the 
default font. No - Use a True Type font as the 
default font.

yes, no no

Model Display x_angle Sets the default view orientation for models 
(appears in the Orientation dialog box). The default 
orientation is the last option, x_angle, y_angle, or 
orientation, in the configuration file.

0

Model Display y_angle Sets the default view orientation for models 
(appears in the Orientation dialog box). The default 
orientation is the last option, x_angle, y_angle, or 
orientation, in the configuration file.

0

Notification Manager nmgr_affected_by_dma Show notifications for models/features that are 
affected by Creo direct modifications.

yes, no yes

Notification Manager nmgr_modified_in_dma Components that were repositioned in Creo Direct. 
All models and features affected by this operation 
cannot be updated or modified in Creo Parametric 
until parametric behavior is restored.

yes, no yes

Notification Manager nmgr_outdated_mathcad Show notifications for models that contain MathCad 
Sheet with values different from Creo values.

yes, no yes

Notification Manager nmgr_outdated_non-native Show notifications for non-native models that are 
not up-to-date with respect to source.

yes, no yes

Notification Manager nmgr_outdated_pdm Show notifications for models that are not up-to-date 
with recent PDM model version.

yes, no yes

Notification Manager nmgr_pending_dma Models that were modified in Creo Direct and not 
reviewed. The changes should be accepted or 
rejected in the View Creo Changes dialog

yes, no yes

Notification Manager nmgr_reference_changed Show notifications for models/features whose 
references were changed since last regeneration.

yes, no yes
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Category Name Description Values Default Value
Notification Manager nmgr_reference_out_of_sessio

n
Show notifications for models/features with 
references not in session.

yes, no no

Photorender default_scene_filename Complete path to the scene file to be used as 
default scene file.

<creo_loadpoint>\graphic-
library\scenes\/creo_default_sc
ene.scn

Photorender photorender_capability_warnin
gs

Allows the user to disable warnings about PhotoLux 
only capabilities.

yes, no yes

Photorender photorender_default_height Sets the default height (in pixels) for the custom size 
rendered output

450

Photorender photorender_default_width Sets the default width (in pixels) for the custom size 
rendered output

600

Photorender photorender_memory_usage Sets the memory limit that Pro/PHOTORENDER 
allows for model processing. Do not use commas in 
the memory value, as Creo interprets these as 
decimals. The minimum allowed value is 64 and 
maximum value is 5120.

256

Photorender photorender_preview_scale Allows user defined size ratio at which 
Pro/PHOTORENDER will render, using the default 
Render To: Full Window Preview setting. Increasing 
the value creates higher quality rendering with 
slower performance. Reducing the value produces 
reverse results.

0.5

Photorender pro_texture_library Allows the user to specify a different graphics 
library.

Photorender room_rotation_lock Default room rotation setting at session start.  studio 
- Lock room rotation to studio.  model - Lock room 
rotation to model.

studio, model studio

Photorender save_scene_with_file Yes - Automatically update the model with current 
scene information when saving the model; No - 
Scene information embedded in model must be 
updated manually.

yes, no no

Photorender save_texture_with_model Yes - Embed applied texture and tracesketch 
bitmap files into the model file.

yes, no no

Photorender window_gamma Gamma correction to apply to images created by 
renderer. Default value is 1.0.

1

Piping aec_dwg_anno_attrpar_spec_fi
le

Specifies the aec drawing annotation 
attribute/parameter specification file name.

aec_dwg_anno_attrparam_spe
c.ptd
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Category Name Description Values Default Value
Piping aec_object_type_file Specifies the aec object type file name. aec_object_type.ptd
Piping display_thick_insulation Yes - Display insulation in thick mode. No - Display 

insulation in centerline mode. This option can be 
overridden by the Thick insulation option in the 
Model Display dialog box.

yes, no yes

Piping display_thick_pipes Yes - Display pipes in thick mode. No - Display 
pipes in centerline mode. This option can be 
overridden by the Thick pipes option in the Model 
Display dialog box.

yes, no no

Piping isogen_attribute_map_file Specifies the mapping between isogen parameter 
and attribute name.

<creo_loadpoint>\text\piping_d
ata\isodata\isogen_attribute_m
ap.ptd

Piping isogen_endtype_map_file Specify name of file mapping Pro/Piping endtypes 
with ISOGEN endtypes

<creo_loadpoint>\text\piping_d
ata\isodata\isogen_endtype_m
ap.ptd

Piping isogen_mandatory_attr_file Specify file containing mandatory attribute filenames 
used by ISOGEN.

isogen.fls

Piping isogen_nominal_size_map_file Specify name of file mapping Pro/Piping Size with 
Nominal Sizes in MM and Inches

<creo_loadpoint>\text\piping_d
ata\isodata\isogen_nominal_si
ze_map.ptd

Piping isogen_output_files_dir Specify directory to save the PCFs created by 
ISOGEN interface

Piping isogen_pcf_filename_format Specify format to create filenames of PCF files 
being created

mnemonic,-,specification,-
,number

Piping isogen_symbol_map_file Specify name of file for mapping Pro/Piping 
selection names with ISOGEN symbol keys 
(SKEY)s

<creo_loadpoint>\text\piping_d
ata\isodata\isogen_symbol_ma
p.ptd

Piping pipe_3d_bend_theor_int_pts Yes - Displays theoretical intersections and bends in 
three-dimensional models.

yes, no no

Piping pipe_bend_locations_csys_unit
s

Define which assembly units will be used for the 
piping bend locations calculations. Yes - to use 
coordinate system assembly units. No - to use 
pipeline assembly units.

yes, no no

Piping pipe_pre_22_bendinfo_conv Convert bend report information generated prior to 
Pro/ENGINEER 2000i-2 to current saved analysis 
format.

yes, no yes

Piping pipe_solid_centerline Yes - Display Pro/PIPING centerlines. No - Do not 
display Pro/PIPING centerlines.

yes, no yes
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Category Name Description Values Default Value
Piping pipe_solid_label_format Specify the pipe solid label format that will be used 

to automatically generate pipeline labels.
size,-,specification,-
,mnemonic,-,number,-
,insulation

Piping pipe_update_pre_20_int_pts Yes - Pipelines created prior to Release 20.0 are 
updated with intersection point entities. The entities 
are created in session by Info>Regen Info or when 
you retrieve the model.

yes, no no

Piping pipeline_assembly_library_dir Sets the default pipeline assembly library directory. <creo_loadpoint>\text\piping_d
ata\pipelinelib\

Piping pipeline_assembly_name_form
at

Sets the default pipeline assembly name format. mnemonic,-,number

Piping pipeline_label_format Specify the pipeline label format that will be used to 
automatically generate pipeline labels.

size,-,specification,-
,mnemonic,-,number,-
,insulation

Piping pipeline_solid_start_part_name Sets the default pipeline solid start part name. pipeline_solid_start.prt

Piping pipeline_spool_label_format Specify the pipeline spool label format that will be 
used to generate the spool labels during pipeline 
spool generation.

mnemonic-number-
prefix&#91;0]spoolnum&#91;0
1]suffix&#91;]

Piping pipeline_start_assembly_name Sets the default pipeline start assembly name. pipeline_start.asm

Piping piping_appearance_map_file Sets the default piping appearance map filename. <creo_loadpoint>\text\piping_d
ata\master_catalog\piping_app
earance.map

Piping piping_bolt_nut_select_file Piping bolts and nuts selection file. <creo_loadpoint>\text\piping_d
ata\master_catalog\piping_bolt
_nut_select.ptd

Piping piping_design_method Sets the current Piping design method for pipeline 
modeling.

non_spec_driven, spec_driven, 
user_driven

non_spec_driven

Piping piping_enable_designate_repo
rt

Enable designatable reports for spec-driven piping. yes, no yes

Piping piping_end_compatibility_file Sets the default piping end compatibility filename. <creo_loadpoint>\text\piping_d
ata\master_catalog\piping_end
_compatibility.ptd

Piping piping_extend_dim_scheme Specify a dimension scheme for piping extend 
segment.

cartesian, cylindrical, spherical cartesian
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Category Name Description Values Default Value
Piping piping_extend_show_csys Control whether small preview CSYS is shown at 

end of pipe when defining extend features in 
cartesian / spherical / cylindrical schemes.

yes, no no

Piping piping_fitt_angle_tolerance Sets the default piping fitting angle tolerance value. 1.5

Piping piping_fitt_category_map_file Sets the default piping fitting category map 
filename.

<creo_loadpoint>\text\piping_d
ata\sample_project\piping_fitt_
category_map.ptd

Piping piping_fitt_library_dir Sets the default piping fitting library directory. <creo_loadpoint>\text\piping_d
ata\fittinglib\

Piping piping_fluid_parameter Enables/disables the Parameters tab in Create 
Pipeline Dialog

yes, no no

Piping piping_insulation_dir_file Sets the default piping insulation directory filename. <creo_loadpoint>\text\piping_d
ata\sample_project\piping_insu
lation_dir.ptd

Piping piping_joint_fitting_clearance Sets the piping joint minimum fitting clearance 
value.

1

Piping piping_joint_fitting_offset Sets the piping joint minimum fitting offset value. 1

Piping piping_manufacture_dir_file Sets the default piping manufacture directory 
filename.

<creo_loadpoint>\text\piping_d
ata\master_catalog\piping_ma
nufacture_dir.ptd

Piping piping_material_file Sets the default piping material filename. <creo_loadpoint>\text\piping_d
ata\master_catalog\piping_mat
erial.ptd

Piping piping_material_source Sets the source for material information. Note 
Material_dir requires pro_material_dir to be set.

weight_length, material_dir weight_length

Piping piping_mcat_dir Sets the default piping master catalog directory. <creo_loadpoint>\text\piping_d
ata\master_catalog\

Piping piping_mcat_dir_file Sets the default piping master catalog directory 
filename.

<creo_loadpoint>\text\piping_d
ata\master_catalog\piping_mc
at_dir.ptd

Piping piping_min_bolting_clearance Sets the default piping minimum bolting clearance 
value.

1

Piping piping_project_data_dir Sets the default Project data directory. <creo_loadpoint>\text\piping_d
ata\sample_project\

Piping piping_schematic_driven Set the Schematic Driven Pipeline Modeling 
ON/OFF

yes, no no
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Category Name Description Values Default Value
Piping piping_schematic_xml_dir Specify directory with full path containing schematic 

information XML file(s).
<dir_name>\dump_x86e_win6
4\

Piping piping_spec_dir_file Sets the default piping specification directory 
filename.

<creo_loadpoint>\text\piping_d
ata\sample_project\piping_spe
c_dir.ptd

Piping piping_system_tree_format Sets the default piping model tree format. mnemonic
Piping piping_thumb_wheel_incremen

t
Sets the default piping thumb wheel increment 
value.

1

Piping piping_thumb_wheel_ratio_inc Sets the default piping thumb wheel ratio increment 
value.

0.01

Piping piping_wildfire_convert Always ask before converting old piping assemblies 
to update the network structure.

never, automatic, manual manual

Piping pro_insulation_dir Specifies the directory to search for insulation files 
used in Pro/PIPING. Use full path name to avoid 
problems.

Piping pro_pip_fitt_dir Specifies the directory to search for fittings used in 
Pro/PIPING.

Piping pro_pip_lnstk_dir Specifies the directory to search for linestock files 
used in Pro/PIPING. Use full path name to avoid 
problems.

Piping units_system_dic_file Specifies the file containing the mapping for MCAT 
filename and units.

<creo_loadpoint>\text\piping_d
ata\master_catalog\piping_unit
s_system_dic_file.ptd

Printing & Plotting acrobat_reader Sets the Adobe Acrobat Reader command path. 
This value will be used to launch the reader after 
exporting a PDF document.

Printing & Plotting delete_after_plotting Yes - A plot file is automatically deleted from the 
directory in which it resides when it has been 
successfully plotted.

yes, no

Printing & Plotting din_std_line_priority If set to YES line priority in plotting or export is 
determined according to DIN standard

yes, no no

Printing & Plotting gerber_360_interpolation Yes - Arcs and circles included in outputted Gerber 
plot files will take this format.

yes, no no

Printing & Plotting pen_slew Sets the pen speed for both x and y directions for 
plotters that are compatible with this option. Consult 
your plotter's user guide for more information.

-1.000000 0.000000
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Category Name Description Values Default Value
Printing & Plotting pen_slew_xy Sets the pen speed for the x and y directions 

individually for plotters that are compatible with this 
option.  The first value is the x value and the 
second, the y value. They should be separated by a 
space.

-1.000000 0.000000

Printing & Plotting pen_table_file Specifies a default pen mapping table which 
supersedes other pen mapping information.

table.pnt

Printing & Plotting pen1_line_weight Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest).

4

Printing & Plotting pen2_line_weight Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest).

1

Printing & Plotting pen3_line_weight Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest).

2

Printing & Plotting pen4_line_weight Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest).

3

Printing & Plotting pen5_line_weight Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest).

2

Printing & Plotting pen6_line_weight Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest).

3

Printing & Plotting pen7_line_weight Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest).

1

Printing & Plotting pen8_line_weight Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest).

4

Printing & Plotting plot_carberry_extends When plotting to a raster format (jpg, tiff, etc), set to 
YES to ignore the view border and produce output 
sized to the smallest rectangle that includes the 
drawing items.

yes, no no

Printing & Plotting plot_file_dir Specifies the directory where plot files should be 
written. Use the full pathname to avoid problems. 
For example /home/users/plotfiles.
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Category Name Description Values Default Value
Printing & Plotting plot_linestyle_scale Specifies the scaling factor for the DOTFONT line 

style in a plot.
1

Printing & Plotting plot_names Yes - Plot files are given descriptive extensions 
when created. No - All plot files are simply given the 
extension .plt.

yes, no

Printing & Plotting plot_proceed_dialog Yes - Enables the Plot Proceed dialog which 
provides a choice for delaying the printing of plot 
files. This is useful for large plots when using lp print 
commands. The lp command may not access the 
plot file before it is removed resulting in no output.

yes, no no

Printing & Plotting plot_to_scale_full_window Provides the ability to exclude empty window space 
when plotting the model to scale.

yes, no

Printing & Plotting plotter Establishes the default plotter for making plot files.

Printing & Plotting plotter_command Sets the command that you use to start a plot on 
your system; for Windows NT or Windows 95, 
windows_print_manager option configures Creo to 
plot to a recognized device in the Windows NT or 
Windows 95 print manager.

windows_print_manager

Printing & Plotting plotter_handshake Specifies the type of plotter handshake initialization 
sequence generated in the plotter files.

hardware, software

Printing & Plotting postscript_compression Specifies whether or not to compress exported 
shaded PostScript files. Yes - A shaded postscript 
file created with File>Export will be compressed. 
This will increase processing time.

yes, no no

Printing & Plotting pro_plot_config_dir Sets the directory of your user-defined plotter 
configuration file. Use the full pathname to avoid 
problems.

Printing & Plotting ps_output_with_pagesize Specifies whether or not to include pagesize 
information when generating postscript files from 
Creo. No - Creo will omit Adobe level 2 pagesize 
information from the header of the postscript file.

yes, no yes

Printing & Plotting raster_plot_dpi Determines the resolution for plotter outputs 
variables are in dots per inch.

100, 200, 300, 400 100
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Category Name Description Values Default Value
Printing & Plotting rotate_postscript_print Specifies rotation for printing. Yes - Rotates a 

PostScript plot 90 degrees counterclockwise. Use 
when you are plotting a landscape drawing on a 
portrait-type laser printer, or a portrait drawing on a 
landscape-type laser printer.

yes, no

Printing & Plotting shaded_postscript_background Specifies how background colors are handled in 
Postscript files of shaded objects.

yes, no no

Printing & Plotting ttf_handling_for_plot_files Defines how annotations using True Type Fonts are 
written to the plot file. Using True Type Fonts 
reduces the plot file size, but font substitution may 
occur due to device settings. Annotations that do 
not use True Type Fonts are unaffected by this 
option.

stroke all fonts, use true type fonts use true type fonts

Printing & Plotting u3d_create_color_surfaces YES- Exports color of each surface of model. NO- 
Exports one color per model. Default NO.

yes, no no

Printing & Plotting use_8_plotter_pens Specifies whether to support up to 8 plotter pens. 
The initial default is 4 pens.

yes, no no

Printing & Plotting use_software_linefonts Yes - The exact line style used in Creo is plotted, 
stroked out dot by dot, dash by dash, and space by 
space. No - plots lines using the line font it supports 
which most closely resembles the font used in Creo.

yes, no no

Printing & Plotting variable_plots_in_inches No - Variable plot sizes may be entered in 
millimeters.

yes, no yes

Printing & Plotting versatec_cutter_installed Yes - Indicates that a cutter is installed on a 
Versatec plotter.

yes, no

Reference Control allow_direct_ref_to_layout_file Allow direct references to layout files through layout 
feature.

yes, no no

Reference Control allow_ref_scope_change No - Displays the message "Reference scope 
changes are prohibited by the configuration file 
settings" when the Ref Scope user interface is 
changed.

yes, no yes

Reference Control def_comp_ref_ctrl_exception Default setting for newly created components that 
allows/disallows referencing entities forbidden by 
Reference Control settings.

yes, no yes

Reference Control def_multiple_backup_prompt_
num

Number of selected components that will invoke 
confirmation before multi-component backing up 
placement references.

100
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Category Name Description Values Default Value
Reference Control def_obj_feat_refs_to_backup Default setting that controls the level of feature 

backup for newly created models. Other_models: all 
references to other models will be backed up, 
Non_permitted: only references that were created 
despite the initial restrictions will be backed up.

none, other_models, non_permitted non_permitted

Reference Control def_obj_place_refs_to_backup Default setting that controls the level of placement 
backup for newly created models. Other_models: all 
references to other models will be backed up, 
Non_permitted: only references that were created 
despite the initial restrictions will be backed up.

all, none, other_models, non_permitted non_permitted

Reference Control def_obj_ref_ctrl_exception Default setting for newly created models that 
allows/disallows referencing entities forbidden by 
Reference Control settings.

yes, no yes

Reference Control default_comp_geom_scope Set thespecified Shared Geometry reference control 
conditions to newly added components.

all, none, pg all

Reference Control default_comp_module_geom_
scope

Set the specified Shared Geometry reference 
control conditions to newly added components for 
configurable structure.

all, none, pg, tagged tagged

Reference Control default_comp_scope_setting Set the specified Accessible reference control 
conditions to newly added components.

all, none, subassemblies, skeleton_model all

Reference Control default_comp_skel_geom_sco
pe

Set the specified Shared Geometry reference 
control conditions to newly added Skeleton 
components.

all, none, pg all

Reference Control default_comp_skel_scope_sett
ing

Set the specified Accessible reference control 
conditions to newly added Skeleton components.

all, none, subassemblies, skeleton_model all

Reference Control default_ext_ref_scope Set default scope for externally referenced models. 
All - Any model. None - Only current model and 
children. Skeletons - Any component in model's 
assembly and higher skeletons on branch. 
Subassembly - Only components and children in 
model's assembly.

all, none, subassemblies, skeleton_model all

Reference Control default_geom_scope Default value for Geometry Scope allowed for 
referencing.

all, pg_if_exists, pg_only all
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Category Name Description Values Default Value
Reference Control default_obj_constraints_scope Set the specified Shared Placement reference 

control conditions to newly created models if 
template models were not used.

all, none, interfaces all

Reference Control default_obj_module_constr_sc
ope

Set the specified Shared Placement reference 
control conditions to newly created models for 
configurable structure if template models were not 
used.

all, none, interfaces, tagged tagged

Reference Control default_obj_module_geom_sco
pe

Set the specified Shared Geometry reference 
control conditions to newly created models for 
configurable structure modules if template models 
were not used.

all, none, pg, tagged all

Reference Control default_object_geom_scope Set the specified Shared Geometry reference 
control conditions to newly created models if 
template models were not used.

all, none, pg all

Reference Control default_object_scope_setting Set default condition for reference control. All - Any 
model. None - Only current model and children. 
Skeletons - Any component in model's assembly 
ang higher skeletons on branch. Subassembly - 
Only components and children in model's assembly.

all, none, subassemblies, skeleton_model all

Reference Control default_placement_scope Default value for Component Placement Reference 
filter.

all, intrf_if_exists, intrf_only all

Reference Control feat_references_to_backup Level of backup for feature references none, other_models, non_permitted non_permitted
Reference Control ignore_all_ref_scope_settings Controls whether object-specific reference scope 

settings are ignored or not. Environment scope 
settings will still be enforced. See also 
allow_ref_scope_change and default_ext_ref_scope

yes, no no

Reference Control ignore_export_geom_declarati
on

Ignore Export Geometry settings. yes, no no

Reference Control model_allow_ref_scope_chang
e

Yes - Users can change the scope setting of 
components.

yes, no yes

Reference Control placement_references_to_bac
kup

Level of backup for placement references all, none, other_models, non_permitted non_permitted

Reference Control ref_control_allow_exceptions Check to allow referencing components that are not 
permitted by the above setting

yes, no yes
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Category Name Description Values Default Value
Reference Control ref_scope_copy_color Set the color of backed up references according to 

RGB values. Enter RGB values between 0 and 100 
separated by space.

55.000000 55.000000 
55.000000

Reference Control ref_scope_copy_color_change Enable changing colors of backuped references 
during selection.

yes, no yes

Reference Control ref_scope_no_pick_to_copy Disable selecting references backuped by 
references control.

yes, no no

Reference Control ref_scope_no_pick_to_prohibit Disable selecting references prohibited by 
references control.

yes, no yes

Reference Control ref_scope_prohibit_color Set the color of prohibited references according to 
RGB values. Enter RGB values between 0 and 100 
separated by space.

45.000000 45.000000 
45.000000

Reference Control ref_scope_prohibit_color_chan
ge

Enable changing colors of prohibited references 
during selection.

yes, no yes

Sheetmetal close_corner_relief Closes the gap between the bend surfaces of a 
corner that is a result of intersecting walls in the 
form state.

yes, no no

Sheetmetal die_models_directory Sets path to directory that contains the die models.

Sheetmetal enable_flat_state Enables the creation of a flat state instance of the 
model. The instance can be fully flat or fully formed.

yes, no no

Sheetmetal flange_shape_sketches_direct
ory

Sets path to directory that contains the Flange 
shapes.

Sheetmetal flat_shape_sketches_directory Sets path to directory that contains the Flat shapes.

Sheetmetal initial_bend_y_factor Specifies a constant used to determine the neutral 
bend line for a sheet metal part. This value is always 
used for non-cylindrical bends. It is used for regular 
bends only when no bend table is specified.

0.5

Sheetmetal material_upd_smt_bend_table Defines whether assignment of material to the 
model via Creo Toolkit will overwrite existing bend 
table data and y factor value. Always Replace - 
Overwrites existing data. Never Replace - Keeps 
existing data

always_replace, never_replace always_replace
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Category Name Description Values Default Value
Sheetmetal merge_smt_srfs_without_sea

m
Yes - no edge left at the merge if the sheetmetal 
surfaces being merged are same surfaces. No - 
edge is left even between same sheetmetal 
surfaces.

yes, no yes

Sheetmetal pro_sheet_met_dir Sets the default directory of your user-defined bend 
tables. If not set, the Pro/SHEETMETAL supplied 
bend tables are used. Use the full path name to 
avoid problems.

Sheetmetal pro_smt_params_dir Specifies the directory to save/retrieve Sheet metal 
parameters files.  Use full path name to avoid 
problems.

Sheetmetal punch_axis_points Yes - Enables the creation of punch axis points in 
Sheetmetal cuts and punches.

yes, no no

Sheetmetal punch_models_directory Sets path to directory that contains the punch 
models.

Sheetmetal smt_add_bends_on_sharp_ed
ges

Determines if bends will be added automatically on 
edges with sharp geometry in the wall creation tools. 
Yes - bends will be added automatically. No - sharp 
geometry of edges will be kept.

yes, no yes

Sheetmetal smt_allow_flip_sketch Yes - Allows flipping the sketch in Flat and Flange 
tools. No  - Disables the ability to flip the sketch in 
Flat and Flange tools.

yes, no no

Sheetmetal smt_bend_notes_dflt_display Define the default state of bend note display 
(sheetmetal mode)

yes, no yes

Sheetmetal smt_bend_notes_direction_do
wn

Define the down direction symbol for bend notes 
(sheetmetal mode)

default

Sheetmetal smt_bend_notes_direction_up Define the up direction symbol for bend notes 
(sheetmetal mode)

default

Sheetmetal smt_bend_notes_order Define the fields order for bend notes (sheetmetal 
mode)

&type&direction&angle

Sheetmetal smt_bend_notes_type_formed Define the formed symbol for bend notes 
(sheetmetal mode)

default

Sheetmetal smt_bend_notes_type_rolled Define the rolled symbol for bend notes (sheetmetal 
mode)

default

Sheetmetal smt_crn_rel_display Yes - Corner relief notes will be displayed. No - 
Corner relief notes will not be displayed.

yes, no yes
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Category Name Description Values Default Value
Sheetmetal smt_drive_bend_by_parameter

s
Sheetmetal bend radius and bend angle values and 
bend dimension location will be driven by feature 
level relations to Sheetmetal parameters.

yes, no no

Sheetmetal smt_drive_tools_by_parameter
s

Drives the Sheetmetal options and values by feature-
level relations to Sheetmetal parameters.

yes, no yes

Sheetmetal smt_form_abort_on_fail_plc Yes - will always fail the Sheetmetal Form feature if 
there is a problem with its placement .

yes, no no

Sheetmetal smt_mp_method MASS - Suppressed Flat Pattern and Flatten Forms 
will be temporary resumed before mass properties 
calculation of sheetmetal part. CG - Mass 
Properties calculation will be performed on current 
state of sheetmetal part.  BOTH - Both methods will 
be used one after the other.

both, mass, cg cg

Sheetmetal smt_outside_mold_lines Yes - Outside Mold Lines will be created during Flat 
Pattern creation.

yes, no no

Sketcher 2d_palette_path Sets the default directory for the user sketcher 
shape library. Use the full path name to avoid 
problems.

Sketcher dma_sketcher_guide_width_fa
ctor

Guide width as a proportion of sketched line width 0.75

Sketcher grid_snap Yes - Makes pick points snap to a grid. No - Turns 
the grid snap off so that any location can be picked.

yes, no no

Sketcher section_color Specifies the color of sketched sections. default, drawing_color, sketch_color
Sketcher sket_import_geometry_line_sty

le
Determine if the original line style and color should 
be preserved on Copy/Paste, Sketcher Palette and 
Import from file. Yes - Preserve original line style 
and color.

yes, no no

Sketcher sketcher_alignment_constr Yes - Alignment constraints will be used by Intent 
Manager; No - Alignment constraints will not be 
used.

yes, no no

Sketcher sketcher_animated_modify No - The section is not animated as modifications 
are regenerated.

yes, no yes

Sketcher sketcher_auto_create_referenc
es

This option controls the automatic reference 
creation from selected background geometry.

yes, no no
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Category Name Description Values Default Value
Sketcher sketcher_auto_create_refs The option values are: 2: the system automatically 

creates 2 dimensioning references; 1: the system 
automatically adds the orientation reference as a 
dimensioning reference; 0: the system does not 
automatically create dimensioning references.

1, 2 2

Sketcher sketcher_blended_background This option controls whether the blended 
background should be used in 3D Sketcher.  The 
option has no effect if blended background is turned 
off generally.

yes, no no

Sketcher sketcher_collinear_constr Yes - collinear constraints will be used by Intent 
Manager; No - collinear constraints will not be used 
by Intent Manager.

yes, no yes

Sketcher sketcher_default_font_kerning Automatically set kerning for text entities in 
Sketcher. Yes - Kerning will be set for new text 
entities. No  - Kerning will not be set automatically.

yes, no no

Sketcher sketcher_diagonal_constr Yes - Diagonal constraints will be used; No - 
Diagonal constraints will not be used.

yes, no no

Sketcher sketcher_dim_of_revolve_axis If this option is set all dimensions created by Intent 
Manager to Axis of Revolution will be diameter 
dimensions.

yes, no yes

Sketcher sketcher_dimension_autolock Automatically lock strong sketcher dimensions. yes, no no

Sketcher sketcher_disp_constraints Shows the constraints when sketching in Sketcher 
Mode; for example, H for horizontal, V for vertical, 
and so on.

yes, no yes

Sketcher sketcher_disp_dimensions No - Suppresses the display of all dimensions while 
in sketcher.

yes, no yes

Sketcher sketcher_disp_grid Specify whether or not to display the sketcher grid. yes, no no

Sketcher sketcher_disp_guides Shows guides when sketching. yes, no yes
Sketcher sketcher_disp_vertices No - Suppresses the display of yellow points on all 

vertices while in sketcher.
yes, no yes

Sketcher sketcher_disp_weak_dimensio
ns

Yes - weak dimensions will be displayed; No - weak 
dimensions will not be displayed.

yes, no yes
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Category Name Description Values Default Value
Sketcher sketcher_equal_length_constr Yes - equal length constraints will be used by Intent 

Manager; No - equal length constraints will not be 
used by Intent Manager.

yes, no yes

Sketcher sketcher_equal_radii_constr Yes - equal radii constraints will be used by Intent 
Manager; No - equal radii constraints will not be 
used by Intent Manager.

yes, no yes

Sketcher sketcher_grid_angle Enter a grid angle value to override the default grid 
angle value.

0

Sketcher sketcher_grid_line_quantity Enter number of radial lines for radial grid. 12
Sketcher sketcher_grid_radius_spacing Enter a radial grid spacing value to override the 

default radial grid spacing value.
1

Sketcher sketcher_grid_type Set grid type to be Cartesian or Polar. cartesian, polar cartesian
Sketcher sketcher_highlight_open_ends Yes - Highlights open ends of sketched entities in 

Sketcher. No - Does not highlight open ends of 
sketched entities in Sketcher.

yes, no yes

Sketcher sketcher_import_exact_geom During import in sketcher use exact geometry. yes, no yes

Sketcher sketcher_known_dim_on_ref_e
nt

YES - create known dimensions on known 
geometry, NO - create reference dimensions on 
known geometry

yes, no yes

Sketcher sketcher_lineup_hor_constr Yes - line up horizontal constraints will be used by 
Intent Manager; No - line up horizontal constraints 
will not be used by Intent Manager.

yes, no yes

Sketcher sketcher_lineup_ver_constr Yes - line up vertical constraints will be used by 
Intent Manager; No - line up vertical constraints will 
not be used by Intent Manager.

yes, no yes

Sketcher sketcher_lock_modified_dims Yes - modified dimensions will be locked; No - 
modified dimensions will not be locked.

yes, no no

Sketcher sketcher_midpoint_constr Yes - midpoint constraints will be used by Intent 
Manager; No - midpoint constraints will not be used 
by Intent Manager.

yes, no yes

Sketcher sketcher_parallel_constr Yes - parallel constraints will be used by Intent 
Manager; No - parallel constraints will not be used 
by Intent Manager.

yes, no yes

Sketcher sketcher_perpendicular_constr Yes - perpendicular constraints will be used by 
Intent Manager; No - perpendicular constraints will 
not be used by Intent Manager.

yes, no yes
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Category Name Description Values Default Value
Sketcher sketcher_point_on_entity_cons

tr
Yes - point on entity constraints will be used by 
Intent Manager; No - point on entity constraints will 
not be used by Intent Manager.

yes, no yes

Sketcher sketcher_refit_after_dim_modif
y

Refits section after dimension modification in 2D 
section or when creating the first feature.

yes, no yes

Sketcher sketcher_same_point_constr Yes - same points constraints will be used by Intent 
Manager; No - same points constraints will not be 
used by Intent Manager.

yes, no yes

Sketcher sketcher_save_preview_image This option controls whether section files should be 
saved with embedded image information which can 
be used to preview sections in File/Open dialog.

yes, no no

Sketcher sketcher_set_grid_method "Dynamic" - grid spacing is determined by the 
system based on zoom factor, "Static" - grid spacing 
is fixed and set by the user.

dynamic, static dynamic

Sketcher sketcher_set_grid_x_major Enter the number of grid lines per major line in x 
axis.

5

Sketcher sketcher_set_grid_x_spacing Enter an x-grid spacing value to override the default 
x-grid spacing value.

1

Sketcher sketcher_set_grid_y_major Enter the number of grid lines per major line in y 
axis.

5

Sketcher sketcher_set_grid_y_spacing Enter a y-grid spacing value to override the default y-
grid spacing value.

1

Sketcher sketcher_shade_closed_loops yes-closed loops in sketcher will be displayed as 
shaded, no-closed loops in sketcher will not be 
displayed as shaded

yes, no yes

Sketcher sketcher_snap_sensitivity Adjusts the sensitivity of the snapping to geometry. high, medium, low, very_high, very_low very_high

Sketcher sketcher_starts_in_2d Defines initial model orientation in Sketcher mode. 
Yes - (2D orientation) Looking directly at section 
(sketching) plane. No - (Orientation unchanged) 
Sketch directly on the 3D part.

yes, no no

Sketcher sketcher_symmetric_constr Yes - symmetric constraints will be used by Intent 
Manager; No - symmetric constraints will not be 
used by Intent Manager.

yes, no yes

Sketcher sketcher_tangent_constr Yes - tangent constraints will be used by Intent 
Manager; No - tangent constraints will not be used 
by Intent Manager.

yes, no yes
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Category Name Description Values Default Value
Sketcher sketcher_undo_reorient_view Controls the ability to Undo view reorientation while 

in Sketcher. Yes - it is possible to Undo view 
reorientation in Sketcher.

yes, no no

Sketcher sketcher_undo_stack_limit Sketcher saves a copy of each function performed. 
The number of possible saved functions depend on 
the number specified in the option. The undo menu 
can be used to remove the stored functions.

200

Style Feature advanced_style_surface_edit Use advanced options by default for Surface Edit in 
Style.

yes, no no

Style Feature keep_style_items_hidden_on_
exit

Keep style entities hidden after exiting of the Style 
feature definition.

yes, no no

Style Feature style_auto_regen_curves Yes - Enable autoregeneration of curves. yes, no yes
Style Feature style_auto_regen_shaded_surf

ace
Yes - Enable autoregeneration of shaded surfaces. yes, no yes

Style Feature style_auto_regen_surface Yes - Enable autoregeneration of surfaces. yes, no yes
Style Feature style_connection_arrow_scale Set scale factor of surface connection arrow. 

Number should be greater then 0.
1

Style Feature style_default_connections Yes - Add connections to a newly created Style 
surface.

yes, no yes

Style Feature style_display_grid Yes - Display grid for active datum plane. yes, no yes
Style Feature style_grid_spacing Set the number of lines to display on the grid. 

Number should be equal or greater than 2.
5

Style Feature style_merge_surfaces Merge surfaces on exit from the Style Feature yes, no yes
Style Feature style_surface_mesh_display On - Display surfaces mesh. Off - Do not display 

surfaces mesh. Off When Shaded - Display 
surfaces mesh except when shaded.

off, on, off when shaded off when shaded

Style Feature style_surface_mesh_quality Sets the quality of the surface mesh. Values range 
is between 0.1 to 10.

1

System allow_float_opt_checkout Yes - Allows checkout failure for floating modules. yes, no no

System auto_traceback "always": a traceback file will be generated when a 
fatal error occurs. "yes", "ask": ask the user whether 
to generate a traceback. "no", "never": no traceback 
will be generated.

yes, no, never, ask, always always

System browser_limit_to_ie9_mode Limit Internet Explorer to IE9 standard mode even if 
higher version is installed.

yes, no no
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Category Name Description Values Default Value
System cmdmgr_trail_output Trail file and mapkey output will include system 

instructions that are independent of user interface 
configuration when available (typically menu bar and 
toolbar options).

yes, no yes

System cpus_to_use Set up the number of threads including main thread 2

System csv_format_delimeter Define the delimeter character in BOM format file: 
Comma, TAB, Semicolon, Space or other user-
defined

comma, tab, semicolon, space

System display_ie8_warning_dialog Show/Hide the warning dialog related to Internet 
Explorer 8 running in Compatibility Mode

yes, no yes

System enable_tree_indep Setup whether tree customization will allow 
separating the tree window from Creo window.

yes, no no

System export_report_format Controls the format of the exported reports 
displayed in the embedded browser. Rich Text - 
Exports the report in Rich Text format, Comma 
Delimited - Exports the report in Comma Delimited 
format.

comma_delimited, rich_text comma_delimited

System general_undo_stack_limit Setup the default number of entries in the top level 
Undo/Redo (default = 50).

50

System overlays_enabled Yes - Enables Creo screens and menus to be 
placed on different overlay layers of the hardware 
graphics card. This frees memory for Creo use.

yes, no no

System pick_aperture_radius Specifies the size of the area about the mouse 
when making selections. Units are 1/1000 of screen 
size.

7

System protable_in_background Yes - Starts Pro/TABLE editor in the background. 
Reduces time between pressing a menu button that 
uses Pro/TABLE and entering the data.

yes, no yes

System saveunders_enabled Yes - Enables Creo popup helptext and menus to 
retain the portion of the window they obscure to be 
used to restore the window image when they are 
dismissed.

yes, no yes

System set_trail_single_step Yes - Enables a trail file to be single-stepped by 
entering <CR>.

yes, no no

System tablet_device_name Specifies the name of a digitizing tablet.
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Category Name Description Values Default Value
System trail_delay Sets a delay in seconds between trail file steps.
System trail_dir Instructs Creo to create its trail file in the specified 

directory rather than in the startup directory.

System train_file_path Specifies the default directory for training files. The 
path name must start from the root of the directory, 
for example, /home/users/library/training.

System web_browser_history_days Enter number of days to store history records. 20
System web_browser_homepage Enter location of Creo browser home page. <creo_loadpoint>\help\usascii\

resource_center_index.html

System web_browser_in_separate_win
dow

Specifies whether Creo web browser should be 
launched as a separate window. When set to Yes 
the browser will be displayed as a separate window. 
The default, No, will result in the browser being 
embedded in the Creo application window.

yes, no no

System windows_browser_type Select the type of embedded browser to use. ie_browser, chromium_browser ie_browser
Update Control child_of_layout_backup_updat

e
Set the default update state for a child referencing 
the layout feature's geometry.

manual, auto, notify auto

Update Control copied_feat_refs_update_state Copied Feature References Update manual, auto, notify, no_dependency auto

Update Control copied_place_refs_update_stat
e

Copied Placement References Update manual, auto, notify, no_dependency auto

Update Control direct_child_of_layout_update Set the default update state for a child directly 
referencing the layout model through layout feature.

manual, auto, notify notify

Update Control individual_child_update Allow individual update control for children of layout 
feature.

yes, no yes

Update Control new_cg_update_state Set the default update state for newly created Copy 
Geometry features relative to the reference model.

manual, auto, notify auto

Update Control new_layout_feature_update_st
ate

Define the default update state of a new DSF 
created.

manual, auto, notify notify

Update Control retrieve_data_sharing_ref_part
s

Automatic reference parts retrieval for dependent 
data sharing features.

yes, no, ignore_missing no
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Category Name Description Values Default Value
User Interface ae_propagate_detail_depende

ncy
Sets the AE detail dependency for AE's that are 
locally propagated. If set to independent, the AE's 
parameter call outs will update to other propagated 
AEs parameters.

dependent, independent dependent

User Interface af_copy_references_flag Toggle display of Copy References column in 
Annotation Feature definition dialog

yes, no no

User Interface allow_confirm_window Display a confirmation window when exiting Creo. 
This enables you to use the mouse to 
confirm/cancel exiting Creo.

yes, no yes

User Interface auto_ae_param_file Define path and file name of external file used to 
define parameters that are automatically created in 
all Annotation Elements.

User Interface auto_include_annot_plane Control the default setting of the check box in the 
Propagate annotation dialog box which controls 
whether to pass all annotations plane references.

yes, no yes

User Interface auto_propagate_ae Yes - causes the automatic, local propagation of 
AE's after a supported feature has been created.

yes, no no

User Interface auxapp_popup_menu_info Enable display of popup menu info in the trail file. yes, no no

User Interface bm_graph_tool BMX graph tool default, excel_linked, excel_embedded default
User Interface bmgr_pref_file Specifies the location of the Graph Tool preference 

file.
User Interface button_name_in_help Yes - The name and menu of any selected menu 

option displays, in English, in the help text 
associated with that button.

yes, no no

User Interface default_font Sets font for text other than menu bar, menus and 
their children, and pop-up menus and help. Add 
comma-delimited variables in any order (italic bold, 
24, times or 24, times, italic bold have the same 
effect). Any omitted variable uses standard setting.

User Interface dialog_translation Specifies the language in which the dialog display 
when running non-English version of Creo.

yes, no yes

User Interface enable_popup_help Controls pop-up help in dialog boxes. Yes - Help 
enabled. No - Help disabled.

yes, no yes
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Category Name Description Values Default Value
User Interface fonts_size Determines the relative size of the text in menus 

and dialog boxes. You must restart Creo for the 
change to take effect.

medium, small, large

User Interface help_translation Specifies the language in which the short help 
messages display when running non-English 
versions of Creo. Yes - Display in native language. 
No - Display in English.

yes, no yes

User Interface iconify_entire_pro Determines how many other Creo windows/menus 
are iconified when one window is iconified. Yes - All 
the windows and menus are iconified. No - Only the 
selected window is iconified.

yes, no yes

User Interface kbd_cmd_abbreviation On - Enables use of abbreviations when entering 
menu commands from the keyboard.

off, on off

User Interface kbd_selection Provides the ability to select locations in the 
graphics area via the keyboard.  Yes - Selection in 
the graphics area may be performed via the 
keyboard.  No - Selection in the graphics area 
requires a mouse.

yes, no no

User Interface load_ui_customization_run_dir Enables the loading of the UI customization file (.ui) 
if located in the run directory

yes, no no

User Interface mdl_tree_cfg_file Specifies the Model Tree configuration file to be 
loaded when Creo is started.

User Interface menu_font Specify font used in the Creo menu bar, menus, and 
all their children. Specify the comma-delimited 
variables in any order (italic bold, 24, times or 24, 
times, italic bold have the same effect). Any omitted 
variable uses the standard setting.

User Interface menu_manager_position Controls the position of the Menu Manager.  outside 
- Top left corner of Menu Manager is aligned to top 
right corner of window, inside - Top right corner of 
Menu Manager is aligned to top right corner of 
graphics area,  adaptive - Menu Manager is 
positioned outside if there is enough room, 
otherwise it is positioned inside.

inside, outside, adaptive adaptive

User Interface menu_mapper_location Specify your own URL for the Menu Mapper button 
in the help menu.
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Category Name Description Values Default Value
User Interface menu_translation Specifies the language in which the menus display 

when running non-English version of Creo.
yes, no, both yes

User Interface modeltree_show_gen_of_insta
nce

Determines whether the generic name is displayed 
as an extension of the instance name in the model 
tree and other model name lists.

yes, no yes

User Interface msg_translation Specifies language in which Messages are 
displayed when running non-English version of 
Creo.

yes, no yes

User Interface native_kbd_macros Specifies support of keyboard macros written in 
native language (for example, German).

yes, no no

User Interface new_parameter_ui Enable the new parameter editor and user interface. yes, no yes

User Interface new_relation_ui Enable the new relations editor and user interface. yes, no yes

User Interface online_resources_location Specify your own URL for the Online Resources 
button in the help menu.

User Interface open_window_maximized Open any new Creo window maximized by default. 
This config will override "reserve_menu_space" 
option.

yes, no no

User Interface param_dec_places Sets the number of decimal places (0-14) to display 
in parameters.

6

User Interface parameter_dialog_setup_file Setup for the parameter dialog configuration file.
User Interface part_table_editor Sets the editor that is used to edit notebook 

parameter tables. Protab - Use Pro/TABLE. Editor - 
Use the system editor (refer to 
pro_editor_command).

protab, editor, excel

User Interface pattern_relations_copy Determines whether relations of pattern leader are 
inherited by pattern members.

yes, no yes

User Interface popuphelp_font Specify font used in the Creo pop-up help. Add the 
comma-delimited variables in any order (italic bold, 
24, times or 24, times, italic bold have the same 
effect). Any omitted variable uses the standard 
setting.

User Interface pro_editor_command Enables use of an editor other than the system 
editor when the option editor has been specified as 
the value for the options part_table_editor or 
relation_file_editor.
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Category Name Description Values Default Value
User Interface prompt_on_exit Determines if you are prompted to save objects 

when exiting a Creo Parametric session.
yes, no no

User Interface propagate_inactive_annotation Yes - causes the propagation of inactive annotation. yes, no yes

User Interface provide_pick_message_always No - A message describing the (pre)selected item is 
provided only while querying. Yes - A message 
describing the selected item is provided in all cases 
(i.e. even when Query is not used).

yes, no no

User Interface relation_file_editor Sets the editor used to edit relations. protab, editor editor
User Interface reserved_menu_space Reserves space for extra menus to the right of the 

Creo window (0.0-4.0). This option overrides 
windows_scale.

1

User Interface right_mouse_button_popup Specify whether or not the right mouse button pop 
up menu is available or not.

yes, no yes

User Interface selection_dragger_display_ma
x

Threshold for the number of simultaneously 
selected items to not display draggers.

100

User Interface set_menu_width Determines width of menu manager panels. Default 
value is equivalent to 8 character widths. Acceptable 
range is from 8 to 20. Values lower than 8 and 
higher than 20 are ignored.

-1

User Interface summary_help Refers to the one-line help Messages that are either 
displayed or not displayed.

yes, no no

User Interface suppress_dlg_license_expired Suppresses "License expired: List of options and 
expiration days" dialog

7

User Interface suppress_license_loss_dialog Yes - Suppresses the 'Regained Floating License' 
dialog box. No - The 'Regained Floating License' 
dialog box will display.

yes, no no

User Interface terminal_command Specifies the full path to the terminal emulator 
command (the command that starts shell windows). 
Use the command for your system. Enter the 
complete path name and the terminal command.

User Interface thermo_position_hint Enables you to position the thermometer-type 
scales whenever they appear, so that they do not 
overlap the Creo windows (if space permits, for 
example, if windows have been scaled).

no_window_overlap, window_overlap window_overlap
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Category Name Description Values Default Value
User Interface visible_mapkeys No - Mapkeys will run without displaying picks being 

made in the Menu Manager menus. This does not 
affect the display of picks being made in menu bar 
menus or dialog boxes.

yes, no no

User Interface visible_message_lines Sets the default number of visible message lines in 
the Creo message area.

2

User Interface windows_scale Scales Creo windows with a given coefficient. A 
value of 0.85 is usually adequate to allow dynamic 
menus to display to the right of the Creo window.

1

Weld add_weld_mp Yes - System includes welds when calculating mass 
properties and approximates lightweight weld mass 
properties. No - System excludes welds when 
calculating mass properties.

yes, no no

Weld pro_weld_params_dir Specifies the directory to search when a weld 
parameter file is needed.

Weld weld_ask_xsec_refs No - Do not ask for X-section references when 
creating weld features. Yes - Ask for X-section 
references when creating weld features.

yes, no no

Weld weld_color Defines default weld color. The three decimal values 
specify (in order) percentage of red, green and blue 
in the resulting color. For example, 0 0 49 specifies 
a medium blue. Change in session using 
Tools>Colors>System.

0.000000 0.000000 0.000000

Weld weld_dec_places Sets the default number of decimal places (0-10) to 
display in weld parameters.

3

Weld weld_edge_prep_driven_by Determines if the edge preparation feature is 
created in the part or the  assembly level.

part, assembly part

Weld weld_edge_prep_groove_angle Specifies an initial default value for the angle cut 
edge preparation.

45

Weld weld_edge_prep_groove_dept
h

Specifies an initial default value for the edge 
preparation depth.

0.25

Weld weld_edge_prep_instance Controls whether a family table instance is created 
for edge preparation. Yes - Instances of the 
components that receive edge preparation are 
created.

yes, no
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Category Name Description Values Default Value
Weld weld_edge_prep_name_suffix Specifies the suffix name for the instance that will 

be created during edge preparation. Part name plus 
extension makes the instance name.

_noep

Weld weld_edge_prep_root_open Specifies an initial default value for the root opening 
edge preparation.

0.25

Weld weld_edge_prep_visibility Applies only if weld_edge_prep is set to Yes. 
Generic - Edge preparation features are resumed in 
the generic and suppressed in the instance. 
Instance - Edge preparation features are 
suppressed in the generic and resumed in the 
instance.

generic, instance

Weld weld_geom_type_default Sets the default weld geometry type. light, surface surface
Weld weld_notch_corner_radius Specifies an initial default value for the radius at 

weld notch corner.
0.1

Weld weld_notch_height Specifies an initial default value for the weld notch 
height.

0.4

Weld weld_notch_radius Specifies an initial default value for the weld notch 
radius.

0.5

Weld weld_notch_width Specifies an initial default value for the weld notch 
width.

0.5

Weld weld_ui_standard Specifies standard for welding user interface. ANSI - 
Use ANSI standards. ISO - Use ISO standards.

ansi, iso ansi

Without category accessory_window_above Yes - Displays and keeps the accessory window 
above the active window. No - Does not keep the 
accessory window above the active window.

yes, no no

Without category accessory_window_display Docked - Displays the accessory window embedded 
in the active window. Undocked - Displays the 
accessory window as a standalone window.

undocked, docked docked

Without category acis_out_version Allows the user to choose ACIS export version. 4, 5 5
Without category aec_parameter_file Specifies the file name of the user defined piping 

parameter codes.
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Category Name Description Values Default Value
Without category allow_delete_many_in_drawing

s
Make the Delete Many command available in 
drawing mode. The Delete Many command is not 
supported by undo but can improve performance 
when deleting a significant number of items.

yes, no no

Without category allow_workpiece_silhouette Determines if the workpiece is allowed for Silhouette 
Mach Window creation. NO - only reference part is 
allowed; YES - both workpiece and reference part 
are allowed; AUTO - only workpiece is allowed.

yes, no, auto no

Without category animation_imported_pbk_dir Sets the default directory for the playback files to be 
used for Imported Animation.

Without category anlfeat_update_on_redefine Force full analysis feature update (like new) on 
redefinition

yes, no no

Without category arc_radius_limit Sets the upper limit for a radius in a CIRCLE 
statement of NCL file. The value must be positive. If 
not, 10*part_size is used.

-1

Without category ask_designate_owners Show the both required and optional owners to be 
designated.

yes, no yes

Without category assemble_module_in_rep Retrieves the assembled module to CSA in a 
specified representation.

representative module variant

Without category atb_search_path Extends search path for ATB Update and ATB 
Check Status commands.

Without category attach_menumanager Setup menu manager attachment to the main Creo 
window.

yes, no no

Without category auto_center_dimension Automatically centers the dimension text between 
witness lines. For common reference dimensions, 
controls the centering of the first dimension only.

yes, no no

Without category auto_clean_shown_dimensions This option controls whether the clean dimensions 
routine is automatically applied for newly shown 
dimensions. When set to NO the dimensions will be 
shown using their default locations from the model.

yes, no yes

Without category auto_eval_current_cnfg_rule If the option is "yes" simplified representation would 
be updated each time on retrieve/regeneration if it 
contains current configuration rule.

yes, no yes
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Category Name Description Values Default Value
Without category auto_show_3d_detail_items When set to yes, AEs parallel to the view will be 

displayed while creating a new view.
yes, no yes

Without category auto_update_default_dwg_mo
del

Automatically update the default drawing model to 
one shown in a view on the current sheet.

yes, no yes

Without category backup_reference_information Yes-Backup the reference information of a feature 
once the feature regenerates successfully. No- Do 
not save the reference information of a feature.

yes, no yes

Without category bmx_param_restrictions Restricted parameters automatically violate 
constraints in any Design Study

yes, no yes

Without category check_udf_int_key Yes - updates UDF internal keys upon group's 
retrieval. No - skips keys update.

yes, no yes

Without category collect_dims_in_active_layer This config options allows dimensions to be 
collected on the active layer.

yes, no yes

Without category combined_views_customizatio
n

Enable / Disable combined views customization. yes, no yes

Without category comp_assemble_with_interfac
e

Settings for assembling component with 
interface(s).

none, default_multi, default_single, 
from_list

default_multi

Without category comp_interface_placement Sets the default interface placement type. Interface 
to geometry - place the component using 
component interfaces and assembly geometry. 
Interface to Interface - place the component using 
assembly and component interfaces.

interface_to_interface, interface_to_geom interface_to_interface

Without category comp_normal_offset_eps Specifies the angle epsilon such that if the desired 
surfaces are equal or less than the epsilon (in 
degrees), then a normal constraint will be created.

10

Without category comp_placement_legacy_mov
e

Show the legacy Move tab in the Component 
Placement dashboard

yes, no yes

Without category comp_snap_angle_tolerance Specify the angle tolerance for snapping while 
freeform dragging components. Default value is 
30.0 degrees.

30

Without category comp_snap_dist_tolerance Specify the distance tolerance for snapping while 
freeform dragging components.  Default value is 0.1 
(relative to size of component being assembled).

0.1
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Category Name Description Values Default Value
Without category confirm_on_edit_foreign_mode

ls
Provides a confirmation dialog when attempting to 
make design changes to foreign models

yes, no no

Without category constraint_reference_redefine keep_constraint_type - Adjusts the component 
position to keep the same constraint type. 
reset_constraint_type - Automatically changes the 
constraint type to keep the position of the 
component.

keep_constraint_type, 
reset_constraint_type

keep_constraint_type

Without category contact_surfaces_gap Sets the maximum allowable gap between weld 
contact surfaces.

0

Without category convert_to_wf3_replace Convert to Wildfire3 replace functionality. yes, no no
Without category cosmetic_thread_match_tolera

nce
Sets the tolerance, which is used in the analysis to 
match standard thread type and standard radius, to 
the selected thread surface.

0.001

Without category create_drw_sheet_thumbnails Controls whether thumbnail images of drawing 
sheets will be generated and displayed with the 
drawing sheet tabs.  Setting this option to No may 
improve performance with large drawings.

yes, no yes

Without category creotkdat Specify the full path to an additional Toolkit registry 
file.

Without category default_cable_axis_location Sets the location type for axis. Choose Along to 
create one location at each end of the axis.

on, along on

Without category default_geom_analysis_type Default save type for geometry analysis. quick, saved, feature quick
Without category default_ref_current_module_vr

nt
Allow references to current design solution only. yes, no yes

Without category des_exp_folder Sets the directory for the Design Exploration 
session. The default location is in a default system 
folder. Type a valid file path to change the directory 
to a user defined one.

Without category designate_model_item_param
s

When an object is designated, all parameters 
belonging to that object will be automatically 
designated as well.

yes, no no

Without category disp_in_open_rep_create Simplified Rep to display initially in Open Rep 
Create: "No" for none, "Yes" for graphics rep, or 
"Default Rep" to display the rep indicated by option 
"open_simplified_rep_by_default".

yes, no, default rep no

Without category display_all_dims Controls the display of dimensions during dynamic 
edit.

yes, no yes
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Category Name Description Values Default Value
Without category display_combined_views Display combined view tabs by default yes, no no
Without category display_images Yes - Display images added to the model. No - Do 

not display images.
yes, no yes

Without category display_mapkeys_dialog_on_to
p

Controls whether mapkeys dialog will be displayed 
always on top (yes) or behind the main window (no).

yes, no no

Without category display_pdm_server_quick_vie
w

Yes - display summary view of PDM information for 
items in session. It applies to ProductPoint only.

yes, no yes

Without category display_popup_viewer No- disable popup viewer, File_Open_Only: display 
popup viewer only in the file open dialog, Yes: 
display popup viewer in file open dialog, model tree 
and in Server Quick View dialog

yes, no, file_open_only file_open_only

Without category display_sketch_dims Controls the display of sketch dimensions during 
dynamic edit.

yes, no yes

Without category dm_enable_simple_import_exp
ort

Enable a simplified method of import/export 
between disk and Workspace.

yes, no yes

Without category dm_nc_process Sets output of NC process information as content 
on the NC Assembly CAD Document in XML 
Format. Yes  - Outputs the file whenever CAD 
Document is Saved. No - Does not output the file.

yes, no no

Without category dm_preview_searches_server Search for files on the server while previewing. yes, no yes

Without category drilling_ui_diam_mode Enables the diameter selection mode by default. yes, no yes

Without category drilling_ui_end_opt_default Defines default end option for holemaking 
sequences. "AUTO" - end is determined 
automatically, "REFERENCE" - end is determined 
by the selected reference, "DEPTH" - end is 
determined by the specified depth, "THROUGH" - 
machine through the part.

auto, through, reference, depth auto

Without category drilling_ui_start_opt_default Defines default start option for holemaking 
sequences. "AUTO" - start is determined 
automatically, "REFERENCE" - start is determined 
by the selected reference.

auto, reference auto

Without category drw_prompt_for_combined_sta
te

Determines whether the combined state prompt will 
appear in a drawing when creating a view.

yes, no yes
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Category Name Description Values Default Value
Without category dwg_unicode_conv_lang_scop

e
Specifies scope of the option 
'dwg_unicode_conversion_language'. '2D' to apply 
to 2D models only, 'ALL' to apply to all models.

all, 2d 2d

Without category edge_tess_quality Set the accuracy level for arc tessellation. high, medium, low low
Without category enable_3dmodelspace_browse

r_tab
Yes - Display 3D ModelSpace tab in the browser 
when Creo starts. No - Display 3D ModelSpace tab 
only when you click a 3D ModelSpace link in the 
navigator.

yes, no yes

Without category enable_face_preselection Controls the ability to "pre-select" faces/datums as 
an entry to Sketch based features such as Extrude, 
Revolve (input to the internal sketch).

yes, no yes

Without category enable_fsaa Enable OpenGL full screen anti-aliasing. off, 2, 4, 8, 16, 32 off
Without category enable_obsoleted_features yes, no no
Without category enable_offset_fan_curve Enables fan curve option for offset tool. yes, no no
Without category enable_opengl_shader Enable OpenGL Phong lighting. yes, no yes
Without category enable_partcommunity_tab Yes - Display PartCommunity tab in the browser. No 

- Do not display the tab.
yes, no yes

Without category esr_mass_properties Defines whether to include all immediate 
components of external simplified rep  into Mass 
Properties calculations or only defined state of 
design assembly.

design_only, extended design_only

Without category expand_all_with_nested_layers Yes - expand all including nested sub layers. yes, no yes

Without category fasthlr_drawing Specifies whether fast hidden line removal is on/off 
by default.

yes, no no

Without category file_dialog_units_class Sets the units for manikin attributes displayed in the 
File Open dialog.

mks, ips mks

Without category file_timestamp_format Controls the format of time stamps in file dialogs 
and the folder browser. The format for the setting is 
a string consisting of up to seven portions: the year, 
the month, and the date, the hours, minutes, 
seconds and am/pm designator. You can enter the 
portions in any order.

%dd-%mmm-%yy 
%hh:%mi:%ss %pm
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Category Name Description Values Default Value
Without category flex_dma_reduce_solution_nu

mber
Reduces the number of default solutions found in 
Flexible Modeling features, when modifying 
geometry with mixed convexity contours.

yes, no yes

Without category flex_tan_propagation_default Defines default state of the Tangency Propagation 
option in Flexible Modeling features.

off, on off

Without category group_repl_with_recycle Yes - enables new UDF replacement with family 
table instances that prevents children failures. No - 
UDF replacement will work in the same manner as 
Wildfire 3.0 and earlier releases.

yes, no yes

Without category group_replace_rename Yes - updates replaced group name with 
replacement group name. No - preserves existing 
name of the group being replaced if it is a user-
given name.

yes, no yes

Without category hdic_export_v5_secondary_cgr In HDIC export for CATIA V5 allows to attach CGR 
as a secondary content

yes, no no

Without category hdic_export_v5_to_ws_enable Enables HDIC export for CATIA V5 to Workspace. yes, no no

Without category idd_repair_tangency Sets the default state of the "Repair Tangency" 
checkbox in the Repair and Match tools

yes, no no

Without category include_all_tools_in_list Show/hide inapplicable cutting tools in mfg 
sequence UI.

yes, no no

Without category intf3d_out_catia_v5_version Allows the user to switch between the default and 
alternate converter version for export to CATIA V5

16, 17, 18, 19, 20, 21, 22 16

Without category jlink_java_command Specifies a command to start JRE for J-Link. May 
contain arguments and environment variables. 
Overrides the default, see also jlink_java2.

Without category js_error_policy Control the display and execution of the java script 
error dialogs.  If the dialog is presented, the user 
can choose whether to stop or continue running the 
script.

show, suppress_continue, supress_stop

Without category keep_model_in_open_window Controls whether a model is displayed in its window 
when  the accessory window is open.

yes, no no

Without category last_session_directory_path Sets the directory that holds the temp files for the 
session recording mechanism.

<work_dir>\appdata\roaming\p
tc\proengineer\wildfire\.wf\.setti
ngs
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Category Name Description Values Default Value
Without category last_session_retrieval Yes - Activates recording mechanism that enables 

the session to be retrieved during the next session. 
No - The recording mechanism is not available and 
the session can not be retrieved.

yes, no yes

Without category layer_rule_retrieve_objects This option controls whether or not the system will 
retrieve additional objects needed to evaluate a 
layer rule. OK tells the system to retrieve the 
objects. Cancel stops evaluation of the rule.

ok, cancel, promt promt

Without category layout_data_sharing Allows to change the default ce entity type to be 
public or private.

private, public private

Without category layout_guides Enable/Disable layout guides. yes, no yes
Without category layout_precision_decimals Display 0 to 5 decimal places in precision panels 1, 3, 2, 4, 5 2

Without category layout_precision_panel Yes - Precision Panel will be shown; No - Precision 
Panel will not be shown.

yes, no yes

Without category layout_smart_constraints To improve the user experience, specific entity 
types are appropriately constrained by default (i.e. - 
fillets with tangency constraints). Yes - specific 
entity types will be created with appropriate 
constraints by default; No - constraints will never be 
automatically created for any entity type.

yes, no yes

Without category layout_symbol_inst_palette_file Specifies the location of the layout symbol instance 
palette. If you do not specify a directory, layout will 
use the same palette as Creo drawings. Use full 
path name to avoid problems.

Without category layout_template_dir Specifies the default directory for layout template 
files.  Use full pathname to avoid problems.

Without category lda_batch_mapping_option Specifies the options for mapping in LDA from 
dBatch.

all, model_only, views_only, 
annotations_only, model_and_views, 
views_and_annotations

all

Without category lda_map_file Path to the file containing the list of matching 
drawings and solid models.
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Category Name Description Values Default Value
Without category lda_model_dir Path to the directory containing the solid models.

Without category lda_overall_view_map_time_li
mit

Specifies LDA overall view mapping time limit in 
seconds.

300

Without category lda_prefix_in_basic_dim_box Add prefix to basic box while converting the 
dimension to basic.

yes, no no

Without category lda_show_entities_default Speicify whether to show mapped draft entities by 
default in Validate Association Dialog.

yes, no no

Without category lda_view_map_time_limit Specifies LDA single view mapping time limit in 
seconds.

60

Without category manikin_drag_auto_locks Manikin drag auto locks yes, no yes
Without category manikin_drag_legacy_rotate Controls the Manikin Rotate Around Axis drag 

mode: Legacy (YES) or direct joint angle control 
(NO)

yes, no no

Without category manikin_flexibility Sets the level of flexibility that is allowed when 
dragging a manikin. FULL - All Manikin segments 
are articulated.  NONE - Manikin is calculated as a 
single body. DEFAULT - Manikin finger segments 
are locked to a single body.

none, default, full default

Without category manikin_replace_keep_posture Controls whether a manikin's existing posture is 
applied to a replacement manikin.

yes, no yes

Without category mass_prop_load_from_file Controls whether to take into the account values 
from mass properties file.

by_request, always by_request

Without category measure_auto_replace_mode Automatically switches to Replace mode for the last 
reference in appropriate Measures (Distance, Angle, 
Transform)

yes, no no

Without category measure_dec_places This configuration option controls the number of 
digits after the decimal point. If value = -1, this 
configuration is ignored and measure_sig_figures is 
used

-1

Without category measure_dialog_expand Determines default look of measure dialog 
(expanded or collapsed)

yes, no no

Without category measure_ref_option_status Determine As Object (As Center et al.) checkbox 
option behavior in Measure Tool

default, all_on, all_off, keep_last default
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Category Name Description Values Default Value
Without category measure_show_feattab Controls initial display of the Feature tab in Measure 

Tool. Yes - feature tab is always displayed by 
default. No - feature tab state is saved for the 
duration of the session upon closing of the dialog.

yes, no yes

Without category mfg_paste_special_dep_defaul
t

Controls the default state of the following option in 
Paste Special dialog: "Make copies dependent on 
dimensions of originals". This configuration option 
has an effect only for manufacturing assemblies.

yes, no yes

Without category model_tree_font Specify font used in the Creo Model Tree. specify 
the comma-delimited variables in any order (italic 
bold, 24, times or 24, times, italic bold have the 
same effect). Any omitted variable uses the 
standard setting.

Without category modelcheck_dir Specifies path to the ModelCHECK configuration 
files.

Without category module_variant_cross_refs Allow references between design solutions in 
Module

yes, no no

Without category mp_analysis_default_source Specifies the default source for mass properties 
calculation via Analysis.

geometry, assigned, mp_source

Without category mp_calc_level Specifies the level of mass properties calculation. assembly_only, all_models assembly_only

Without category msr_regen_special_refs Force special reference regeneration for some 
types of analyses

yes, no yes

Without category multiple_skeletons_allowed Allows/restricts multiple skeleton. yes, no no
Without category new_ref_part_name_disabled Disallow redirecting data sharing feature missing 

reference model to a model with different name.
yes, no yes

Without category old_style_set_datum Yes - datum properties dialog has button for old-
style set datum. No - datum properties dialog does 
not have button for old-style set datum.

yes, no yes

Without category open_builder_in_mt_mode Open the variant builder in Model Tree Selection 
mode

yes, no no

Without category orientation_style Set spin orientation style to dynamic or anchored. anchored, dynamic dynamic

Without category pdm_server_quickview_rows_n
um

Sets the default number of rows for the pdm quick 
view list.

7
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Category Name Description Values Default Value
Without category plot_names_with_sheet Yes - Plot file names are appended with _(sheet 

number) before file extension.
yes, no no

Without category popup_refpairintch_window Bring forward the window being used with the 
reference pairing table.

yes, no no

Without category prime_analysis_directory Sets the default directory for the Prime files to be 
used for Prime analysis calculations. Use the full 
pathname to avoid problems.

Without category prime_automapping Toggles Prime analysis automapping of variables yes, no no

Without category propagate_by_default Yes - If the modified geometry belongs to a 
geometry pattern, a pattern recognition feature or a 
symmetry recognition feature, the modification is 
automatically propagated to all pattern/symmetry 
members.

yes, no no

Without category ptc_manikin_comforts_path Sets the default directory for the Creo manikin 
comfort angles. You must restart Creo for the 
change to take effect.

Without category ptc_manikin_library_path Sets the default directory for the Creo manikin 
library (or custom manikin libraries you built 
containing the proper index menu files). Use the full 
path name to avoid problems.  You must restart 
Creo for the change to take effect.

<creo_loadpoint>\manikin_lite\

Without category ptc_manikin_posture_path Sets the default directory for the Creo manikin 
postures (or custom posture libraries you built). Use 
the full path name to avoid problems.  You must 
restart Creo for the change to take effect.

Without category qty_balloon_change_warning Sets the warning style when quantity balloons have 
changed in a drawing.  Dialog displays the warning 
in a dialog box, Message displays the warning in the 
message area only.

dialog, message dialog

Without category quick_print_drawing_template Specify the path and name of a drawing template to 
be used by the File > Quick Print command.

Without category quick_print_plotter_config_file Specify the path and name of the default plotter 
config file to be used by the File > Quick Drawing 
command.

Without category radial_hole_linear_dim YES - Option for creation of radial hole with a linear 
dimension will be available.

yes, no no
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Category Name Description Values Default Value
Without category record_mapkey_comment_to_t

rail
Controls whether a comment is written to the trail 
file whenever a mapkey is executed.

yes, no yes

Without category regen_failure_handling Specifies whether to enter resolve mode when 
regeneration failures occur.  Resolve_mode - Enter 
resolve mode when regeneration failures occur. 
No_resolve_mode - Don't enter resolve mode when 
regeneration failures occur.

resolve_mode, no_resolve_mode no_resolve_mode

Without category regen_int_mdls_on_retr Yes to regen models intersected with assem feats 
during assembly retrieval.

yes, no no

Without category regen_solid_before_save Controls whether to regenerate top model,  or 
promot user before regeneration if it is required

yes, no, prompt prompt

Without category relations_ang_eval_diff_check Check for differences in the evaluation of relation 
sets evaluated and saved in versions of Creo 2.0 
prior to M110. Warn_message Check and give a 
warning in the message area.  Warn_dialog  Check 
and give a warning in a message window. Ignore  
Skip the check and warning.

ignore, warn_message, warn_dialog warn_message

Without category relations_num_const_units Specifies whether diagnostic should be issued when 
an unitless numeric value causes relation 
expression evaluation trouble.

yes, no no

Without category relations_units_sensitive Set the default unit sensitivity (ignore or take into 
account parameter/dimensions units) in creation of 
new relation data (legacy relation data will not be 
unit sensitive until "converted" to one).

yes, no yes

Without category remember_last_attach_type Yes - Sets the default of the ATTACH TYPE menu 
of the last options picked.

yes, no yes

Without category remember_replaced_compone
nts

Set to "Yes" this option will preserve a dependency 
to the replaced, outgoing, component. Set to "No" 
the dependency will, when possible, be removed.

yes, no yes

Without category replace_comp_notes_method Specify treatment of notes when components are 
replaced. Transfer - transfer to new component. 
Remove - remove the notes. Preserve - save notes 
in case component is restored.

transfer, remove, preserve transfer

Without category reroute_affected_children Affected children when setting Current solution. none, auto, selective selective
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Category Name Description Values Default Value
Without category restricted_val_definition Specify name and path of the file contained 

restricted values definition.
Without category retrieve_display Controls whether or not graphics data is loaded in 

the background.
background, foreground background

Without category retrieve_merge_ref_parts Automatic reference parts retrieval for dependent 
Merge.

yes, no, ignore_missing no

Without category rmv_xsec_unlinked_cosm_feat
s

Specify whether to automatically try to delete, or to 
detach from the feature list, the internal sketch 
features which were unlinked from offset cross 
sections, and whether to do it only upon sketch 
unlinking, or upon model retrieval too.

none, detach_on_unlink, delete_on_unlink, 
detach_on_both, delete_on_both

detach_on_unlink

Without category round_prewf5_displayed_dim_
val

Rounds the displayed value round all, round none, calculated calculated

Without category save_view_states_method Setup the method used on saving view states 
changes.

prompt, save changes, discard changes prompt

Without category shade_with_edge_tangent Display Tangent edges in Shade with Edge view 
mode.

yes, no yes

Without category show_affected_children_dialog Do not invoke dialog for setting Current solution. yes, no yes

Without category show_axes_by_view_scope Determines the scope of the Show Model 
Annotations tool when showing model datums and 
selecting a drawing view. For large assembly 
drawings, use top_model_only to improve 
performance by restricting the set of axes to be 
shown.

top_model_only, all_sub_models top_model_only

Without category show_description_view_mgr Yes - show a column for Description field for all tabs 
in view manager.

yes, no no

Without category show_object_type_in_taskbar Yes - Displays the icon of the open PTC Creo object 
in the taskbar and window title bar. For all PTC Creo 
applications except PTC Creo Parametric, icons 
include a letter indicating the application name. No - 
Displays the PTC Creo application icon in the 
taskbar and window title bar.

yes, no no

Without category show_sketch_dims_in_feature Sets the default display state of internal sketch 
dimensions in the feature definition environment.

yes, no no
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Category Name Description Values Default Value
Without category simprep_column_display Controls display of Simplified Representations 

columns in Model Tree,  'Automatic'-'Current Rep' 
column is shown automatically when a rep is 
activated, 'Manual' visibility of the  column is fully 
controlled by user, pre-Wildfire 6 behavior.

automatic, manual automatic

Without category simprep_column_format Specifies simplified representation model tree 
column format.

names only, icons only, icons and names icons and names

Without category simprep_default_cnfg_asm Retrieves a CSA model in a specified 
representation. Yes - uses Open Rep dialog. No - 
retrieves the Master representation. Specified Name 
- retrieves the model in the specified representation 
name if it exists or the Default representation.

last stored

Without category simprep_ondemand_activation Enables retrieving on-demand the Master rep of  an 
activated model. When an assembly is activated  
the Assembly only rep is retrieved.

yes, no yes

Without category simprep_ondemand_cleanup Determines if a model retrieved on demand  should 
be removed or erased.  Disabled - the model will not 
be removed  and will remain in the assembly.  
Removed - the model will be removed. 
Remove_Erase - The model will be removed  and 
erased from memory.

disable, restore, restore_and_erase restore

Without category simprep_ondemand_editing Enables on demand retrieval of an edited item and 
its parent references.  Configuration tools (Family 
Tables, Relations, etc) will retrieve  required models 
accordingly.  Automatic - Retrieves the minimum 
rep required to perform the operation.

automatic, master, disable, 
master_with_ancestors

automatic

Without category simprep_ondemand_regenerati
on

Enables on demand retrieval of required  models 
during regeneration.  Can affect regeneration 
performance.

automatic, master, disable automatic

Without category single_side_surf_color Allow application of color to a single side of a 
surface.

yes, no no

Without category sketcher_curve_color_synch Synchronize color assignment between sketched 
curves and their sketches.

yes, no yes

Without category sketcher_palette_path Sets the default directory for the user sketcher 
shape library. Use the full path name to avoid 
problems.
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Category Name Description Values Default Value
Without category sketcher_rel_accuracy Enter a sketcher relative accuracy. 1
Without category sketcher_strngthn_to_def_dec

_pl
This option enable the user to keep a highly precise 
value during creation or convertion strong 
dimension.

yes, no yes

Without category snap_single_constraints When dynamically dragging components during 
component placement, allow to snap to references 
one constraint at a time.

yes, no yes

Without category spin_with_orientation_center Display orientation center while reorienting. yes, no yes
Without category style_state_transparency Set the value of transparency for components set to 

"Transparent" in style state.  Value must be between 
0 and 100.

70

Without category suppress_dim_ghost_with_ctrl Suppress the ghost image of dimension when CTRL 
is pressed. It allows better visibility while selecting 
further dimension references.

yes, no no

Without category template_cnfg_asm Specifies the default configurable assembly 
template file.  Use full pathname to avoid problems.

inlbs_csa.asm

Without category template_esrasm Specifies the designated template ESR assembly. 
Use full path to avoid problems.

inlbs_asm_esr.asm

Without category template_layout Specifies the default layout template file.  Use full 
pathname to avoid problems.

Without category tk_enable_ribbon_custom_sav
e

Enable storing the Auxiliary Application User 
Interface customization

yes, no no

Without category tool_mgr_save_pocket_in_xml Determines whether the tool position should be 
saved in a XML file (*.txf) created in tool manager 
dialog.

yes, no yes

Without category travel_bounds_display Enable travel bounds display. yes, no no
Without category travel_bounds_transparency Transparency value for machine bound display. 0.8
Without category trngrv_roundtool_nobackcut Yes - Groove turning using round tool generates no 

back cut motion for profile pass.
yes, no no

Without category upd_param_on_retr_mark_mo
dified

Allows/disallows mark model as changed if as a 
result of mass properties/relations calculation during 
retrieval some parameter values are changed.

yes, no no

Without category use_master_for_bad_disp_rep
s

Yes to retrieve master rep when graphics rep has 
no display data.

yes, no no
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Category Name Description Values Default Value
Without category use_strict_ui_trail Perform extra validation of user interface actions 

when playing back trail files.
yes, no yes

Without category use_temp_interface_for_paste Yes - Enables use of interfaces for multiple 
placement of components during paste.

yes, no yes

Without category use_web_page_font_in_report
s

Controls whether HTML reports use the browser's 
standard fonts.

yes, no no

Without category visible_recent_files Number of visible recent files. The possible range is 
1 - 30.

21

Without category web_enable_javascript Enables or disables Pro/Web.Link in the embedded 
browser.

off, on off

Without category web_max_mail_size Set the maximum email attachment size in 
kilobytes.

5000

Without category weld_fillet_preferences_file Sets the path and name of the fillet weld 
preferences file.

Without category weld_general_preferences_file Sets the path and name of the general weld 
preferences file.

Without category weld_groove_preferences_file Sets the path and name of the groove weld 
preferences file.

Without category weld_plug_slot_preferences_fil
e

Sets the path and name of the plug/slot weld 
preferences file.

Without category weld_spot_preferences_file Sets the path and name of the spot weld 
preferences file.
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Category Name Status Description Values Default Value
Application 
Programming 
Interfaces

web_link_proe_read CHANGED Sets Pro/Web.Link permission to read data from a Creo 
Parametric session.
----------
Sets Pro/Web.Link permission to read data from a Creo 
session.

yes, no no

Application 
Programming 
Interfaces

web_link_proe_write CHANGED Sets Pro/Web.Link permission to modify data in a Creo 
Parametric session.
----------
Sets Pro/Web.Link permission to modify data in a Creo session.

yes, no no

Assembly allow_freeze_failed_assy
_comp

NEW Allow freezing failed assembly components. yes, no no

Assembly auto_backup_new_place
mnt_refs

DELETED Yes - Create Component Reference Backup, No - Do not 
Create Component Reference Backup.

yes, no no

Assembly copy_geom_update_pre_
2000i_dep

CHANGED Yes - Flags independent copy geom features in a pre-2000i 
model as modified when retrieved into Creo Parametric. Save 
the model immediately to update the model's copy geom 
dependency information.
----------
Yes - Flags independent copy geom features in a pre-2000i 
model as modified when retrieved into Creo. Save the model 
immediately to update the model's copy geom dependency 
information.

yes, no

Assembly dim_inactive_component
s

CHANGED Display inactive assembly components with stippled 
transparency and default color (grey). Default value is 
shade_only.
----------
Display inactive assembly components using phantom 
transparency and default color (grey). Default value is 
shade_only.

never, always, 
shaded_only

shaded_only

Assembly freeze_failed_assy_comp DELETED No - Requires an action to fix the assembly or freeze the 
component that fails retrieval. Yes - Freezes any component 
failing retrieval at its last known assembly location.

yes, no no
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Category Name Status Description Values Default Value
Assembly mtrl_convert_units CHANGED If set to "Yes" Creo Parametric will automatically convert units in 

materials from a library to the model system of units.
----------
If set to "Yes" Creo will automatically convert units in materials 
from a library to the model system of units.

yes, no yes

Assembly skeleton_model_default_
color

CHANGED Specifies the color Creo Parametric uses to display new 
skeleton models. The three decimal values ranging from 0 
through 100 specify (in order) the percentages of red, green, 
and blue in the resulting color. For example, 0 0 49 specifies 
medium blue.
----------
Specifies the color Creo uses to display new skeleton models. 
The three decimal values ranging from 0 through 100 specify (in 
order) the percentages of red, green, and blue in the resulting 
color. For example, 0 0 49 specifies medium blue.

0.000000 75.000000 100.000000

Creo Simulate sim_hyperelastic_materia
l_fit

CHANGED Sets the default method for calculating coefficients for 
hyperelastic materials. If set to "normalized", normalized 
stresses will be used. If set to "non-normalized", non-normalized 
stresses will be used.)
----------
Sets the default method for calculating coefficients for 
hyperelastic materials. If set to "normalized", normalized 
stresses will be used. If set to "non-normalized", non-normalized 
stresses will be used.

normalized, non-
normalized

normalized

Data Exchange afx_enabled CHANGED Loads EFX application.
----------
Loads AFX application.

yes, no no
----------
yes

Data Exchange atb_show_foreign_name NEW Displays foreign source model name in the model tree for 
imported models.

yes, no yes

Data Exchange auto_associate_dimensio
ns

CHANGED If set to yes, Creo Parametric will attempt to take imported 
dimensions that are not associative and link them to geometric 
entities so that they act as associative.
----------
If set to yes, Creo will attempt to take imported dimensions that 
are not associative and link them to geometric entities so that 
they act as associative.

yes, no no
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Category Name Status Description Values Default Value
Data Exchange board_bend_notes_dflt_d

isplay
NEW Define the default state of bend note display (board mode) yes, no yes

Data Exchange board_bend_notes_direct
ion_down

NEW Defines the down direction symbol for board bend notes. default

Data Exchange board_bend_notes_direct
ion_up

NEW Defines the up direction symbol for board bend notes.

Data Exchange board_bend_notes_order NEW Defines the fields order for board bend notes. &type&direction&angle

Data Exchange board_bend_notes_type_
formed

NEW Defines the formed symbol for board bend notes. default

Data Exchange board_bend_notes_type_
rolled

NEW Defines the rolled symbol for board bend notes. default

Data Exchange board_bend_table_direct
ory

NEW Will be used to set the bend allowance table only. Sets the 
default directory of the board bend allowance table files. If not 
set,  the system supplied bend tables are used. Use the full 
name and  path to avoid problems.

Data Exchange board_design_rules_dire
ctory

NEW Will be used to set the design rules file folder only. Will be used  
by the design rules manager. Sets the default directory of the  
board design rules files. Use the full name and path to avoid 
problems.

Data Exchange board_drive_bend_by_pa
rameters

NEW Board bend radius and bend angle values and bend  dimension 
location will be driven by feature-level  relations to board 
parameters.

yes, no no

Data Exchange board_drive_tools_by_pa
rameters

NEW Drives the board options and values by feature-level  relations 
to board parameters.

yes, no yes

Data Exchange board_flange_shape_ske
tches_dir

NEW Sets path to directory that contains the Flange shapes.

Data Exchange board_flat_shape_sketch
es_dir

NEW Sets path to directory that contains the Flat shapes.

Data Exchange board_parameters_direct
ory

NEW Specifies the directory to save/retrieve board parameters files. 
Use full name and path to avoid problems.

Data Exchange dwg_export_format CHANGED Provides the ability to choose DWG file version when exporting 
from Creo Parametric drawing.
----------
Provides the ability to choose DWG file version when exporting 
from Creo drawing.

14, 2000, 2004, 2007, 
2010
----------
14, 2000, 2004, 2007, 
2010, 2013

2007
----------
2013
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Category Name Status Description Values Default Value
Data Exchange dxf_block_to_pro_symbol CHANGED Specifies whether or not DXF BLOCKS to be imported as Creo 

Parametric symbols. Yes - Imports BLOCKS as symbol 
definitions, No - Imports BLOCKS as separate entities.
----------
Specifies whether or not DXF BLOCKS to be imported as Creo 
symbols. Yes - Imports BLOCKS as symbol definitions, No - 
Imports BLOCKS as separate entities.

yes, no no

Data Exchange dxf_export_format CHANGED Provides the ability to choose DXF file version when exporting 
from Creo Parametric drawing.
----------
Provides the ability to choose DXF file version when exporting 
from Creo drawing.

12, 13, 14, 2000, 2004, 
2007, 2010
----------
12, 13, 14, 2000, 2004, 
2007, 2010, 2013

2007
----------
2013

Data Exchange dxf_in_proxy_entity DELETED Controls the input support for ACAD_PROXY_ENTITY. yes, no yes
Data Exchange dxf_out_comments CHANGED YES - comments (999 group codes) will be created in DXF file 

exported from Creo Parametric. NO - DXF file will be created 
without comment lines.
----------
YES - comments (999 group codes) will be created in DXF file 
exported from Creo. NO - DXF file will be created without 
comment lines.

yes, no yes

Data Exchange ecad_create_hint_add CHANGED Assists in creation of an ecad_hint.map file. Yes - Automatically 
renames components, if necessary, each time library of 
component outlines is imported to Creo Parametric. This does 
not create an ecad_hint.map file. It controls if ecad_hint.add is 
created.
----------
Assists in creation of an ecad_hint.map file. Yes - Automatically 
renames components, if necessary, each time library of 
component outlines is imported to Creo. This does not create 
an ecad_hint.map file. It controls if ecad_hint.add is created.

yes, no yes

Data Exchange ecad_edmd_out_version CHANGED Set the EDMD output version. 2.0, 1.2
----------
2.0, 1.2, 3.0

2

Data Exchange ecad_export_cuts_as_ho
les

CHANGED Exports Creo Parametric cuts as holes to ECAD systems.
----------
Exports Creo cuts as holes to ECAD systems.

yes, no yes



Creo 2.0 to PTC Creo 3.0 Parametric Configuration Options Changes

PTC Inc. 124 Creo 2.0 to PTC Creo 3.0 Parametric Configuration Options Changes

Category Name Status Description Values Default Value
Data Exchange ecad_export_holes_as_c

uts
CHANGED Exports Creo Parametric holes as cuts to ECAD systems.

----------
Exports Creo holes as cuts to ECAD systems.

yes, no no

Data Exchange ecad_import_holes_as_f
eatures

CHANGED Import sections specified as DRILLED_HOLE as through-all 
holes. Boards created with Creo Parametric drilled holes export 
with default value of NPTH for the ECAD_HOLE_TYPE 
parameter. Create this feature parameter if a value of PTH is 
needed (IDF 2.0/3.0).
----------
Import sections specified as DRILLED_HOLE as through-all 
holes. Boards created with Creo drilled holes export with default 
value of NPTH for the ECAD_HOLE_TYPE parameter. Create 
this feature parameter if a value of PTH is needed (IDF 2.0/3.0).

yes, no yes

Data Exchange ecad_outline_ents_enha
nced_exp

CHANGED Enhanced export of special entities to ECAD formats. Yes - 
Attempt to approximate arcs and lines. No - Use part accuracy 
to approximate lines.

yes, no no
----------
yes

Data Exchange ecadcollab_accept_color NEW ECAD Collaboration Accept color 0.0 255.0 0.0

Data Exchange ecadcollab_auto_redef_a
reas

NEW Automatically redefine ECAD Areas affected by collaboration 
changes

yes, no yes

Data Exchange ecadcollab_auto_redef_c
omps

NEW Automatically redefine components affected by collaboration 
changes

yes, no yes

Data Exchange ecadcollab_auto_redef_h
oles

NEW Automatically redefine holes affected by collaboration changes yes, no yes

Data Exchange ecadcollab_preview_after
_color

NEW ECAD Collaboration Preview After color 255.0 127.0 0.0

Data Exchange ecadcollab_preview_befo
re_color

NEW ECAD Collaboration Preview Before color 0.0 76.0 255.0

Data Exchange ecadcollab_preview_level NEW ECAD Collaboration preview Level full, partial, light partial

Data Exchange ecadcollab_reject_color NEW ECAD Collaboration Reject color 255.0 127.0 127.0
Data Exchange ecadcollab_scan_des_on

_area_chg
NEW Check for affected objects resulting from ECAD Areas 

collaboration changes
yes, no yes

Data Exchange ecadcollab_scan_des_on
_brd_chg

NEW Check for affected objects resulting from board collaboration 
changes

yes, no yes

Data Exchange ecadcollab_scan_des_on
_comp_chg

NEW Check for affected objects resulting from components 
collaboration changes

yes, no yes
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Data Exchange ecadcollab_scan_des_on

_hole_chg
NEW Check for affected objects resulting from holes collaboration 

changes
yes, no yes

Data Exchange ecadcollab_supp_failed_f
eats

NEW Suppress of failed features on Object changes yes, no yes

Data Exchange ecadcollab_suppress_cut
s

NEW Automatically suppress cut features in case of board 
collaboration changes

yes, no yes

Data Exchange export_3d_force_default_
naming

CHANGED Specify whether the Creo Parametric model names should be 
used for STEP export. Yes - Use default naming. No - Add 
suffixes to model file names.
----------
Specify whether the Creo model names should be used for 
STEP export. Yes - Use default naming. No - Add suffixes to 
model file names.

yes, no no

Data Exchange fix_imported_set_view_or
ient

DELETED Sets viewing characteristics for imported CATIA SET files. Yes - 
Files can have translated views. No - Files cannot have 
translated views.

yes, no no

Data Exchange initial_board_bend_y_fact
or

NEW Specifies a value used to determine the neutral bend line for a 
board part. This value is always used for non-cylindrical bends. 
It is used for regular bends only when no bend table is specified

0.5

Data Exchange intf_ignore_suffix_in_pvz CHANGED YES- the document type as suffix will not be appended to the 
part name in Creo View name during Save As to Workspace 
operation
----------
YES- the document type as suffix will not be appended to the 
part name in Creo View name during Save As to Workspace 
operation.

yes, no no

Data Exchange intf_in_granite_direct_en
able

CHANGED Allows the user to switch back to the old 'Import Feature' 
method of reading Desktop .des files and Granite .g files into 
Creo Parametric. By default, Creo Parametric directly opens 
these models.
----------
Allows the user to switch back to the old 'Import Feature' 
method of reading Desktop .des files and Granite .g files into 
Creo. By default, Creo directly opens these models.

yes, no yes
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Category Name Status Description Values Default Value
Data Exchange intf_out_assign_names CHANGED Controls how entity names are handled when an object is 

exported to STEP format from part or assembly mode. You can 
give unique names to Creo Parametric datum points, datum 
axes, datum curves, surfaces, edges, and quilts.
----------
Controls how entity names are handled when an object is 
exported to STEP format from part or assembly mode. You can 
give unique names to Creo datum points, datum axes, datum 
curves, surfaces, edges, and quilts.

no_name, user_name, 
id_name

no_name

Data Exchange intf_ug_version DELETED Sets the version of Unigraphics interface. nx6, nx7, nx8 nx6
Data Exchange intf2d_fit_incompatible_d

ata
CHANGED YES - For import and export, fixes compatibility problems 

between 2-D external formats (such as IGES and DXF) and 
Creo Parametric.
----------
YES - For import and export, fixes compatibility problems 
between 2-D external formats (such as IGES and DXF) and 
Creo.

yes, no no

Data Exchange intf2d_in_acad_expl_uns
upp_ents

NEW Yes - ACAD_PROXY_ENTITY and REGION entities are 
imported as set of draft entities, No - ACAD_PROXY_ENTITY 
and REGION entities are ignored.

yes, no yes

Data Exchange intf2d_in_mi_brk_unsupp
_dim

NEW Yes - Breaks unsupported MI dimension types to separate 
entities, No - Imports unsupported MI dimension types as 
different type dimensions that can look differently.

yes, no no

Data Exchange intf2d_in_mi_lay_parts NEW Yes - Maps MI drafting parts to layers, No - Imports MI drafting 
parts as separate entities.

yes, no yes

Data Exchange intf2d_in_mi_sym_parts NEW Yes - Maps MI symbol parts to symbols, No - Imports MI symbol 
parts as separate entities.

yes, no yes

Data Exchange intf2d_in_mi_view_parts NEW Yes - Maps MI annotation views to 2D views, No - Imports MI 
annotation views as separate entities.

yes, no yes

Data Exchange intf2d_in_std_clrs_as_us
er_def

CHANGED Yes - standard colors are imported as user-defined colors. No - 
standard colors are mapped to Creo Parametric colors.
----------
Yes - standard colors are imported as user-defined colors. No - 
standard colors are mapped to Creo colors.

yes, no yes
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Data Exchange intf2d_out_cgm_ver CHANGED Provides the ability to choose CGM metafile version when 

exporting from Creo Parametric drawing.
----------
Provides the ability to choose CGM metafile version when 
exporting from Creo drawing.

1, 3 1

Data Exchange intf2d_out_quilt_hl_priorit
y

NEW QUILT - quilt lines have higher priority than hidden lines when 
exporting or plotting a drawing. HIDDEN_LINE - hidden lines 
have higher priority than quilt lines.

quilt, hidden_line quilt

Data Exchange intf3d_out_surface_devia
tion

CHANGED Sets maximum allowable deviation between original and 
resulting surfaces in the process of converting Creo Parametric 
surfaces to spline surfaces. By setting this you convert surfaces 
with a better approximation than by using the current model 
accuracy.
----------
Sets maximum allowable deviation between original and 
resulting surfaces in the process of converting Creo surfaces to 
spline surfaces. By setting this you convert surfaces with a 
better approximation than by using the current model accuracy.

-1

Data Exchange pro_gplug_dir CHANGED Specifies the directory in which Granite application plug-ins are 
located. Use the full pathname to avoid problems.

<creo2.0_loadpoint>\x86e_win64\
gplugs\
----------
<creo3.0_loadpoint>\x86e_win64\
gplugs\

Data Exchange pro_stheno_command DELETED Specifies the command for Stheno launch.
Data Exchange use_export_2d_dialog CHANGED Yes - Opens export options dialog when exporting Creo 

Parametric drawing. No - exports file without the options dialog.
----------
Yes - Opens export options dialog when exporting Creo 
drawing. No - exports file without the options dialog.

yes, no yes
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Category Name Status Description Values Default Value
Data Exchange use_iges_kanji_font_200

1
CHANGED Specifies whether to convert Kanji notes in Creo Parametric to 

IGES Kanji notes (font code) when exporting. Yes - Converts 
Kanji notes to IGES Kanji notes. No - Converts using Font 1.
----------
Specifies whether to convert Kanji notes in Creo to IGES Kanji 
notes (font code) when exporting. Yes - Converts Kanji notes to 
IGES Kanji notes. No - Converts using Font 1.

yes, no no

Data Exchange vrml_background_color CHANGED Yes - Exports a model to VRML with the Creo Parametric 
background color.
----------
Yes - Exports a model to VRML with the Creo background 
color.

yes, no no

Data Management dm_cache_limit CHANGED Enter amount of disk space (in megabytes) to allocate for local 
file storage. The change to the existing setting will take effect 
after Creo Parametric is restarted
----------
Enter amount of disk space (in megabytes) to allocate for local 
file storage. The change to the existing setting will take effect 
after Creo is restarted.

Data Management dm_cache_mode CHANGED Indicate which objects will be written to local cache when 
objects in Creo Parametric memory are saved.
----------
Indicate which objects will be written to local cache when 
objects in Creo memory are saved.

all, none, modified all

Data Management dm_fallback_server_locat
ion

CHANGED Specifies the server location where objects will be saved when 
Creo Parametric does not provide an ability to specify the target 
save location. This option is applicable for Windchill 
ProductPoint only.
----------
Specifies the server location where objects will be saved when 
Creo does not provide an ability to specify the target save 
location. This option is applicable for Windchill ProductPoint 
only.
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Data Management dm_hide_virtual_default_

ws
NEW Yes - When there is at least one workspace created in any 

context in selected server, default workspaces that were never 
used, will not be listed. No - (Default value) Default workspaces 
will be listed for each context that has no workspace defined.

yes, no no

Data Management dm_remember_server CHANGED Primary server/workspace must be set by user for each Creo 
Parametric session.
----------
Primary server/workspace must be set by user for each Creo 
session.

yes, no yes

Data Management dm_save_as_attachment CHANGED Controls the default option for Save A Copy when models are 
saved as in non-Creo Parametric format. Yes - It will by default 
save it as secondary content attachment to the original CAD 
Document. No- It will by default save it as Primary CAD 
Document
----------
Controls the default option for Save A Copy when models are 
saved as in non-Creo format. Yes - It will by default save it as 
secondary content attachment to the original CAD Document. 
No- It will by default save it as Primary CAD Document.

yes, no yes

Data Management dm_secondary_upload CHANGED Indicate when modified Creo Parametric objects on a secondary 
server will be moved from the local cache to the user's 
workspace on the server.
----------
Indicate when modified Creo objects on a secondary server will 
be moved from the local cache to the user's workspace on the 
server.

automatic, explicit automatic

Data Management dm_user_presence DELETED Enable user presence indicator and actions.  This capability 
requires a connection with a PDM server and requires an 
installed and running Microsoft communicator client.

yes, no yes

Data Management let_proe_rename_pdm_o
bjects

CHANGED Determines whether an object fetched from a PDM database 
can be renamed in a Creo Parametric session.
----------
Determines whether an object fetched from a PDM database 
can be renamed in a Creo session.

yes, no no
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Category Name Status Description Values Default Value
Data Management read_parameters_of_excl

uded
CHANGED Allow Creo Parametric designated parameters on excluded 

objects in Simplified Representation to be visible in Model Tree 
columns.
----------
Allow Creo designated parameters on excluded objects in 
Simplified Representation to be visible in Model Tree columns.

yes, no, 
common_name_only

no

Data Management regenerate_read_only_o
bjects

CHANGED Determines whether an object retrieved from PDM database 
with read only status can be regenerated in a Creo Parametric 
session.
----------
Determines whether an object retrieved from PDM database 
with read only status can be regenerated in a Creo session.

yes, no yes

Data Management save_unchanged_pdm_o
bject

CHANGED Determines how to save in the current working directory an 
object fetched from a Pro/PDM database into a Creo 
Parametric session.
----------
Determines how to save in the current working directory an 
object fetched from a Pro/PDM database into a Creo session.

as_ref, as_copy as_ref

Dimensions & 
Tolerances

dim_fraction_format CHANGED Std - Displays fractional dimensions in the standard Creo 
Parametric format. Aisc - Displays fractional dimensions in the 
American Institute of Steel Construction (AISC) format and 
displays architectural units in AISC format for feet-inches.
----------
Std - Displays fractional dimensions in the standard Creo 
format. Aisc - Displays fractional dimensions in the American 
Institute of Steel Construction (AISC) format and displays 
architectural units in AISC format for feet-inches.

std, aisc std

Dimensions & 
Tolerances

minimum_angle_dimensi
on

CHANGED Controls the minimum angle value under which Creo Parametric 
assumes colinearity of the selected items when creating a 
driven dimension.
----------
Controls the minimum angle value under which Creo assumes 
colinearity of the selected items when creating a dimension.

1
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Category Name Status Description Values Default Value
Dimensions & 
Tolerances

use_major_units CHANGED Determines if fractional dimensions are displayed in terms of 
feet-inches or meter-mm. Yes - The major units are used. For 
example, when the units are inches and 25.125 is converted to 
a fraction, the dimension becomes 2' 1-1/8".
----------
Determines if fractional dimensions are displayed in feet-inches, 
such as 1' 3 1/2" for 15.5 inches.  Used in retrieval of pre-Creo 
solids to set detail setup option, and used at runtime when 
setup value is 'default'.

yes, no no

Drawing allow_vert_select_in_dim
_create

NEW Allow highlight of model vertices during dimension placement in 
drawings

yes, no yes

Drawing bom_format CHANGED Sets the BOM format file to be used for a customized BOM.  
Specify name and path.

<creo2.0_loadpoint>\text\format.b
ft
----------
<creo3.0_loadpoint>\text\format.b
ft

Drawing drawing_setup_file CHANGED Sets the default drawing setup file option values for your Creo 
Parametric session, otherwise, the system uses the default 
drawing setup file option values. Certain parameters in the file 
are valid only if you have a license for Pro/DETAIL.
----------
Sets the default drawing setup file option values for your Creo 
session, otherwise, the system uses the default drawing setup 
file option values. Certain parameters in the file are valid only if 
you have a license for Pro/DETAIL.

<creo2.0_loadpoint>\text\prodetai
l.dtl
----------
<creo3.0_loadpoint>\text\prodetai
l.dtl

Drawing dwg_unicode_conversion
_language

CHANGED Defines the language used during Unicode conversion of pre-
Wildfire 4.0 drawings.   This option does not affect the 
conversion of models.   File - Uses the language stored in the 
drawing header file; Session - Uses the language of the current 
Creo Parametric session.
----------
Defines the language used during Unicode conversion of pre-
Wildfire 4.0 drawings.    This option does not affect the 
conversion of models.  File - Uses the language stored in the 
drawing header file; Session - Uses the language of the current 
Creo session.

file, session, english, 
japanese, french, german, 
russian, italian, spanish, 
korean, chinese_tw, 
chinese_cn, hebrew, 
greek, turkish, czech, 
polish, hungarian, 
slovenian, portuguese, 
slovak, usascii

file
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Drawing pro_palette_dir CHANGED Sets the default directory for drawing symbol palette files. <creo2.0_loadpoint>\symbols\pal

ette\
----------
<creo3.0_loadpoint>\symbols\pal
ette\

Drawing snap_drw_entity_to_snap
_line

CHANGED Yes - Enable snapping of drawing and report entities to snap 
lines. No - Disable snapping of drawing and report entities to 
snap lines.
----------
Yes - Enable snapping of drawing and report entities to snap 
lines. No - disable snapping of drawing and report entities to 
snap lines.

yes, no yes

Education & Social 
Tools

enable_sociallink DELETED Allow Windchill SocialLink to connect with Creo Parametric. 
When enabled SocialLink commands will be added to the 
Application Menu and the Ribbon bar. Enter "Yes" to enable 
SocialLink, and "No" to disable it

yes, no no

Electromechanical bundle_transition_create
_method

NEW Control whether bundle transitions are created automatically. 
Default is automatic.

automatic, manual

Electromechanical cable_bundle_transition_l
ength

NEW Transition length is controlled by the formula Larger Diameter X 
<percentile>. Default value is 50&#91;0...250]%.

0.5

Electromechanical update_loom_bundle_dat
a

NEW Setup whether to update loom bundle data from old harnesses. yes, no no

Environment activate_window_automa
tically

NEW Yes - Execute Activate command automatically after a window 
is selected. No - Don't execute Activate command automatically 
after a window is selected.

yes, no yes

Environment clock CHANGED Yes - Displays the clock while Creo Parametric is working.
----------
Yes - Displays the clock while Creo is working.

yes, no no

Environment des_exp_confirm_on_sa
ve

NEW When you use a `Save` command during a Design Exploration 
session, it does not save the session, it prompts to add a new 
checkpoint.

yes, no yes

Environment des_exp_create_auto_cp
s

NEW Set the maximum number of automatically created checkpoints 
allowed. Additional checkpoints override previous checkpoints. 
Type a value from 1 to 99. Type 0 to prevent automatic 
checkpoint creation.
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Environment des_exp_create_backup

s
NEW Back up all models in session when starting Design Exploration 

and all models opened and modified during the session. When 
backup is on, starting a Design Exploration session might take 
some time.

yes, no no

Environment des_exp_data_path NEW Sets the directory for the Design Exploration session. The 
default location is in a default system folder. Type a valid file 
path to change the directory to a user defined one. Data from 
only one session is stored.

Environment des_exp_display_type NEW Set the default display of the Checkpoint Tree. 'Tree' - Displays 
all branches in the Checkpoint Tree. 'Timeline' - Displays 
checkpoints in chronological order (des_exp_display_type).

tree, timeline tree

Environment des_exp_show_cp_props
_dialog

NEW Open the Checkpoint Properties dialog box when you add a 
new checkpoint, or turn an automatic checkpoint into a regular 
one.

yes, no yes

Environment intelligent_fastener_enabl
ed

NEW Enables Intelligent Fastener. You must restart Creo for the 
setting to take effect.

yes, no yes

Environment prehighlight_tree CHANGED Default value for "Preselection Highlighting" option in the model 
tree, layer tree and detail tree. When enabled, selectable items 
are highlighted prior to being selected in the tree.
----------
Default value for "Preselection Highlighting" option in the model 
tree, layer tree, detail tree and layout tree. When enabled, 
selectable items are highlighted prior to being selected in the 
tree.

yes, no no

Environment proe_memory_buffer_siz
e

CHANGED Specify the size in megabytes of the memory buffer to be 
reserved by Creo Parametric for system out of memory 
condition. You must restart Creo Parametric for the change to 
take effect.
----------
Specify the size in megabytes of the memory buffer to be 
reserved by Creo for system out of memory condition. You must 
restart Creo for the change to take effect.

50
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Environment show_selected_item_id CHANGED Show id of Creo Parametric and Sketcher geometry in query 

selection bin, collector and tool tip.
----------
Show id of Creo and Sketcher geometry in query selection bin, 
collector and tool tip.

yes, no no

Environment start_appmgr CHANGED Determines whether or not the application manager starts when 
Creo Parametric is started.
----------
Determines whether or not the application manager starts when 
Creo is started.

yes, no yes

Features auto_add_remove CHANGED Allows Creo Parametric to automatically switch from add to 
remove of material for solid extrude and revolve during feature 
creation.
----------
Allows Creo to automatically switch from add to remove of 
material for solid extrude and revolve during feature creation.

yes, no no
----------
yes

Features flex_maintain_solution_to
pology

NEW Initial value for the "Maintain solution topology" option in created 
flexible modeling features.

yes, no no

File Storage & 
Retrieval

pro_datum_target_dir CHANGED Sets the default directory for your user-defined datum target 
symbols. Use the full pathname to avoid problems.

<creo2.0_loadpoint>\symbols\tar
gets\
----------
<creo3.0_loadpoint>\symbols\tar
gets\

File Storage & 
Retrieval

pro_font_dir CHANGED Sets the default font directory (Creo Parametric will load all 
fonts in this directory into the drawing regardless of the contents 
of the system and working directories).
----------
Sets the default font directory (Creo will load all fonts in this 
directory into the drawing regardless of the contents of the 
system and working directories).

<creo2.0_loadpoint>\text\fonts\
----------
<creo3.0_loadpoint>\text\fonts\

File Storage & 
Retrieval

pro_library_dir CHANGED Sets the default directory for the Creo Parametric libraries (or 
any libraries you have built containing the proper index menu 
files). Use the full pathname to avoid problems.
----------
Sets the default directory for the Creo libraries (or any libraries 
you have built containing the proper index menu files). Use the 
full pathname to avoid problems.
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File Storage & 
Retrieval

pro_surface_finish_dir CHANGED Sets the default directory for your user-defined surface finish 
symbols. Use the full pathname to avoid problems.

<creo2.0_loadpoint>\symbols\surf
fins\
----------
<creo3.0_loadpoint>\symbols\surf
fins\

File Storage & 
Retrieval

propagate_change_to_pa
rents

CHANGED When saving objects with option save_objects set to Changed 
or Changed_and_specified, Creo Parametric verifies which 
models are. Yes - Any model that is a parent of a changed 
model is considered to be a changed model when determining 
what to save.
----------
When saving objects with option save_objects set to Changed 
or Changed_and_specified, Creo verifies which models are. 
Yes - Any model that is a parent of a changed model is 
considered to be a changed model when determining what to 
save.

yes, no no

File Storage & 
Retrieval

save_dialog_for_existing
_models

CHANGED Controls whether the Save dialog is shown for models whose 
storage location is already known.

yes, no yes
----------
no

File Storage & 
Retrieval

save_file_iterations NEW Yes - Iterations of a file will be saved. No - Iterations of a file will 
not be saved.

yes, no yes

File Storage & 
Retrieval

search_path CHANGED Specifies list of directories to search (in order) for object/file 
retrieval. These directories, the working directory, and 
directories in search.pro file (refer to search_path_file) are Creo 
Parametric's search path. Use full path name to avoid 
problems.
----------
Specifies list of directories to search (in order) for object/file 
retrieval. These directories, the working directory, and 
directories in search.pro file (refer to search_path_file) are 
Creo's search path. Use full path name to avoid problems.
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File Storage & 
Retrieval

search_path_file CHANGED Specifies path to text file search.pro (a list of directory path 
names). The directories listed in search.pro, the working 
directory, and directories specified by search_path are Creo 
Parametric's search path. Use full path name to avoid 
problems.
----------
Specifies path to text file search.pro (a list of directory path 
names). The directories listed in search.pro, the working 
directory, and directories specified by search_path are Creo's 
search path. Use full path name to avoid problems.

File Storage & 
Retrieval

template_boardpart NEW Specify the model to use as the default new ECAD board 
template.

File Storage & 
Retrieval

template_new_ecadasm NEW Specify the model to use as the default new ECAD assembly 
template.

File Storage & 
Retrieval

use_temp_dir_for_inst CHANGED Explicitly makes Creo Parametric use the Temp directory for 
regenerating instances of models.
----------
Explicitly makes Creo use the Temp directory for regenerating 
instances of models.

yes, no no

File Storage & 
Retrieval
----------
Update Control

retrieve_data_sharing_re
f_parts

CHANGED Automatic reference parts retrieval for dependent data sharing 
features.

yes, no, ignore_missing no

Freestyle Feature freestyle_drag_performa
nce

NEW Yes - Improve performance during drag by temporarily reducing 
graphics quality. No - No reduction in graphics quality during 
drag.

yes, no yes

Layers blank_layer CHANGED Blanks specified layers when you begin a Creo Parametric 
session. The value is the layer ID.
----------
Blanks specified layers when you begin a Creo session. The 
value is the layer ID.

Layers display_layer CHANGED This causes the specified layers to display when you begin a 
Creo Parametric session. The variable "value" is the layer Id.
----------
This causes the specified layers to display when you begin a 
Creo session. The variable "value" is the layer Id.
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Layout layout_feat_copied_geo

m_thick
NEW Layout feature - Copied geometry thickness. 1, 3, 2, 4, 5, 1.5, 2.5, 3.5, 

4.5
1.5

Layout layout_symbol_dir CHANGED Set and automatically create the default directory for saving and 
retrieving user-defined symbols. If you do not specify a 
directory, Layout will use the same directory as Creo Parametric 
drawings. Use full path name to avoid problems.
----------
Set and automatically create the default directory for saving and 
retrieving user-defined symbols. If you do not specify a 
directory, Layout will use the same directory as Creo drawings. 
Use full path name to avoid problems.

<dir_name>\dump_x86e_win64\

Manufacturing curve_traj_offset_opt_def
ault

NEW Enables default state of "Offset Cut" option for the trajectory 
sequence. "ON" - "Offset Cut" option is selected. "OFF" - the 
option is not selected. "AUTO" - the option state depends on the 
selected chain reference.

off, on, auto auto

Manufacturing enable_param_n_tool_up
d_dialog

CHANGED Enables UI for modification of manufacturing parameters and 
tools during "paste special" and UDF placement procedures.
----------
Enable parameters and tool updation dialog.

yes, no yes

Manufacturing mfg_tool_preview_by_pic
k

CHANGED Enables preview of a milling tool at a specified location on the 
tool path or geometry of the part.

yes, no no
----------
yes

Manufacturing ncmdl_bar_stock_part_p
ath

CHANGED Sets path for storage and retrieval of stock instances for 
creating workpiece in NC Model. Specify full path, including part 
name, to avoid problems.

<creo2.0_loadpoint>\text\ncmdl_
data\ncmdl_bar.prt
----------
<creo3.0_loadpoint>\text\ncmdl_
data\ncmdl_bar.prt

Manufacturing ncmdl_billet_stock_part_
path

CHANGED Sets path for storage and retrieval of stock instances for 
creating workpiece in NC Model. Specify full path, including part 
name, to avoid problems.

<creo2.0_loadpoint>\text\ncmdl_
data\ncmdl_billet.prt
----------
<creo3.0_loadpoint>\text\ncmdl_
data\ncmdl_billet.prt

Manufacturing use_strict_cl_file_names DELETED Use strict cl file names. yes, no no
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Manufacturing
----------
Without category

drilling_ui_diam_mode CHANGED Enables the diameter selection mode by default. yes, no yes

Manufacturing
----------
Without category

drilling_ui_end_opt_defa
ult

CHANGED Defines default end option for holemaking sequences. "AUTO" - 
end is determined automatically, "REFERENCE" - end is 
determined by the selected reference, "DEPTH" - end is 
determined by the specified depth, "THROUGH" - machine 
through the part.

auto, through, reference, 
depth

auto

Manufacturing
----------
Without category

drilling_ui_start_opt_defa
ult

CHANGED Defines default start option for holemaking sequences. "AUTO" - 
start is determined automatically, "REFERENCE" - start is 
determined by the selected reference.

auto, reference auto

Miscellaneous conf_mouse_anim DELETED Display the presenter's mouse motions when observing a 
shared Creo Parametric session.

yes, no no

Model Display blended_transparency CHANGED Yes - Transparent colors will appear using alpha blending (if 
supported) when the model is shaded.

yes, no, independent yes
----------
independent

Model Display datum_point_symbol CHANGED Specifies the shape of datum point symbols displayed in Part or 
Assembly mode.

dot
----------
dot, cross, circle, triangle, 
square

cross

Model Display enable_ambient_occlusio
n

NEW Enable ambient occlusion. This simulates the effect of light 
radiating from a real model by darkening the occluded areas.

yes, no no

Model Display max_animation_time CHANGED When the orientation, or zoom state, of the Creo Parametric 
window changes, an animation sequence of a predefined 
duration takes place. This option controls the maximum time the 
system spends animating.
----------
When the orientation, or zoom state, of the Creo window 
changes, an animation sequence of a predefined duration takes 
place. This option controls the maximum time the system 
spends animating.

1
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Model Display max_image_dimension CHANGED Set the upper bound dimension on images loaded into Creo 

Parametric. Images larger than this limit will be rescaled to this 
upper bound during loading.
----------
Set the upper bound dimension on images loaded into Creo. 
Images larger than this limit will be rescaled to this upper bound 
during loading.

4096, 1024, 2048, 8192, 
16384

4096
----------
16384

Model Display min_animation_steps CHANGED When the orientation, or zoom state, of the Creo Parametric 
window changes, an animation sequence of predefined duration 
takes place. This option controls the minimum number of 
frames used in the animation sequence.
----------
When the orientation, or zoom state, of the Creo window 
changes, an animation sequence of predefined duration takes 
place. This option controls the minimum number of frames used 
in the animation sequence.

6

Model Display model_detail_options_file CHANGED Sets the path to the file which contains the default model detail 
option values for new models.

<creo2.0_loadpoint>\text\3d_inch
.dtl
----------
<creo3.0_loadpoint>\text\3d_inch
.dtl

Model Display smooth_lines DELETED Choose whether to smooth lines by default or not. yes, no no
Model Display update_old_appearance NEW Update pre-Creo 3.0 appearances to their latest values. Always - 

update without warning, Never - do not update, Prompt - issue a 
warning dialog allowing users to choose to update or not.

never, always, prompt always

Notification 
Manager

nmgr_affected_by_dma NEW Show notifications for models/features that are affected by Creo 
direct modifications.

yes, no yes

Notification 
Manager

nmgr_modified_in_dma NEW Components that were repositioned in Creo Direct. All models 
and features affected by this operation cannot be updated or 
modified in Creo Parametric until parametric behavior is 
restored.

yes, no yes

Notification 
Manager

nmgr_outdated_mathcad NEW Show notifications for models that contain MathCad Sheet with 
values different from Creo values.

yes, no yes

Notification 
Manager

nmgr_outdated_non-
native

NEW Show notifications for non-native models that are not up-to-date 
with respect to source.

yes, no yes
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Notification 
Manager

nmgr_outdated_pdm NEW Show notifications for models that are not up-to-date with recent 
PDM model version.

yes, no yes

Notification 
Manager

nmgr_pending_dma NEW Models that were modified in Creo Direct and not reviewed. The 
changes should be accepted or rejected in the View Creo 
Changes dialog

yes, no yes

Notification 
Manager

nmgr_reference_change
d

NEW Show notifications for models/features whose references were 
changed since last regeneration.

yes, no yes

Notification 
Manager

nmgr_reference_out_of_
session

NEW Show notifications for models/features with references not in 
session.

yes, no no

Photorender default_scene_filename CHANGED Complete path to the scene file to be used as default scene file. <creo2.0_loadpoint>\graphic-
library\scenes\/creo_default_scen
e.scn
----------
<creo3.0_loadpoint>\graphic-
library\scenes\/creo_default_scen
e.scn

Photorender photorender_memory_us
age

CHANGED Sets the memory limit that Pro/PHOTORENDER allows for 
model processing. Do not use commas in the memory value, as 
Creo Parametric interprets these as decimals. The minimum 
allowed value is 64 and maximum value is 5120.
----------
Sets the memory limit that Pro/PHOTORENDER allows for 
model processing. Do not use commas in the memory value, as 
Creo interprets these as decimals. The minimum allowed value 
is 64 and maximum value is 5120.

256

Piping isogen_attribute_map_fil
e

CHANGED Specifies the mapping between isogen parameter and attribute 
name.

<creo2.0_loadpoint>\text\piping_d
ata\isodata\isogen_attribute_map
.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\isodata\isogen_attribute_map
.ptd
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Piping isogen_endtype_map_file CHANGED Specify name of file mapping Pro/Piping endtypes with ISOGEN 

endtypes
<creo2.0_loadpoint>\text\piping_d
ata\isodata\isogen_endtype_map.
ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\isodata\isogen_endtype_map.
ptd

Piping isogen_nominal_size_ma
p_file

CHANGED Specify name of file mapping Pro/Piping Size with Nominal 
Sizes in MM and Inches

<creo2.0_loadpoint>\text\piping_d
ata\isodata\isogen_nominal_size
_map.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\isodata\isogen_nominal_size
_map.ptd

Piping isogen_symbol_map_file CHANGED Specify name of file for mapping Pro/Piping selection names 
with ISOGEN symbol keys (SKEY)s

<creo2.0_loadpoint>\text\piping_d
ata\isodata\isogen_symbol_map.
ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\isodata\isogen_symbol_map.
ptd

Piping pipeline_assembly_librar
y_dir

CHANGED Sets the default pipeline assembly library directory. <creo2.0_loadpoint>\text\piping_d
ata\pipelinelib\
----------
<creo3.0_loadpoint>\text\piping_d
ata\pipelinelib\

Piping piping_appearance_map
_file

CHANGED Sets the default piping appearance map filename. <creo2.0_loadpoint>\text\piping_d
ata\master_catalog\piping_appea
rance.map
----------
<creo3.0_loadpoint>\text\piping_d
ata\master_catalog\piping_appea
rance.map
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Piping piping_bolt_nut_select_fil

e
CHANGED Piping bolts and nuts selection file. <creo2.0_loadpoint>\text\piping_d

ata\master_catalog\piping_bolt_n
ut_select.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\master_catalog\piping_bolt_n
ut_select.ptd

Piping piping_end_compatibility
_file

CHANGED Sets the default piping end compatibility filename. <creo2.0_loadpoint>\text\piping_d
ata\master_catalog\piping_end_c
ompatibility.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\master_catalog\piping_end_c
ompatibility.ptd

Piping piping_fitt_category_map
_file

CHANGED Sets the default piping fitting category map filename. <creo2.0_loadpoint>\text\piping_d
ata\sample_project\piping_fitt_cat
egory_map.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\sample_project\piping_fitt_cat
egory_map.ptd

Piping piping_fitt_library_dir CHANGED Sets the default piping fitting library directory. <creo2.0_loadpoint>\text\piping_d
ata\fittinglib\
----------
<creo3.0_loadpoint>\text\piping_d
ata\fittinglib\

Piping piping_insulation_dir_file CHANGED Sets the default piping insulation directory filename. <creo2.0_loadpoint>\text\piping_d
ata\sample_project\piping_insulat
ion_dir.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\sample_project\piping_insulat
ion_dir.ptd
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Piping piping_manufacture_dir_f

ile
CHANGED Sets the default piping manufacture directory filename. <creo2.0_loadpoint>\text\piping_d

ata\master_catalog\piping_manuf
acture_dir.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\master_catalog\piping_manuf
acture_dir.ptd

Piping piping_material_file CHANGED Sets the default piping material filename. <creo2.0_loadpoint>\text\piping_d
ata\master_catalog\piping_materi
al.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\master_catalog\piping_materi
al.ptd

Piping piping_mcat_dir CHANGED Sets the default piping master catalog directory. <creo2.0_loadpoint>\text\piping_d
ata\master_catalog\
----------
<creo3.0_loadpoint>\text\piping_d
ata\master_catalog\

Piping piping_mcat_dir_file CHANGED Sets the default piping master catalog directory filename. <creo2.0_loadpoint>\text\piping_d
ata\master_catalog\piping_mcat_
dir.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\master_catalog\piping_mcat_
dir.ptd

Piping piping_project_data_dir CHANGED Sets the default Project data directory. <creo2.0_loadpoint>\text\piping_d
ata\sample_project\
----------
<creo3.0_loadpoint>\text\piping_d
ata\sample_project\

Piping piping_spec_dir_file CHANGED Sets the default piping specification directory filename. <creo2.0_loadpoint>\text\piping_d
ata\sample_project\piping_spec_
dir.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\sample_project\piping_spec_
dir.ptd
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Piping units_system_dic_file CHANGED Specifies the file containing the mapping for MCAT filename 

and units.
<creo2.0_loadpoint>\text\piping_d
ata\master_catalog\piping_units_
system_dic_file.ptd
----------
<creo3.0_loadpoint>\text\piping_d
ata\master_catalog\piping_units_
system_dic_file.ptd

Printing & Plotting plotter_command CHANGED Sets the command that you use to start a plot on your system; 
for Windows NT or Windows 95, windows_print_manager 
option configures Creo Parametric to plot to a recognized 
device in the Windows NT or Windows 95 print manager.
----------
Sets the command that you use to start a plot on your system; 
for Windows NT or Windows 95, windows_print_manager 
option configures Creo to plot to a recognized device in the 
Windows NT or Windows 95 print manager.

windows_print_manager

Printing & Plotting ps_output_with_pagesize CHANGED Specifies whether or not to include pagesize information when 
generating postscript files from Creo Parametric. No - Creo 
Parametric will omit Adobe level 2 pagesize information from 
the header of the postscript file.
----------
Specifies whether or not to include pagesize information when 
generating postscript files from Creo. No - Creo will omit Adobe 
level 2 pagesize information from the header of the postscript 
file.

yes, no yes

Printing & Plotting u3d_create_color_surfac
es

NEW YES- Exports color of each surface of model. NO- Exports one 
color per model. Default NO.

yes, no no
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Printing & Plotting use_software_linefonts CHANGED Yes - The exact line style used in Creo Parametric is plotted, 

stroked out dot by dot, dash by dash, and space by space. No - 
plots lines using the line font it supports which most closely 
resembles the font used in Creo Parametric.
----------
Yes - The exact line style used in Creo is plotted, stroked out 
dot by dot, dash by dash, and space by space. No - plots lines 
using the line font it supports which most closely resembles the 
font used in Creo.

yes, no no

Reference Control allow_direct_ref_to_layou
t_file

NEW Allow direct references to layout files through layout feature. yes, no no

Reference Control def_comp_ref_ctrl_excep
tion

NEW Default setting for newly created components that 
allows/disallows referencing entities forbidden by Reference 
Control settings.

yes, no yes

Reference Control def_multiple_backup_pro
mpt_num

NEW Number of selected components that will invoke confirmation 
before multi-component backing up placement references.

100

Reference Control def_obj_feat_refs_to_bac
kup

NEW Default setting that controls the level of feature backup for newly 
created models. Other_models: all references to other models 
will be backed up, Non_permitted: only references that were 
created despite the initial restrictions will be backed up.

none, other_models, 
non_permitted

non_permitted

Reference Control def_obj_place_refs_to_b
ackup

NEW Default setting that controls the level of placement backup for 
newly created models. Other_models: all references to other 
models will be backed up, Non_permitted: only references that 
were created despite the initial restrictions will be backed up.

all, none, other_models, 
non_permitted

non_permitted

Reference Control def_obj_ref_ctrl_exceptio
n

NEW Default setting for newly created models that allows/disallows 
referencing entities forbidden by Reference Control settings.

yes, no yes

Reference Control default_comp_invalid_ref
s

DELETED Set the specified handling method of out-of-scope Accessible 
references to newly added components.

copy, prohibit copy

Reference Control default_object_invalid_ref
s

DELETED Sets default condition for reference handling. Prohibit - System 
will abort all attempts to create ext. reference that violates 
scope. Copy - System will issue warning upon all attempts to 
create ext. reference that violates scope.

copy, prohibit copy
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Reference Control feat_references_to_back

up
NEW Level of backup for feature references none, other_models, 

non_permitted
non_permitted

Reference Control placement_references_to
_backup

NEW Level of backup for placement references all, none, other_models, 
non_permitted

non_permitted

Reference Control ref_control_allow_excepti
ons

NEW Check to allow referencing components that are not permitted 
by the above setting

yes, no yes

Reference Control scope_invalid_refs DELETED Prohibit - System will abort all attempts to create external 
reference violating the scope. Backup - Warning appears. Abort 
reference creation or declare as out-of-scope reference. If you 
declare, backup copies to part/assembly and backup is 
referenced.

copy, prohibit copy

Sheetmetal die_models_directory NEW Sets path to directory that contains the die models.
Sketcher dma_sketcher_guide_wid

th_factor
NEW Guide width as a proportion of sketched line width 0.75

Sketcher sketcher_disp_guides NEW Shows guides when sketching. yes, no yes
Sketcher sketcher_snap_sensitivity CHANGED sketcher snap sensitivity

----------
Adjusts the sensitivity of the snapping to geometry.

high, medium, low, 
very_high, very_low

very_high

Style Feature style_merge_surfaces NEW Merge surfaces on exit from the Style Feature yes, no yes
System csv_format_delimeter CHANGED Define the delimiter character in BOM format file: Comma, TAB, 

Semicolon, Space or other user-defined.
----------
Define the delimeter character in BOM format file: Comma, 
TAB, Semicolon, Space or other user-defined

comma, tab, semicolon, 
space

System enable_tree_indep CHANGED Setup whether tree customization will allow separating the tree 
window from Creo Parametric window.
----------
Setup whether tree customization will allow separating the tree 
window from Creo window.

yes, no no

System overlays_enabled CHANGED Yes - Enables Creo Parametric screens and menus to be 
placed on different overlay layers of the hardware graphics 
card. This frees memory for Creo Parametric use.
----------
Yes - Enables Creo screens and menus to be placed on 
different overlay layers of the hardware graphics card. This 
frees memory for Creo use.

yes, no no
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System saveunders_enabled CHANGED Yes - Enables Creo Parametric popup helptext and menus to 

retain the portion of the window they obscure to be used to 
restore the window image when they are dismissed.
----------
Yes - Enables Creo popup helptext and menus to retain the 
portion of the window they obscure to be used to restore the 
window image when they are dismissed.

yes, no yes

System trail_dir CHANGED Instructs Creo Parametric to create its trail file in the specified 
directory rather than in the startup directory.
----------
Instructs Creo to create its trail file in the specified directory 
rather than in the startup directory.

System web_browser_homepage CHANGED Enter location of Creo Parametric browser home page.
----------
Enter location of Creo browser home page.

<creo2.0_loadpoint>\help\usascii\
resource_center_index.html
----------
<creo3.0_loadpoint>\help\usascii\
resource_center_index.html

System web_browser_in_separat
e_window

CHANGED Specifies whether Creo Parametrics web browser should be 
launched as a separate  window.  When set to Yes the browser 
will be displayed as a separate window.   The default, No, will 
result in the browser being embedded in the Creo Parametric 
application window
----------
Specifies whether Creo web browser should be launched as a 
separate window. When set to Yes the browser will be 
displayed as a separate window. The default, No, will result in 
the browser being embedded in the Creo application window.

yes, no no

System windows_browser_type CHANGED Select the type of embedded browser to use. ie_in_process, 
ie_in_sep_process, 
mozilla_based_browser
----------
ie_browser, 
chromium_browser

ie_in_process
----------
ie_browser

Update Control child_of_layout_backup_
update

NEW Set the default update state for a child referencing the layout 
feature's geometry.

manual, auto, notify auto

Update Control copied_feat_refs_update
_state

NEW Copied Feature References Update manual, auto, notify, 
no_dependency

auto
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Update Control copied_place_refs_updat

e_state
NEW Copied Placement References Update manual, auto, notify, 

no_dependency
auto

Update Control direct_child_of_layout_up
date

NEW Set the default update state for a child directly referencing the 
layout model through layout feature.

manual, auto, notify notify

Update Control individual_child_update NEW Allow individual update control for children of layout feature. yes, no yes

Update Control new_cg_update_state NEW Set the default update state for newly created Copy Geometry 
features relative to the reference model.

manual, auto, notify auto

Update Control new_layout_feature_upd
ate_state

NEW Define the default update state of a new DSF created. manual, auto, notify notify

User Interface allow_confirm_window CHANGED Display a confirmation window when exiting Creo Parametric. 
This enables you to use the mouse to confirm/cancel exiting 
Creo Parametric.
----------
Display a confirmation window when exiting Creo. This enables 
you to use the mouse to confirm/cancel exiting Creo.

yes, no yes

User Interface dialog_translation CHANGED Specifies the language in which the dialog display when running 
non-English version of Creo Parametric.
----------
Specifies the language in which the dialog display when running 
non-English version of Creo.

yes, no yes

User Interface drm_policy_server DELETED Allows a user to preset the server policy that is to be used when 
Apply Policy command is utilized.

User Interface fonts_size CHANGED Determines the relative size of the text in menus and dialog 
boxes. You must restart Creo Parametric for the change to take 
effect.
----------
Determines the relative size of the text in menus and dialog 
boxes. You must restart Creo for the change to take effect.

medium, small, large
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User Interface help_translation CHANGED Specifies the language in which the short help messages 

display when running non-English versions of Creo Parametric. 
Yes - Display in native language. No - Display in English.
----------
Specifies the language in which the short help messages 
display when running non-English versions of Creo. Yes - 
Display in native language. No - Display in English.

yes, no yes

User Interface iconify_entire_pro CHANGED Determines how many other Creo Parametric windows/menus 
are iconified when one window is iconified. Yes - All the 
windows and menus are iconified. No - Only the selected 
window is iconified.
----------
Determines how many other Creo windows/menus are iconified 
when one window is iconified. Yes - All the windows and menus 
are iconified. No - Only the selected window is iconified.

yes, no yes

User Interface initial_drm_warning DELETED Warns the user that they are initiating a DRM session.  When 
set to "no", this warning dialog will be skipped.

yes, no yes

User Interface mdl_tree_cfg_file CHANGED Specifies the Model Tree configuration file to be loaded when 
Creo Parametric is started.
----------
Specifies the Model Tree configuration file to be loaded when 
Creo is started.

User Interface menu_font CHANGED Specify font used in the Creo Parametric menu bar, menus, and 
all their children. Specify the comma-delimited variables in any 
order (italic bold, 24, times or 24, times, italic bold have the 
same effect). Any omitted variable uses the standard setting.
----------
Specify font used in the Creo menu bar, menus, and all their 
children. Specify the comma-delimited variables in any order 
(italic bold, 24, times or 24, times, italic bold have the same 
effect). Any omitted variable uses the standard setting.
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User Interface menu_translation CHANGED Specifies the language in which the menus display when 

running non-English version of Creo Parametric.
----------
Specifies the language in which the menus display when 
running non-English version of Creo.

yes, no, both yes

User Interface msg_translation CHANGED Specifies language in which Messages are displayed when 
running non-English version of Creo Parametric.
----------
Specifies language in which Messages are displayed when 
running non-English version of Creo.

yes, no yes

User Interface open_window_maximize
d

CHANGED Open any new Creo Parametric window maximized by default. 
This config will override "reserve_menu_space" option.
----------
Open any new Creo window maximized by default. This config 
will override "reserve_menu_space" option.

yes, no no

User Interface popuphelp_font CHANGED Specify font used in the Creo Parametric pop-up help. Add the 
comma-delimited variables in any order (italic bold, 24, times or 
24, times, italic bold have the same effect). Any omitted variable 
uses the standard setting.
----------
Specify font used in the Creo pop-up help. Add the comma-
delimited variables in any order (italic bold, 24, times or 24, 
times, italic bold have the same effect). Any omitted variable 
uses the standard setting.

User Interface reserved_menu_space CHANGED Reserves space for extra menus to the right of the Creo 
Parametric window (0.0-4.0). This option overrides 
windows_scale.
----------
Reserves space for extra menus to the right of the Creo window 
(0.0-4.0). This option overrides windows_scale.

1
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User Interface thermo_position_hint CHANGED Enables you to position the thermometer-type scales whenever 

they appear, so that they do not overlap the Creo Parametric 
windows (if space permits, for example, if windows have been 
scaled).
----------
Enables you to position the thermometer-type scales whenever 
they appear, so that they do not overlap the Creo windows (if 
space permits, for example, if windows have been scaled).

no_window_overlap, 
window_overlap

window_overlap

User Interface visible_message_lines CHANGED Sets the default number of visible message lines in the Creo 
Parametric message area.
----------
Sets the default number of visible message lines in the Creo 
message area.

2

User Interface windows_scale CHANGED Scales Creo Parametric windows with a given coefficient. A 
value of 0.85 is usually adequate to allow dynamic menus to 
display to the right of the Creo Parametric window.
----------
Scales Creo windows with a given coefficient. A value of 0.85 is 
usually adequate to allow dynamic menus to display to the right 
of the Creo window.

1

Without category accessory_window_abov
e

CHANGED Yes - Displays and keep the accessory window above the active 
window. No - Does not keep the accessory window above the 
active window.
----------
Yes - Displays and keeps the accessory window above the 
active window. No - Does not keep the accessory window above 
the active window.

yes, no no

Without category attach_menumanager CHANGED Setup menu manager attachment to the main Creo Parametric 
window.
----------
Setup menu manager attachment to the main Creo window.

yes, no no

Without category auto_center_dimension NEW Automatically centers the dimension text between witness lines. 
For common reference dimensions, controls the centering of 
the first dimension only.

yes, no no
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Without category backup_reference_infor

mation
NEW Yes-Backup the reference information of a feature once the 

feature regenerates successfully. No- Do not save the reference 
information of a feature.

yes, no yes

Without category comp_placement_legacy
_move

NEW Show the legacy Move tab in the Component Placement 
dashboard

yes, no yes

Without category confirm_on_edit_foreign_
models

NEW Provides a confirmation dialog when attempting to make design 
changes to foreign models

yes, no no

Without category des_exp_folder NEW Sets the directory for the Design Exploration session. The 
default location is in a default system folder. Type a valid file 
path to change the directory to a user defined one.

Without category display_images CHANGED Display images outside of Style feature
----------
Yes - Display images added to the model. No - Do not display 
images.

yes, no yes

Without category edge_tess_quality CHANGED Set the accuracy level for arc tessllation.
----------
Set the accuracy level for arc tessellation.

high, medium, low low

Without category enable_3dmodelspace_b
rowser_tab

CHANGED Yes - Display 3D ModelSpace tab in the browser when Creo 
Parametric starts.  No - Display 3D ModelSpace tab only when 
you click a 3D ModelSpace link in the navigator.
----------
Yes - Display 3D ModelSpace tab in the browser when Creo 
starts. No - Display 3D ModelSpace tab only when you click a 
3D ModelSpace link in the navigator.

yes, no yes

Without category enable_partcommunity_t
ab

NEW Yes - Display PartCommunity tab in the browser. No - Do not 
display the tab.

yes, no yes

Without category flex_dma_reduce_solutio
n_number

NEW Reduces the number of default solutions found in Flexible 
Modeling features, when modifying geometry with mixed 
convexity contours.

yes, no yes

Without category flex_tan_propagation_def
ault

NEW Defines default state of the Tangency Propagation option in 
Flexible Modeling features.

off, on off
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Without category layout_smart_constraints CHANGED

----------
To improve the user experience, specific entity types are 
appropriately constrained by default (i.e. - fillets with tangency 
constraints). Yes - specific entity types will be created with 
appropriate constraints by default; No - constraints will never be 
automatically created for any entity type.

yes, no yes

Without category layout_symbol_inst_palet
te_file

CHANGED Specifies the location of the layout symbol instance palette. If 
you do not specify a directory, layout will use the same palette 
as Creo Parametric drawings. Use full path name to avoid 
problems.
----------
Specifies the location of the layout symbol instance palette. If 
you do not specify a directory, layout will use the same palette 
as Creo drawings. Use full path name to avoid problems.

Without category measure_ref_option_stat
us

CHANGED Determine AsObject (AsCenter et al.) checkbox option behavior 
in Measure Tool
----------
Determine As Object (As Center et al.) checkbox option 
behavior in Measure Tool

default, all_on, all_off, 
keep_last

default

Without category model_tree_font CHANGED Specify font used in the Creo Parametric Model Tree. specify 
the comma-delimited variables in any order (italic bold, 24, 
times or 24, times, italic bold have the same effect). Any omitted 
variable uses the standard setting.
----------
Specify font used in the Creo Model Tree. specify the comma-
delimited variables in any order (italic bold, 24, times or 24, 
times, italic bold have the same effect). Any omitted variable 
uses the standard setting.

Without category pro_design_test_mode_d
ir

DELETED Sets the default directory for the Design Test mode data. If not 
specified, your current working directory is the default. Use the 
full pathname to avoid problems.
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Without category ptc_manikin_comforts_p

ath
CHANGED Sets the default directory for the Creo Parametric manikin 

comfort angles.  You must restart Creo Parametric for the 
change to take effect.
----------
Sets the default directory for the Creo manikin comfort angles. 
You must restart Creo for the change to take effect.

Without category ptc_manikin_library_path CHANGED Sets the default directory for the Creo Parametric manikin 
library (or custom manikin libraries you built containing the 
proper index menu files). Use the full path name to avoid 
problems.  You must restart Creo Parametric for the change to 
take effect.
----------
Sets the default directory for the Creo manikin library (or custom 
manikin libraries you built containing the proper index menu 
files). Use the full path name to avoid problems.  You must 
restart Creo for the change to take effect.

<creo2.0_loadpoint>\manikin_lite\
----------
<creo3.0_loadpoint>\manikin_lite\

Without category ptc_manikin_posture_pat
h

CHANGED Sets the default directory for the Creo Parametric manikin 
postures (or custom posture libraries you built). Use the full path 
name to avoid problems.  You must restart Creo Parametric for 
the change to take effect.
----------
Sets the default directory for the Creo manikin postures (or 
custom posture libraries you built). Use the full path name to 
avoid problems.  You must restart Creo for the change to take 
effect.

Without category relations_ang_eval_diff_c
heck

CHANGED Check for differences in the evaluation of relation sets 
evaluated and saved in versions of Creo 2.0 prior to M110. 
Warn_message Check and give a warning in the message 
area. Warn_dialog skip the check and warning.
----------
Check for differences in the evaluation of relation sets 
evaluated and saved in versions of Creo 2.0 prior to M110. 
Warn_message Check and give a warning in the message 
area.  Warn_dialog  Check and give a warning in a message 
window. Ignore  Skip the check and warning.

ignore, warn_message, 
warn_dialog

warn_message
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Without category show_axes_by_view_sco

pe
CHANGED Determines the scope of the Show Model Annotations tool when 

showing model datums and selecting a drawing view. For large 
assembly drawings, use top_model_only to improve 
performance by restricting the set of axes to be shown.

top_model_only, 
all_sub_models

all_sub_models
----------
top_model_only

Without category suppress_dim_ghost_wit
h_ctrl

NEW Suppress the ghost image of dimension when CTRL is pressed. 
It allows better visibility while selecting further dimension 
references.

yes, no no

Without category tool_mgr_save_pocket_i
n_xml

CHANGED Determines whether tool position should be saved in a XML file 
(*.txf) created in tool manager dialog.
----------
Determines whether the tool position should be saved in a XML 
file (*.txf) created in tool manager dialog.

yes, no no
----------
yes

Without category visible_recent_files CHANGED Number of visible recent files. The possible range is 1 - 25.
----------
Number of visible recent files. The possible range is 1 - 30.

13
----------
21

Without category
----------
Assembly

new_wf5_simp_rep_ui CHANGED Yes - Use Component Chooser base Simp Rep UI, No - Use 
old Simp Rep definition UI.

yes, no yes

Without category
----------
Data Exchange

ecad_load_filtered_holes
_to_ui

CHANGED Controls whether "ECAD import holes configs" 
(ecad_pin_hole_import & ecad_via_hole_import) will remove 
holes completely from the import (default) or just pre-set the 
holes filter UI condition.

yes, no no

Without category
----------
Data Exchange

ecad_outline_holes_exp_
method

CHANGED Select how holes that are placed on the board outline be 
exported.

default, arcs default

Without category
----------
Data Exchange

intf_pdf_u3d_create_u3d
_files

CHANGED YES - When exporting a Creo Parametric model as PDF U3D 
file, create a U3D file of the same name as the PDF file.
----------
YES - When exporting a Creo model as PDF U3D file, create a 
U3D file of the same name as the PDF file.

yes, no no

Without category
----------
Data Exchange

intf2d_out_blanked_layer
s

CHANGED Enables export of blanked layer entities. If an entity is placed on 
a layer that is blanked and this option is set to YES, the entity 
will be exported.

yes, no no

Without category
----------
Data Exchange

intf3d_out_jt_config_nam
e

CHANGED Name of JT configuration file.
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Without category
----------
Data Exchange

intf3d_out_jt_config_path CHANGED Path to JT configuration file.

Without category
----------
Drawing

warn_if_iso_tol_missing CHANGED Yes - Returns the user to the dimension properties dialog to 
select a different table. No - Applies the tolerance according to 
existing functionality.

yes, no no

Without category
----------
Electromechanical

boeing_extract_bundle CHANGED Yes - Uses the extract bundle algorithm. No - Does not use the 
extract bundle algorithm.

yes, no no

Without category
----------
Electromechanical

ignore_bundles_in_find_c
ables

CHANGED Include bundles and overbraids in the query results when the 
model or logical data is queried for unrouted items.

yes, no no

Without category
----------
Electromechanical

smaller_bundle_min_ben
d_rad

CHANGED Setup whether to consider the thickness of the bundle when set 
up the minimum bend radius.

yes, no no

Without category
----------
Electromechanical

trace_thru_splice_conne
ctor

CHANGED Report the from/to connectors of cables passing through splices 
correctly.

yes, no no

Without category
----------
Layers

save_hidden_items_w_st
atus

CHANGED The items on the "Hidden Items" temporary layer are stored 
permanently when layer display status is saved with Save 
Status command.

yes, no yes

Without category
----------
Reference Control

default_ext_ref_scope CHANGED Set default scope for externally referenced models. All - Any 
model. None - Only current model and children. Skeletons - Any 
component in model's assembly and higher skeletons on 
branch. Subassembly - Only components and children in 
model's assembly.

all, none, subassemblies, 
skeleton_model

all

Without category
----------
System

display_ie8_warning_dial
og

CHANGED Show/Hide the warning dialog related to Internet Explorer 8 
running in Compatibility Mode

yes, no yes
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